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本章将在下面几节中介绍安捷伦 PSG 信号源的型号、选项和主要特点，另外还将介绍其工作模式、

前面板用户接口及前面板和后面板连接器。

“信号源型号和主要特点”，第 2 页

“选项”，第 5 页

“固化软件升级”，第 5 页

“工作模式”，第 7 页

“前面板”，第 9 页

“前面板显示”，第 17 页

“后面板”，第 22 页

1   信号源概述

注 如需与 PSG 有关的更多信息，如技术资料表、配置指南、应用指南、常见问答、技术支持、

软件等，请访问安捷伦 PSG 网页：http://www.agilent.com/find/psg.
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E8257D PSG 模拟信号源主要特点

E8257D PSG 包括下述标准特点：

CW 连续波输出：250 kHz 到最高工作频率，最高工作频率取决于选项

频率分辨率：0.001 Hz

列表和步进扫描频率和幅度，拥有多个触发源

用户平坦度校正

外部二极管检波器置平

自动置平控制(ALC)开关模式；即使没有功率搜索，在 ALC 关模式下仍提供了功率校准功能

10 MHz 参考频率振荡器，支持外部输出

RS-232, GPIB 和 10Base-T LAN I/O 接口

信号源模块接口，兼容 Agilent 83550 系列毫米波信号源模块(频率扩展到 110 GHz)及 Oleson 微波实

验室(OML) AG 系列毫米波信号源模块(频率扩展到 325 GHz)

E8257D PSG 还提供了下述选装功能：

选项 007 - 模拟锯齿波扫描

信号源概述

信号源型号和主要特点

表 1-1 PSG信号源型号

型号 频率范围

E8257D PSG 模拟信号源 250 kHz - 20 GHz (选项 520)

250 kHz - 40 GHz (选项 540)

250 kHz - 50 GHz (选项 550)

250 kHz - 67 GHza (选项 567)

E8267D PSG 矢量信号源 250 kHz - 20 GHz (选项 520)

250 kHz - 31.8 GHz (选项 532)

250 kHz - 44 GHz (选项 544)

信号源型号和主要特点

表 1-1 列出了安捷伦提供的 PSG 信号源型号及其输出信号类型和频率范围。

a. functional,but unspecified, above 67 GHz to 70 GHz

第 1章
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信号源概述

信号源型号和主要特点

选项 UNR - 增强的相噪性能

选项 UNT - AM、FM、相位调制和 LF 输出

开环或闭环 AM

dc 合成 FM - 10 MHz 速率；最大变化取决于载频

AM, FM, Φ M 和脉冲的外部调制输入

同步调制配置(例外：FM 及Φ M 或线性 AM 及指数 AM)

双函数发生器，包括下述特点：

— 50(低频输出, 0 - 3Vp, 通过 LF OUTPUT 提供

— 可选择的波形: 正弦波, 双正弦波, 扫描正弦波、三角形波、正锯齿波、负锯齿波、方波、正

态分布噪声、高斯分布噪声和 DC

— 可调节的频率调制速率

— 在列表和步进扫描模式下可选择的触发：自由运行(自动), 触发键(单次), 总线(远程)和外部触发

选项 UNU - 脉冲调制

内部脉冲发生器

外部调制输入

可选择的脉冲模式：内部方波, 内部自由运行脉冲, 内部触发脉冲, 内部偶极脉冲, 内部选通脉冲和外

部脉冲；内部触发脉冲、内部偶极脉冲和内部选通脉冲要求外部触发源

可调节的脉冲速率

可调节的脉冲周期

可调节的脉宽

可调节的脉冲时延

可供选择的外部脉冲触发：正脉冲或负脉冲

选项 UNW - 窄脉冲调制

在 PSG 的工作频段内生成窄脉冲(最小 20 ns)

包括与选项 UNU 相同的所有功能

选项 1EA - 高输出功率

选项 1E1 - 步进衰减器

第 1 章
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信号源型号和主要特点

选项 1ED - N 型母头 RF 输出连接器

选项 1EH - 改善了 2 GHz 以下的谐波

选项 1EM - 把所有前面板连接器挪到后面板上

E8267D PSG 矢量信号源主要特点

E8267D PSG 矢量信号源提供了 E8257D PSG 的所有功能，并增加了下述功能：

内部 I/Q 调制器

外部模拟 I/Q 输入

单端和差分模拟 I/Q 输出(E8257D 可以选装)

步进衰减器(E8257D 可以选装)

E8267D PSG 提供了与 E8257D PSG 相同的选装功能，并增加了下述选装功能：

选项 601- 内置基带发生器，8M 样点的内存

选项 602- 内置基带发生器，64M 样点的内存

选项 003-PSG 与 N5102A 的数字输出连接

选项 004-PSG 与 N5102A 的数字输出连接

选项 005-6 GB 内置硬驱

选项 015- 宽带外部 I/Q 输入
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选项

选项

PSG信号源提供了硬件、固化软件、软件和文档编制选项。信号源随机所带的技术数据表概括介绍

了提供的选项。如需更多信息，请访问安捷伦 PSG网页：www.agilent.com/find/psg，您可以选择希望查

看的 PSG 型号，然后点击 View price list (查看报价)。报价中为您选择的型号提供了最新的选项列表。

固化软件升级

在发布新的固化软件时，可以升级信号源中的固化软件。新发布的固化软件可以从安捷伦网站下载，

其中可能会包含以前发布的固化软件中没有提供的信号源特点和功能。

如需了解新的信号源固化软件的供货情况，请访问安捷伦固化软件升级助手网页：www.agilent.com/

find/upgradeassistant，或致电 www.agilent.com/find/upgradeassist 上列明的电话号码。

为升级固化软件

下面的程序说明了怎样使用局域网连接和 PC 把新的固化软件下载到 PSG 中。如需与设备要求及其

它固化软件下载方法有关的信息，如GPIB，请参阅PSG/ESG固化软件升级指南，网址: http://www.agilent.

com/find/upgradeassistant。

1. 注意信号源的 IP 地址。为查看 PSG 上的 IP 地址，按Utility > GPIB/RS-232 LAN > LAN Setup。

2. 使用网络浏览器，访问：www.agilent.com/find/upgradeassistant。

3. 向下滚动到 "Documents and Downloads" (文档和下载),点击E82x7D PSG, NEW Firmware C.xx.xx，

打开另一个网页，做相同的选择。

4. 向下滚动到 "Documents and Downloads"，再次点击 E82x7D PSG NEW Firmware C.xx.xx。

5. 在 File Download (文件下载)窗口中，选择Run this program from its current location (从当前位置

运行这一程序)，点击OK (确定)。

6. 在 Security Warning (安全警报)窗口中，点击 Yes (是)，根据屏幕上的提示操作。固化软件文件下载

到 PC 上。在点击 Finish (完成)时，浏览器会显示 NEW Firmware (新固化软件)页面。

7. 在浏览器中，点击Back (后退)按钮，返回 Firmware Upgrade Assistant (固经软件升级助手)页面。
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固化软件升级

8. 在 "Documents and Downloads" (文档和下载)表中，点击PSG/ESG Upgrade Assistant x.xx，下载

Upgrade Assistant (升级助理)。

9. 在桌面快捷键提示符下，点击 Yes (是)。

10.一旦程序下载完毕，关闭浏览器，双击桌面上的PSG/ESG Upgrade Assistant (PSG/ESG 升级助手)

图标。

11.在 Upgrade Assistant (升级助手)中，设置希望用来下载固化软件的连接类型，以及选择的连接类型的

参数。例如，对局域网，输入第 1 步中记下的仪器 IP 地址。

注 如果启动了 PSG 的动态主机配置协议(DHCP)，网络将在仪器开机时为仪器分配一个 IP 地址。

正因如此，在启动DHCP时，每次在仪器开机时 IP地址通常是不同的。DHCP不会影响主机名。

12.点击Browse(浏览)，选择信号源要升级的固化软件的修订版本。

13.在 Upgrade Assistant (升级助手)中，点击Next (下一步)。

14.在检验到仪器的连接之后，点击Next (下一步)，根据屏幕上的提示操作。

注 下载开始后不能撤销。

注 在出现 User Attention (用户注意)信息时，必须先重新开机，然后点击 OK (确定)。

在升级完成时，Upgrade Assistant (升级助手)会显示一个摘要。

15.点击OK (确定)，关闭 Upgrade Assistant (升级助手)。
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工作模式

工作模式

根据型号和安装的选项，PSG信号源提供了最多四种基本工作模式：连续波(CW)、扫描信号、模拟

调制和数字调制。

CW 连续波模式

在这种模式下，信号源生成一个连续波信号。信号源设成单一的频率和功率水平。E8257D和E8267D

都可以生成 CW 连续波信号。

扫描信号

在这种模式下，信号源扫描通过一个频率和 / 或功率范围。E8257D 和E8267D 都提供了列表扫描功

能和步进扫描功能。选项 007 增加了模拟锯齿波扫描功能。

模拟调制

在这种模式下，信号源使用模拟信号调制CW连续波信号。提供的模拟调制类型取决于安装的选项。

选项UNT提供了AM、FM和ΦM调制。部分调制可以一起使用。选项UNU和选项UNW分别提供

了标准调制和窄脉冲调制功能。

数字调制

在这种模式下，信号源使用实时 I/Q信号或任意 I/Q波形调制CW连续波信号。I/Q调制仅在E8267D

上提供。内置基带发生器(选项 601/602)增加了下述数字调制格式：

Custom Arb Waveform Generator (自定义任意波形发生器)模式可以生成单个被调制载波或多个被调制

载波。在输出前，必须计算和生成每个被调制的载波波形；这个波形是在内置基带发生器上被生成的。

一旦创建波形，可以存储和调用波形，重复回放测试信号。如需了解更多信息，请参阅第 163页“自

定义任意波形发生器”。

Custom Real Time I/Q Baseband (自定义实时 I/Q 基带)模式生成单个载波，但它可以使用实时数据调

制，允许实时控制影响信号的所有参数。通过使用各种数据码型、滤波器、码率、调制类型和突发形

状，可以改变生成的单个载波。如需了解更多信息，请参阅第 191 页“自定义实时 I/Q 基带”。
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工作模式

Two Tone (双音)模式生成没有任何调制的两个单独的连续波信号(或音调);可以调节两个信号之间的频

率间隔。如需了解更多信息，请参阅第 225 页“双音波形发生器”。

Multitone (多音)模式生成最多 64 个连续波信号(或音调)。与 Two Tone (双音)模式一样，可以调节所

有信号之间的频率间隔及幅度。如需更多信息，请参阅第 215 页“多音波形发生器”。

Dual ARB (双 ARB)模式用来控制写入内置基带发生器上 ARB 内存中的波形段的回放顺序。可以在

Custom Arb Waveform Generator(自定义任意波形发生器)模式下使用内置基带发生器生成这些波形，

也可以通过远程界面把这些波形下载到ARB内存中。如需了解更多信息，请参阅第91页“使用双ARB

波形播放器”。
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前面板

1. 显示屏 10. Help (帮助) 19. SYNC OUT 28. Local

2. 软键 11. EXT 1 INPUT 20. VIDEO OUT 29. Preset (预置)

3. 旋钮 12. EXT 2 INPUT 21. Incr Set 30. 线路电源 LED

4. Amplitude (幅度) 13. LF OUTPUT 22. GATE/PULSE/TRIGGER INPUT 31. LINE

5. Frequency (频率) 14. Mod On/Off 23. 箭头键 32. 备用 LED

6. Save (保存) 15. ALC INPUT 24. Hold 33. SYMBOL SYNC

7. Recall (调用) 16. RF On/Off 25. Return 34. DATA CLOCK

8. Trigger (触发) 17. 数字小键盘 26. Contrast Decrease (降低显示对比度) 35. DATA

9. MENUS (菜单) 18. RF OUTPUT 27. Contrast Increase (提高显示对比度) 36. Q Input

37. I Input

前面板

本节介绍了PSG前面板上的各个项目。图 1-1显示了E8267D PSG前面板，其中还包括E8257D上提

供的所有项目。

图 1-1 前面板示意图(E8267D PSG 矢量信号源)

E8267D only

E8257D and E8267D
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前面板

1. 显示屏

LCD 屏幕提供了与当前功能有关的信息，其中可以包括状态指示灯、频率和幅度设置及错误信息。

软键标签位于显示屏的右侧。如需与前面板显示屏有关的更详细信息，请参阅第 17 页“前面板显示”。

2. 软键

软键用来激活每个键左面显示的功能。

3. 旋钮

使用旋钮提高或降低数值，改变高亮度显示的位或字符，或逐步通过列表，或选择一行中的项目。

4. Amplitude (幅度)

按这个硬键，可以激活幅度功能。可以改变输出幅度，或使用菜单配置幅度属性，如功率搜索、用

户平坦度和置平模式。

5. Frequency (频率)

按这个硬键可以激活频率功能。可以改变输出频率，或使用菜单配置频率属性，如倍频器、偏置和

参考频率。

6. Save (保存)

按这个硬键可以进入由多个选项组成的菜单，用户可以把数据保存在仪器的状态寄存器中。仪器状

态寄存器是划分成 10 个序列(编号 0 - 9)的一段内存，每个序列包含 100 个寄存器(编号 00 - 99)。它用来

存储和调用频率、幅度和调制设置。

在不同信号配置之间切换时，Save (保存) 硬键可以通过前面板或SCPI命令迅速重新配置信号源。一

旦已经保存了仪器状态，那么可以使用Recall (调用)硬键调用所有频率、幅度和调制设置。如需与保存

和调用仪器状态有关的更多信息，请参阅第 61 页“使用仪器状态寄存器”。

7. Recall (调用)

恢复内存寄存器中保存的仪器状态。为调用仪器状态，按Recall (调用)，并输入希望的序列号和寄

存器号码。为保存状态，使用 Save (保存)硬键。如需与保存和调用仪器状态有关的更多信息，请参阅

第 61 页“使用仪器状态寄存器”。
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8. Trigger (触发)

对列表扫描、步进扫描或锯齿波扫描(仅选项007)等功能启动立即触发事件。在使用这个硬键启动触

发事件之前，触发模式必须设成 Trigger Key (触发键)。例如，先按 Sweep/List (扫描 / 列表)硬键，然后

顺序按下面的软键：

More (1 of 2) > Sweep Trigger > Trigger Key

More (1 of 2) > Point Trigger > Trigger Key

9. MENUS (菜单)

这些键为配置各种功能打开软键菜单。如需说明，请参阅“主要参考资料”。

表 1-2 前面板 MENUS组中的硬键

E8257D PSG 模拟发生器 E8267D PSG 矢量发生器

AM Mode FM/ Φ M

Sweep/List Mux Utility

FM/ Φ M AM I/Q

Utility Sweep/List Pulse

Pulse Mode Setup LF Out

LF Out Aux Fctn

注 某些菜单是可选的。如需更多信息，请参阅第 5 页“选项”。

10. Help (帮助)

按这个硬键，可以获得任意硬键或软键的简短说明，在大多数情况下，会列出相关的远程操作 SCPI

命令。信号源上提供了两种帮助模式: 单次模式和连续模式。单次模式是出厂时预先设置的条件。按Utility

> Instrument Info/Help Mode > Help Mode Single Cont，可以在单次模式和连续模式之间拨动。

在单次模式下，为用户按的下一个键提供帮助文字，而不会激活该键的功能。之后按任何键都会退出

帮助模式，并激活其功能。

在连续模式下，为用户按的每个后续键提供帮助文字，直到用户再次按Help (帮助)硬键，或转变到单

次模式。此外，每个键都是活动的，意味着将执行这些键的功能(Preset 键除外)。
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11. EXT 1 INPUT

这个母头BNC输入连接器(只有配备选项UNT, UNU或UNW时才能使用)支持AM, FM和ΦM使用

的± 1 Vp信号。对这些调制，± 1 Vp产生了指明的偏差或深度。在为AM、FM或ΦM选择AC耦合输

入，峰值输入电压与 1 Vp差 3%以上时，HI/LO在显示屏上亮起告警灯。可以把输入阻抗选择为 50欧姆

或 600 欧姆; 损坏电平是 5 Vrms 和 10 Vp。在配备选项 1EM 的信号源上，这个连接器挪到了后面板上。

12. EXT 2 INPUT

这个母头BNC输入连接器(只有配备选项UNT, UNU或UNW时才能使用)支持AM, FM和ΦM使用

的± 1 Vp 信号。对 AM, FM 或Φ M 调制，± 1 Vp 产生了指明的偏差或深度。在为 AM、FM 或Φ M 选

择 AC 耦合输入，峰值输入电压与 1 Vp 差 3% 以上时，HI/LO 在显示屏上亮起告警灯。可以把输入阻抗

选择为 50 欧姆或 600 欧姆；损坏电平是 5 Vrms 和 10 Vp。在配备选项 1EM 的信号源上，这个连接器挪

到了后面板上。

13. LF OUTPUT

这个母头BNC输出连接器(只有配备选项UNT时才能使用)输出低频(LF)源函数发生器生成的调制信

号。这个输出能够把 3Vp (额定值)驱动到 50 欧姆负荷中。在配备选项 1EM 的信号源上，这一输出挪到

了后面板上。

14. Mod On/Off
这个硬键(只有配备选项UNT, UNU或UNW的E8257D及仅E8267D才能使用)启动或禁用所有的已激

活的调制格式(AM, FM, ΦM, 脉冲或 I/Q)，使之应用在RF输出连接器提供的输出载波信号上。这个硬键

不是用来设置或激活一个AM、FM、ΦM、脉冲或 I/Q的调制格式；每一种调制格式必须已经被设置和激

活(例如, AM > AM On)，否则在启动Mod On/Off硬键时，将没有任何调制格式被应用在输出载波信号上。

MOD ON/OFF 报警器表明伴随Mod On/Off硬键的使用，一个已激活的调制格式被启用或被禁用。

15. ALC INPUT

这个母头 BNC 输入连接器用于负外部检波器置平。这个连接器支持 - 0.2 mV 到 - 0.5 V 的输入。额

定输入阻抗是 120千欧，损坏电平是± 15 V。在配备选项 1EM的信号源上，这个输入挪到了后面板上。
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16. RF On/Off

按这个硬键可以拨码开关RF OUTPUT连接器上出现的RF信号的工作状态。尽管用户可以设置和启

动各种频率、功率和调制状态，但只有在 RF On/Off 设为 On 时，RF OUTPUT 上才会出现 RF 和微波输

出信号。在显示屏中一直可以看到RF On/Off 报警器，表明 RF 是否打开或关闭。

17. 数字附加键盘

数字附加键盘由 0 - 9个硬键、一个小数点硬键和一个退格硬键 (  )组成。退格硬键可以退格或

在正负值之间交替。在指定正值或负值时，必须在输入数字值前输入负号。

18. RF OUTPUT

这个连接器输出 RF 和微波信号。额定输出阻抗是 50 欧姆。逆功率损坏电平是 0 Vdc、0.5 W(额定

值)。在配备选项 1EM 的信号源上，这个输出挪到了后面板上。连接器类型因频率选项不同而变化。

19. SYNC OUT

这个母头 BNC 输出连接器 (只有配备选项 UNU 或 UNW 时才能使用)输出一个同步的、在内部和触

发脉冲调制过程中额定值宽 50 ns的、兼容TTL的脉冲信号。额定源阻抗是 50欧姆。在配备选项1EM的

信号源上，这个输出挪到了后面板上。

20. VIDEO OUT

这个母头BNC输出连接器(只有配备选项UNU或UNW时才能使用)输出兼容TTL电平的脉冲信号，

其在所有脉冲模式下都遵守输出包络。额定源阻抗是 50 欧姆。在配备选项 1EM 的信号源上，这个输出

挪到了后面板上。

21. Incr Set

这个硬键可以设置当前活动功能的增量值。当前活动功能的增量值出现在显示屏的活动输入区域。可

以使用数字附加键盘、箭头硬键或旋钮，调节增量值。
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22. GATE/ PULSE/ TRIGGER INPUT

这个母头BNC输入连接器(只有配备选项UNU或UNW时才能使用)支持外部提供的脉冲信号，作为

脉冲或触发输入使用。在脉冲调制时，+1 V 为开，0 V 为关(触发门限是 0.5 V，磁滞效应为 10%；这样

0.6 V将是开，0.4 V将是关)。损坏电平是±5 Vrms和10 Vp。额定输入阻抗是 50欧姆。在配备选项1EM

的信号源上，这个输入挪到了后面板上。

23. 箭头键

这些上下箭头硬键用来提高或降低数字值，步进通过显示的列表，或在显示的一行列表中选择项目。

可以使用左右箭头硬键，高亮度显示各个位或字符。一旦高亮度显示各个位或字符，可以使用上下箭头

硬键改变其取值。

24. Hold (保持)

按这个硬键，可以在显示屏上隐去软键标签区域和文字区域。一旦按下这个硬键，软键、箭头硬键、

旋钮、数字附加键盘和 Incr Set 硬键将会失效。

25. Return (返回)

按这个硬键，可以返回以前的软键菜单。可以逐步返回菜单，直到选择的第一个菜单。

26. Contrast Decrease (降低对比度)

按这个硬键，显示屏背景会变暗。

27. Contrast Increase (提高对比度)

按这个硬键，显示屏背景会变亮。

28. Local

按这个硬键，可以使远程操作无效，把信号源返回前面板控制状态。

29. Preset (预置)

按这个硬键，可以把信号源设置成已知状态(出厂状态或用户定义状态)。

30. 线路电源 LED

这个绿色 LED 表明什么时候把信号源的电源开关设到开的位置。
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31. LINE

在开的位置时，这个开关会激活信号源的全部功率；在备用状态下，它使所有信号源功能无效。在

备用状态下，信号源保持连接到线路功率，功率提供给部分内部电路。

32. 备用 LED

这个黄色 LED 表明信号源电源开关什么时候设成备用状态。

33. SYMBOL SYNC

这个母头BNC输入连接器(仅E8267D)兼容CMOS，支持外部提供的用于内置基带发生器(选项 601/

602)的码同步信号。预计输入是 3.3 V CMOS 码时钟信号(也兼容 TTL)。SYMBOL SYNC 可以每个码发

生一次，或者是单个的1位宽脉冲，用来同步第一个码的第一位。最大时钟速率是50 MHz。损坏电平是>

+5.5 V 和< -0.5V。不能指定额定输入阻抗。SYMBOL SYNC 的使用模式有两种：

在与数据时钟一起作为码同步使用时，在码的第一个数据位过程中，信号必须为高。在数据时钟信号

的下降沿过程中，信号必须有效，可以是单个脉冲，也可以是连续信号。

在 SYMBOL SYNC 本身作为(码)时钟时，CMOS 下降沿用来为 DATA 信号提供时钟输入。

在配备选项 1EM 的信号源上，这个输入挪到了后面板上。

34. DATA CLOCK

这个母头BNC输入连接器(仅E8267D)兼容CMOS，支持外部提供的数据时钟输入信号，同步内置基

带发生器(选项 601/602)使用的串行数据。预计输出是 3.3 V CMOS 码时钟信号(也兼容 TTL)，其中上升

沿与开始的数据位对准。下降沿用来为 DATA 和 SYMBOL SYNC 信号提供时钟输入。最大时钟速率是

50 MHz，损坏电平是> +5.5 V和<-0.5V。额定输入阻抗是不能指定的。在配备选项 1EM的信号源上，这

个输入挪到了后面板上。
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35. DATA

这个母头BNC输入连接器(仅配备选项601/602的E8267D)兼容CMOS，支持数字调制应用使用的外

部提供的串行数据输入。预计输入是 3.3 V CMOS信号(也兼容TTL)，其中CMOS高 =数据 1，CMOS低

= 数据 0。最大输入数据速率是 50 Mb/s。数据必须在数据时钟的下降沿(正常模式)或在码同步的下降沿

(码模式)上有效。损坏电平是> +5.5和< -0.5V。额定输入阻抗是不能指定的。在配备选项 1EM的信号源

上，这个输入挪到了后面板上。

36. Q Input

这个母头BNC输入连接器(仅E8267D)支持把正交相位(Q) 成分作为外部提供的调制、模拟调制或 I/

Q调制。同相(I)成分通过 I INPUT提供。对校准的输出电平，信号电平是                 = 0.5 Vrms。额定输入

阻抗是 50 或 600 欧姆。损坏电平是 1 Vrms 和 10 Vpeak。为激活增加到 I 和 Q 输入连接器上的信号，按

Mux > I/Q Source 1 或 I/Q Source 2，然后选择 Ext 50 Ohm 或 Ext 600 Ohm。在配备选项 1EM 的信号源

上，这些输入挪到了后面板上。

37. I Input

这个母头BNC输入连接器(仅E8267D)支持把同相(I)成分作为外部提供的调制、模拟调制或I/Q调制。

正交相位(Q)成分通过Q INPUT提供。信号电平是                   = 0.5 Vrms。额定输入阻抗是50或600欧姆。

损坏电平是 1 Vrms和 10 Vpeak。为激活增加到 I和Q输入连接器上的信号，按Mux > I/Q Source 1或 I/Q

Source 2，然后选择 Ext 50 Ohm 或 Ext 600 Ohm。在配备选项 1EM 的信号源上，这些输入挪到了后面

板上。

I2 + Q2√

I2 + Q2√
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前面板显示屏

图 1-2 是 PSG 显示屏的各个区域，本节介绍了每个区域。

图 1-2 前面板显示屏示意图

1. 活动输入区域 5. 幅度区域

2. 频率区域 6. 错误信息区域

3. 报警器 7. 文字区域

4. 数字调制报警器 8. 软键标签区域
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1. 活动输入区域

这个区域显示当前正在活动的功能。例如，如果频率是活动的功能，那么在这里将显示当前频率设

置。如果当前活动功能具有相关的增量值，那么还会显示这个值。

2. 频率区域

在显示屏的这个部分显示当前频率设置。在使用频率偏置或倍频器、打开频率参考模式或启动源模

块时，还会在这个区域中显示指示灯。

3. 报警器

显示屏报警器显示了部分信号源功能的状态，并指明任何错误条件。报警器位置可以由一个以上的

功能使用。这不会产生问题，因为一次只能激活共享报警器位置的一个功能。

Φ M 在启动相位调制时，会出现这个报警器(仅选项UNT)。如果启动频率调制，FM报警

器会代替Φ M。

ALC OFF 在禁用ALC电路时，会出现这个报警器。如果启动ALC、不能保持输出电平，同一

个位置会出现第二个报警器 UNLEVEL。

AM 在启动幅度调制时，会出现这个报警器(仅选项 UNT)。

ARMED 在已经启动扫描、信号源等待扫描触发事件时，会出现这个报警器。

ATTEN HOLD 在启动衰减器保持功能时，会出现这个报警器(仅选项1E1或E8267D)。在启动这个功

能时，衰减器会保持当前设置。

DIG BUS 在数字总线激活，内部恒温器参考频率振荡器没有冷却(OVEN COLD 出现在同一个

位置)时，会出现这个报警器(仅选项 003 或选项 004)。

ENVLP 如果存在突发情况，如在标尺 2 设为在 Dual ARB 格式下启动 RF 消隐，会出现这个

报警器。

ERR 在错误信息位于错误队列时，会出现这个报警器。只有在查看所有错误信息或清除错

误队列时，才会出现这个报警器。为获得错误信息，按 Utility > Error Info。

EXT 在启动外部置平时，会出现这个报警器。

EXT1 LO/HI 在到 EXT 1 INPUT 的 AC 耦合信号是<0.97 Vp 或>1.03 Vp 时，这个报警器(仅选项

UNT, UNU 或 UNW)会作为 EXT1 LO 或 EXT1 HI 出现。
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EXT2 LO/HI 这个报警器(仅选项 UNT, UNU 或 UNW)作为 EXT2 LO 或 EXT2 HI 显示。在到 EXT

 2 INPUT 的 AC 耦合信号<0.97 Vp 或>1.03 Vp 时，会出现这个报警器。

EXT REF 在使用外部频率参考时，会出现这个报警器。

FM 在启动频率调制时，会出现这个报警器(仅选项UNT)。如果启动相位调制，ΦM报警

器会代替 FM。

I/Q 在启动 I/Q 调制时，会出现这个报警器(仅 E8267D)。

L 在信号源处于接听方模式、并通过 RS-232、GPIB 或 VXI-11 LAN 接口接收信息

或命令时，会出现这个报警器。

MOD ON/OFF 这个报警器(仅适用于配备选项UNT, UNU或UNW的E8257D及仅E8267D)表明是否

已经启动或禁用活动调制格式。按Mod On/Off 硬键，可以启动或禁用通过 RF 输出

连接器提供的输出载波信号上使用的所有活动调制格式(AM, FM, Φ M, 脉冲, 或

I/Q)。Mod On/Off 硬键不会设置或激活 AM, FM, Φ M, 脉冲或 I/Q 格式；

在启动Mod On/Off 硬键时，还必须设置和激活各个调制格式(如AM > AM On)，

或对输出载波信号不使用任何格式。

OVEN COLD 在内部恒温器参考频率振荡器的温度跌落到可以接受的水平以下时，会出现这个报警

器(仅选项 UNR)。在打开这个报警器时，频率精度会劣化。在信号源第一次连接

到线路电源后几分钟内，应出现这种情况。

PULSE 在启动脉冲调制时，会出现这个报警器(选项 UNU 或仅 UNW)。

R 在通过 GPIB、RS-232 或 VXI-11/Sockets LAN 接口远程控制信号源时，会出现这

个报警器(TELNET操作不会激活R报警器)。在打开R报警器时，前面板上的键会禁

用，但Local键和线路电源开关除外。如需与远程操作有关的更多信息，请参阅编程

指南。

RF ON/OFF 这个报警器表明在 RF OUTPUT 上存在 RF 和微波信号(RF ON)，或 RF OUTPUT 上

不存在 RF 和微波信号(RF OFF)。在显示屏上一直可以看到这个报警器的情况。

S 在信号源通过 RS-232、GPIB 或 VXI-11 LAN 接口生成服务请求(SRQ)时，

会出现这个报警器。
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SWEEP 在信号源处于列表扫描、步进扫描或锯齿波扫描模式(锯齿波扫描只有选项 007 才

提供)时，会出现这个报警器。列表模式是指信号源可以从列表中的一个点跳到

另一个点(跳列表)；按升序或降序经过列表。列表可以是频率列表、功率电平列表，也

可以是两者。步进模式是指定义一个开始值、停止值和步进值(频率或功率电平)，信

号发生器生成在开始值开始、然后按步进值递增、直到达到停止值的信号。锯齿波扫

描模式(仅选项 007)是指定义开始值和停止值(频率或功率电平)，信号源生成在开

始值开始、并生成连续输出、直到到达停止值的信号。

T 在信号源处于发话模式、并通过 GPIB、RS-232 或 VXI-11 LAN 接口传输信息时，

会出现这个报警器。

UNLEVEL 在信号源不能保持正确的输出电平时，会出现这个报警器。UNLEVEL 报警器不

一定表明仪器失效。在正常操作过程中，也可能会发生非置平情况。在ALC 电路禁

用时，在同一个位置将出现第二个报警器 ALC OFF。

UNLOCK 在任何锁相环不能保持锁相时，会出现这个报警器。通过检查错误信息，可以确定哪

个环没有锁定。

4. 数字调制报警器

所有数字调制报警器(仅适用于配备选项 601/602 的E8267D)都出现在这个位置。只有在调制激活时

才会出现这些报警器，而且在任何给定时间一次只能激活一个数字调制。

ARB 双任意波形发生器 M-TONE 多音波形发生器

CUSTOM 定制实时 I/Q 基带 T-TONE 双音波形发生器

DIGMOD 定制任意波形发生器

5. 幅度区域

显示屏的这个部分显示当前输出功率电平设置。在使用幅度偏置、打开幅度参考模式、启动外部置

平模式、启动信号源模块及启动用户平坦度时，这个区域还会显示指示灯。
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6. 错误信息区域

这个区域报告简短的错误信息。在发生多条错误信息时，将只保持显示最新的信息。通过按Utility >

Error Info，可以查看报告的错误信息及细节。

7. 文字区域

显示屏的这个文字区域：

显示信号源状态信息，如调制状态、扫描列表和文件目录

显示表格

使您能够执行管理信息、输入信息和显示或删除文件等功能

8. 软键标签区域

这个区域中的标签定义了位于标签右边的软键的功能。根据选择的功能，软键标签可能会变化。
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1. EVENT 1 10. I OUT 19. 10 MHz IN

2. EVENT 2 11. Q OUT 20. AUXILIARY INTERFACE

3. PATTERN TRIG IN 12. I-bar OUT 21. 10 MHz OUT

4. BURST GATE IN 13. Q-bar OUT 22. LAN

5. BASEBAND GEN REF IN 14. COH CARRIER 23. STOP SWEEP IN/OUT

6. DIGITAL BUS 15. SOURCE MODULE INTERFACE 24. Z-AXIS BLANK/MKRS

7. AUXILIARY I/O 16. AC 电源插座 25. SWEEP OUT

8. WIDEBAND I INPUT 17. GPIB 26. TRIGGER OUT

9. WIDEBAND Q INPUT 18. 10 MHz EFC 27. TRIGGER IN

28. SOURCE SETTLED

后面板

本节介绍了 PSG 后面板上的每个项目。图 1-3 是标准 E8267D 后面板。第 23 页上的图 1-4 显示了配

备选项1EM的E8267D后面板。选项1EM把所有前面板连接器挪到了后面板上。这两个后面板示意图还

包括 E8257D 上提供的所有项目。

图 1-3 标准后面板示意图
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1. EVENT 1 15. SOURCE MODULE INTERFACE 29. RF OUT

2. EVENT 2 16. AC 电源插座 30. EXT 1 Input

3. PATTERN TRIG IN 17. GPIB 31. EXT 2 Input

4. BURST GATE IN 18. 10 MHz EFC 32. LF OUT

5. BASEBAND GEN REF IN 19. 10 MHz IN 33. PULSE SYNC OUT

6. DIGITAL BUS 20. AUXILIARY INTERFACE 34. PULSE VIDEO OUT

7. AUXILIARY I/O 21. 10 MHz OUT 35. PULSE/TRIG GATE INPUT

8. WIDEBAND I INPUT 22. LAN 36. ALC INPUT

9. WIDEBAND Q INPUT 23. STOP SWEEP IN/OUT 37. DATA

10. I OUT 24. Z-AXIS BLANK/MKRS 38. DATA CLOCK

11. Q OUT 25. SWEEP OUT 39. SYMBOL SYNC

12. I-bar OUT 26. TRIGGER OUT 40. I Input

13. Q-bar OUT 27. TRIGGER IN 41. Q Input

14. COH CARRIER 28. SOURCE SETTLED

图 1-4 选项 1EM 后面板示意图
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1. EVENT 1

这个母头BNC连接器(仅E8267D)用于内置基带发生器(选项 601/602); 在没有选项 601/602的信号源

上，这个母头 BNC 连接器不能使用。

在实时模式下，EVENT 1连接器为触发或选通外部设备输出一个码型或帧同步脉冲。它可以设置成

在码型、帧或时隙开始处启动，也可以调节到 1 位分辨率± 1 个时隙范围内。

在任意波形模式下，EVENT 1连接器输出标尺1生成的定时信号。标尺(对正极和负极为3.3 V CMOS

高)是在波形中打开标尺 1 时 EVENT 1 连接器上的输出。

这个连接器的反向损坏电平是> +8 V 和< -4 V。额定输出阻抗不能指定。

2. EVENT 2

这个母头BNC连接器(仅E8267D)用于内置基带发生器(选项601/602); 在没有选项601/602的信号源，

这个母头 BNC 连接器不能使用。

在实时模式下，EVENT 2连接器为选通外部设备输出一个数据启动信号。这适用外部数据为内部生

成的时隙提供时钟输入的情况。在信号为低时，启动数据。

在任意波形模式下，EVENT 2连接器输出标尺2生成的定时信号。标尺(对正极和负极为3.3 V CMOS

高)是在波形中打开标尺 2 时 EVENT 2 连接器上的输出。

这个连接器的反向损坏电平是> +8 V 和< -4 V。额定输出阻抗不能指定。

3. PATTERN TRIG IN

这个母头BNC连接器(仅E8267D)用于内置基带发生器(选项 601/602); 在没有选项 601/602的信号源

上，这个母头BNC连接器不能使用。这个连接器接收触发内置码型或帧发生器、启动单码型输出的信号。

最小脉宽是 100 ns。损坏电平是> +5.5 V 和< -0.5 V。额定输入阻抗不能指定。
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4. BURST GATE IN

这个母头BNC连接器(仅E8267D)用于内置基带发生器(选项601/602)。在没有选项601/602的信号源

上，这个连接器不能使用。这个连接器接收选通突发功率使用的 3-V CMOS输入信号。在从外部提供数

据和时钟信息时，使用突发选通。

输入信号必须与突发过程中输出的外部数据输入同步。突发功率包络和被调制数据在内部延迟和再

同步。输入信号对正常突发RF功率或CW RF输出功率必须为CMOS高，对RF关必须为CMOS 低。损

坏电平是> +5.5 V 和< -0.5 V。额定输入阻抗不能指定。

5. BASEBAND GEN REF IN

这个母头BNC连接器(仅E8267D)用于内置基带发生器(选项601/602)；在没有选项601/602的信号源

上，这个母头 BNC 连接器不能使用。这个连接器接收来自外部时基参考时钟的 0 到 +20 dBm 正弦波或

TTL方波信号。内置基带发生器在元器件和接收机测试应用中使用这个外部时基参考时钟(只有内置基带

发生器能够锁定到这个外部参考时钟上; RF 频率一直锁定到 10 MHz 参考时钟上)。

这个连接器支持 250 kHz - 100 MHz 的速率，在 13 MHz、AC 耦合时额定输入阻抗是 50 欧姆。在

ARB设置中选择外部参考时钟时，任意波形发生器的内部时钟锁定到这个信号上。最小脉宽必须> 10 ns。

损坏电平是> +8 V 和< -8 V。

6. DIGITAL BUS

这是Agilent Baseband Studio产品专用的总线，它要求配备选项 003/004和 601/602的E8267D。这个

连接器不能用于通用客户用途。只有在安装了 Baseband Studio 选项时，才会出现信号(详情请参阅 http:/

/www.agilent.com/find/basebandstudio)。在数字总线激活时，显示屏上会出现 DIG BUS 报警器(内部恒温

器参考频率振荡器没有冷却 -OVEN COLD 出现在相同的位置)。



26 第 1章

信号源概述

后面板

7. AUXILIARY I/O

这个母头37针连接器(仅E8267D)只有在配备内置基带发生器(选项601/602)的仪器上才能使用。对没

有选项 601/602 的信号源，这个连接器不能使用。这个连接器可以使用下图中介绍的输入和输出。

图 1-5 辅助 I/O 连接器(母头 37 针连接器)

后面板连接器

示意图

SYM SYNC OUT: 用于内置基带发生器。这个针脚

输出码同步、宽一个数据时钟周期的CMOS码时钟。

EVENT 3: 用于内置基带发生器。在任意波形模式下，这个针脚输出标尺

3 生成的定时信号。在波形中打开标尺 3 时，标尺(对正极和负极为 3.3 V

CMOS 高)在这个针脚上是输出。反向损坏电平: > +8 V 和< -4 V。

EVENT 4: 用于内置基带发生器。在任意波形模式下，这

个针脚输出标尺 4 生成的定时信号。在波形中打开标尺 4

时，标尺(对正极和负极为 3.3 V CMOS 高)在这个针脚上

是输出。反向损坏电平: > +8 V 和< -4 V。

PATT TRIG IN 2: 接收触发内置码型或帧发生

器启动单码型输出的信号。最小脉宽：100 ns。

损坏电平：> +5.5 V 和< -0.5 V。

ALT PWR IN: 用于内置基带发生器。这个针脚接

收同步外部数据和交替功率信号定时的 CMOS 信

号。损坏电平：> +8 V 和< -4 V。

DATA OUT: 用于内置基带发生器。这个针脚从内置

数据发生器输出数据(CMOS)或数据输入上外部提供

的信号。

DATA CLK OUT: 用于内置基带发生器。这个针

脚中继同步串行数据使用的 CMOS 码时钟。
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8. WIDEBAND I INPUT

这个母头 BNC 连接器(仅 E8267D)用于宽带外部 I/Q 输入(选项 015)。它接收宽带 AM，支持在 3.2 -

44 GHz 范围内(频率上限取决于选项)为 I/Q 调制器直接提供高带宽模拟输入。这个输入没有校准。输入

上推荐的功率电平是 0 dBm，最大幅度 +/- 1 V。在没有选项 015 的信号源上，这个连接器不能使用。这

个连接器的额定阻抗是 50 欧姆。

信号源在 20-28.5 GHz 频率范围内使用低边波瓣混频(选项 532 和 544)，它反转 I 信号和 Q 信号的相

位关系。对内部生成的I/Q信号，信号源的固化软件对此进行补偿。但是，对宽带外部 I/Q输入(选项015)，

则没有补偿，必须交换后面板上的 I 输入和 Q 输入，以在这个频段内保持正确的相位关系。如需更多信

息，请参阅“PSG 用户指南”A37 上变频器部分及选项 015 技术资料表。

9. WIDEBAND Q INPUT

这个母头BNC连接器(仅E8267D)用于宽带外部 I/Q输入 (选项015)；在没有选项015的信号源上，这

个母头 BNC 连接器不能使用。这个母头 BNC 连接器支持在 3.2 - 44 GHz 范围内(频率上限取决于选项)

为 I/Q 调制器直接提供高带宽模拟输入。这个输入没有校准。输入上推荐的功率电平是 0 dBm，最大幅

度 +/- 1 V。在没有选项 015 的信号源上，这个连接器不能使用。这个连接器的额定阻抗是 50 欧姆。如

需更多信息，请参阅上面的宽带 I 输入说明。

10. I OUT

这个母头BNC连接器(仅E8267D)可以用于内置基带发生器(选项601/602)，输出 I/Q调制的模拟同相

成分；在没有选项 601/602 的信号源上，这个母头 BNC 连接器可以用来输出已经输送到 I 输入连接器上

的外部 I/Q 调制的同相成分。I OUT 连接器的额定输出阻抗是 50 欧姆 DC 耦合。

11. Q OUT

这个母头BNC连接器(仅E8267D)可以用于内置基带发生器(选项601/602)，输出 I/Q调制的模拟正交

相位成分；在没有选项 601/602的信号源上，这个母头BNC连接器可以用来输出已经输送到Q输入连接

器上的外部 I/Q 调制的正交相位成分。Q OUT 连接器的额定输出阻抗是 50 欧姆 DC 耦合。

12. I-bar OUT

这个母头 BNC 连接器(仅 E8267D)可以用于内置基带发生器(选项 601/602) ，输出 I/Q 调制的模拟同

相成分补集；在没有选项 601/602 的信号源上，这个母头 BNC 连接器可以用来输出已经输送到 I 输入连

接器上的外部 I/Q 调制的同相成分补集。
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I-bar OUT 与 I OUT 一起使用，提供平衡基带激励源。平衡信号是指出现在两条不同导线中的信

号，这两条导线相对于接地对称，极性相反(失相 180度)。I-bar OUT连接器的额定输出阻抗是 50欧姆

DC 耦合。

13. Q-bar OUT

这个母头BNC连接器(仅E8267D)可以用于内置基带发生器(选项601/602)，输出 I/Q调制的模拟正交

相位成分补集; 在没有选项 601/602 的信号源上，这个母头 BNC 连接器可以用来输出已经输送到 Q 输入

连接器上的外部 I/Q 调制的正交相位成分补集。

Q-bar OUT与Q OUT一起使用，提供平衡基带激励源。平衡信号是指出现在两条不同导线中的信号，这

两条导线相对于接地对称，极性相反(失相 180度)。Q-bar OUT连接器的额定输出阻抗是 50欧姆DC耦合。

14. COH CARRIER

这个母头 SMA 连接器(仅适用于配备选项 UNT 的 E8267D)输出一个与信号源载波相位相干的 RF 信

号。相干载波连接器输出没有使用AM、脉冲或 I/Q调制、而是使用FM或ΦM (在FM或ΦM打开时)调

制的 RF 信号。

额定输出功率是0 dBm。输出频率范围是249.99900001 MHz - 3.2 GHz; 这个输出不能用于> 3.2 GHz

的输出频率。如果 RF 输出频率低于 249.99900001 MHz，相干载波输出信号将具有下述频率: 相干载波

频率 = (1E9 - RF 输出的频率)，单位为 Hz。

损坏电平是 20 Vdc 和 13 dBm 反向 RF 功率。这个连接器的额定输出阻抗是 50 欧姆。

15. SOURCE MODULE INTERFACE

这个接口用来连接兼容的 Agilent 83550 系列毫米波信号源模块。

16. AC 电源插座

AC 线路电压在这里连接。电源线插座容纳信号源自带的三头电源电缆。
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17. GPIB

这个 GPIB 接口支持使用兼容的 IEEE 488.2 设备实现接听和发话功能。

18. 10 MHz EFC

这个母头 BNC 输入连接器接收 -5 V 到 +5 V 范围内的外部 DC 电压，用来实现内部 10 MHz 参考频

率振荡器的电子频率控制(EFC)。这个电压反向调谐示波器的中心频率约 -0.0025 ppm/V。额定输入阻抗

大于 1兆欧。在不用时，这个连接器应使用自带的短路保护盖短路，以保证稳定的工作频率。只有选项

UNR 才提供这个连接器。

19. 10 MHz IN

这个母头BNC连接器容纳> -3 dBm的外部时基参考输入信号电平。参考频率必须是1, 2, 2.5, 5或10

MHz，位于± 1 ppm范围内。信号源检测这个连接器上什么时候存在有效的参考频率信号，然后自动从

内部参考频率操作切换到外部参考频率操作。

对选项UNR，这个BNC连接器容纳额定输入电平为5 ±5 dBm的信号。外部参考频率必须是10 MHz，

位于± 1 ppm 范围内。

额定输入阻抗是 50 欧姆，损坏电平≥ 10 dBm。
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20. AUXILIARY INTERFACE

这个 9 针 D 形微型母头连接器是一个 RS-232 串口，可以用于串行通信和主 / 从源同步。

表 1-3 辅助接口连接器

图 1-6

针脚号 信号说明 信号名称

1 没有连接

2 接收数据 RECV

3 发送数据 XMIT

4 +5V

5 接地, 0V

6 没有连接

7 请求发送 RTS

8 清除发送 CTS

9 没有连接

后面板连接器

示意图

21. 10 MHz OUT

这个母头 BNC 连接器输出> +4 dBm 的额定信号电平，输出阻抗是 50 欧姆。其精度取决于使用的

时基。

22. LAN

这个局域网接口可以通过10Base-T局域网电缆实现以太局域网通信。在传输数据(发送 /接收)时，接

口上的黄色 LED 灯亮。在数据传输延迟或没有传输数据时，绿色 LED 灯亮。
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23. STOP SWEEP IN/OUT

这个母头 BNC 连接器(仅适用于选项 007)提供了在锯齿波扫描操作过程中使用的集电极开路、兼容

TTL的输入 /输出信号。它在回扫和跨频带的间隔过程中提供小的(额定值 0 V)输出。它在扫描的前向部

分提供大的(额定值+5 V)输出。在这个输入 /输出连接器在外部接地时，扫描停止。在作为输入操作时，

这个连接器的额定阻抗小于 10 欧姆。在作为输出操作时，额定阻抗约为 4.2 千欧。

24. Z-AXIS BLANK/MKRS

这个母头 BNC 连接器(仅适用于选项 007)在步进、列表或锯齿波扫描的回扫和频带切换间隔过程中

提供 +5 V (额定)的电平。在锯齿波扫描过程中，当 RF 频率位于标尺频率、强度标尺模式为开时，这个

母头 BNC 连接器提供 -5 V (额定)的电平。这个信号从运行的放大器输出中导出，因此负荷阻抗应大于

等于 5 千欧。这个连接最常用的用途是为 Agilent 8757D 标量网络分析仪提供接口。

25. SWEEP OUT

这个母头 BNC 连接器输出与 RF 功率或频率扫描成比例的电压，其范围从扫描开始时的 0 V，到扫

描结束时的 +10 V (额定值)，扫描宽度不限。

额定输出阻抗小于 1 欧姆，可以驱动 2 千欧的负荷。

在连接到Agilent 8757D网络分析仪时，它在锯齿波(模拟)扫描中生成数量可以选择的等间隔1 ms 10

V 脉冲(额定值)。可以通过 8757D 的远程控制功能，把脉冲数量设为 101 - 1601 之间的值。

26. TRIGGER OUT

在步进 /列表模式下，这个母头BNC连接器输出TTL信号，这个信号在驻留序列开始时或在手动扫

描模式下等待点触发时为高。在驻留结束或在收到点触发时，信号为低。在锯齿波扫描模式下，输出在

锯齿波扫描中提供 1601个等间隔 1µ s脉冲(额定值)。在使用LF Out时，输出在LF扫描开始时提供一个

2 µ s 的脉冲。这个连接器的额定阻抗小于 10 欧姆。

27. TRIGGER IN

这个母头BNC连接器接收3.3V CMOS信号，它用于手动扫描模式下或低频(LF输出)或模拟(AM, FM

和ΦM)外部扫描触发设置下的点到点触发。触发可以发生在信号开始的正边沿或负边沿上。损坏电平是

≤ -4 V 或≥ +10 V。这个连接器的额定输入阻抗约为 4.2 千欧。
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28. SOURCE SETTLED

这个母头BNC连接器提供一个3V CMOS输出触发器，表明信号源什么时候稳定到新的频率或功率

电平。高表明信号源还没有稳定。低表明信号源已经稳定。这个连接器的额定输出阻抗小于 10 欧姆。

29. RF OUT

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 13 页 "18. RF OUTPUT"。

30. EXT 1 Input

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 12 页 "11. EXT 1 INPUT"。

31. EXT 2 Input

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 12 页 "12. EXT 2 INPUT"。

32. LF OUT

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 12 页 "13. LF OUTPUT"。

33. PULSE SYNC OUT

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 13 页 "19. SYNC OUT"。

34. PULSE VIDEO OUT

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 13 页 "20. VIDEO OUT"。

35. PULSE/TRIG GATE INPUT

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 14 页 "22. GATE/ PULSE/

TRIGGER INPUT"。
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36. ALC INPUT

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 12 页 "15. ALC INPUT"。

37. DATA

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 16 页 "35. DATA"。

38. DATA CLOCK

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 15 页 "34. DATA CLOCK"。

39. SYMBOL SYNC

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第15页"33. SYMBOL SYNC"。

40. I Input

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 16 页 "37. I Input"。

41. Q Input

在标准仪器上，这个连接器位于前面板上。这个连接器的说明请参见第 16 页 "36. Q Input"。
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本章将介绍所有安捷伦 PSG 信号源的常用操作。

“使用表格编辑器”，第 36 页

“配置连续波 RF 输出”，第 38 页

“配置扫描 RF 输出”，第 41 页

“使用锯齿波扫描(选项 007)”，第 46 页

“扩展频率范围”，第 56 页

“打开调制格式”，第 57 页

“对 RF 输出使用调制格式”，第 58 页

“使用数据存储功能”，第 59 页

“使用仪器状态寄存器”，第 61 页

“使用安全功能”，第 64 页

“启动选项”，第 71 页

“使用网络服务器”，第 73 页

2   基本操作
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图 2-1

使用表格编辑器

表格编辑器简化了配置任务，如创建列表扫描。本节以 List Mode Values 表格编辑器为例，介绍了

相关信息，以便使您能够熟悉各种基本表格编辑功能。

按Preset > Sweep/List > Configure List Sweep。

信号源显示 List Mode Values 表格编辑器，如下表所示。

活动功能区域 在编辑项目值时显示活动的表格项目

光标 反向视频标识符，用来高亮度显示选择和编辑使用的具体表格项目

表格软键 选择表格项目，预置表格值，修改表格结构

表格项目 种值按带编号的行和带标题的栏排列(栏也称为数据字段。

例如，Frequency 标题下面的栏称为 Frequency 数据字段)

活动功能区域 光标

表格名称 表格项目 表格软键
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表格编辑器软键

下列的表格编辑器软键用于下载，浏览，修改或存储表格项目值。

Edit Item (编辑项目) 在显示屏的活动功能区域中显示选择的项目，可以修改项目的值

Insert Row (插入行) 在当前选择的行上面插入完全相同的一行表格项目

Delete Row (删除行) 删除当前选择的行

Goto Row (定位行) 打开一个软键菜单(Enter, Goto Top Row, Goto Middle Row, Goto Bottom Row,

 Page Up 和Page Down),用来迅速浏览各个表格项目

Insert Item (插入项目) 在当前选择的项目下面新的一行中插入完全相同的项目

Delete Item (删除项目) 删除当前选择的栏的最下面一行中的项目

Page Up (上翻页) 和 显示占用 10 行表格显示区域极限范围外多个行的表格项目

Page Down (下翻页)

More (1 of 2) 使用 Load/Store 及相关软键

Load/Store (加载 / 存储) 打开一个软键菜单(Load From Selected File, Store To File, Delete File,

 Goto Row, Page Up 和 Page Down)，用来从内存目录文件中加载表格

项目，或把当前表格项目作为文件存储在内存目录中

在数据字段中修改表格项目

1. 如果还没有显示，那么打开 List Mode Values 表格编辑器(如第 36 页图 2-1 所示):

按Preset > Sweep/List > Configure List Sweep

2. 使用箭头键或旋钮，把表格光标移到希望修改的项目上。在图2-1中，选择了Frequency数据字段中的

第一个项目。

3. 按Edit Item。

选择的项目显示在显示屏的活动功能区域中。

4. 使用旋钮、箭头键或数字附加键盘，修改项目值。

5. 按Enter。

修改后的项目现在显示在表格中。
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配置 RF 输出

本节介绍怎样创建连续波和扫描RF (第 41页) 输出。它还介绍了怎样使用毫米波信号源模块，扩展

信号源的频率范围(参阅第 56 页)。

配置连续波 RF 输出

这些程序演示了怎样设置下述参数：

RF 输出频率

频率参考和频率偏置(第 39 页)

RF 输出幅度(第 40 页)

幅度参考和幅度偏置(第 40 页)

设置 RF 输出频率

把 RF 输出频率设为 700 MHz，以每步 1 MHz 递增或递减输出频率。

1. 把信号源返回出厂时指定的状态：按 Preset。

注 可以把信号源预置条件设为用户指定的状态。但在这些实例中，我们使用出厂时指定的

预置状态(在 Utility 菜单中把Preset Normal User 软键设为 Normal)。

2. 观察显示屏的 FREQUENCY 区域(左上角)。

显示的值是信号源指定的最大频率。

3. 按RF On/Off。

在RF OUTPUT 连接器上有 RF 信号之前，必须按 RF On/Off 硬键。显示报警器从 RF OFF 变成

RF ON。最大指定频率应该是 RF OUTPUT 连接器上的输出(在信号源的最小功率电平上)。

4. 按 Frequency > 700 > MHz。

在显示屏的 FREQUENCY 区域及活动输入区域应显示 700 MHz RF 频率。

5. 按 Frequency > Incr Set > 1 > MHz。

这会把频率增量值变成 1 MHz。
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6. 按向上箭头键。

每按向上箭头键一次，都会使频率提高使用 Incr Set硬键最后设置的增量值。增量值显示在活动输入

区域中。

7. 使用向下箭头键，使频率降低上一步设置的增量值。试着以 1 MHz 增量向上和向下步进频率。

也可以使用旋钮调节RF输出频率。只要频率是激活功能 (频率显示在活动输入区域中)，旋钮就会提

高和降低 RF 输出频率。

8. 使用旋钮，把频率调回 700 MHz。

设置频率参考和频率偏置

下述程序把RF输出频率设为所有其它频率设置相对的参考频率。在设置频率参考时，显示屏的读数

将是0.00 Hz (信号源硬件的频率输出减去参考频率)。尽管显示结果会变化，但实际频率输出是700 MHz

(从上面第 8 步)。任何后续频率变化会显示为 0 Hz 参考的递增量或递减量。

Frequency Reference Set (设置频率参考)功能并不是一个活动的功能。一旦设定，任何频率设置变化

会在信号源前面板显示屏上显示为频率读数。例如：

1. 预置信号源: 按Preset。

2. 把频率参考设置为 700 MHz：

按：Frequency > 700 > MHz > More (1 of 3) > Freq Ref Set。

这会激活频率参考模式，把输出频率(700 MHz)设为参考值，把 Freq Ref 软键拨到 On(开)的位置。

FREQUENCY 区域显示 0.000 Hz。这个读数是信号源硬件的频率输出(700 MHz)减去参考频率值

(700 MHz)。信号源的实际输出频率是 700 MHz。如 Freq Ref 软键拨到 Off(关)，前面板将表明

实际频率：700 MHz。前面板显示屏上出现 REF 指示灯，Freq Ref Off On 软键拨到 On(开)。

3. 打开 RF 输出：按RF On/Off。

显示屏报警器从 RF OFF 变成 RF ON。RF OUTPUT 连接器上的 RF 频率是 700 MHz。

4. 把频率增量值设为 1 MHz：按 Frequency > Incr Set > 1 > MHz。

5. 使输出频率递增 1 MHz：按向上箭头键。

FREQUENCY区域显示变成1.000 000 000 MHz，这是硬件的频率输出(700 MHz + 1 MHz)减去参考频

率(700 MHz)。RF OUTPUT 上的频率变化 701 MHz。
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6. 输入 1 MHz 偏置：按More (1 of 3) > Freq Offset > 1 > MHz。

FREQUENCY 区域显示 2.000 000 00 MHz，这是硬件频率输出(701 MHz)减去参考频率(700 MHz)加

上偏置(1 MHz)。OFFS 指示灯激活。RF OUTPUT 连接器上的频率仍是 701 MHz。

设置 RF 输出幅度

1. 预置信号源：按Preset。

显示屏的 AMPLITUDE 区域显示信号源的最低功率电平。这是正常预置的 RF 输出幅度。

2. 打开 RF 输出：按 RF On/Off。

显示屏报警器变为 RF ON。在 RF OUTPUT 连接器上，RF 信号是最小功率电平的输出。

3. 把幅度变成 -20 dBm: 按Amplitude > -20 > dBm。

新的输出功率显示在显示屏的AMPLITUDE区域和活动输入区域。在按不同的前面板功能键之前，幅

度一直是活动功能。还可以使用上下箭头键或旋钮改变幅度。

设置幅度参考和幅度偏置

下述程序把RF输出功率设为所有其它幅度参数相对的幅度参考。显示屏上刚开始显示的幅度是0 dB

(硬件的功率输出减去参考功率)。尽管显示结果会变化，但输出功率保持不变。任何后续功率变化都显示

为 0 dB 的递增量或递减量。

1. 按Preset。

2. 把幅度设为 -20 dBm：按Amplitude > -20 > dBm。

3. 激活幅度参考模式，把当前输出功率(-20 dBm)设为参考值：按 More (1 of 2) > Ampl Ref Set。

AMPLITUDE 区域显示 0.00 dB，这是硬件的功率输出(-20 dBm)减去参考值(-20 dBm)。REF 指示灯

激活，Ampl Ref Off On 软键拨到 On (开)。

4. 打开 RF 输出：按 RF On/Off。

显示屏报警器变为 RF ON。RF OUTPUT 连接器上的功率是 -20 dBm。

5. 把幅度增量值变为 10 dB：按 Incr Set > 10 > dB。

6. 使用向上箭头键，把输出功率提高 10 dB。

AMPLITUDE 区域显示 10.00 dB，这是硬件功率输出(-20 dBm 加 10 dBm)减去参考功率(-20 dBm)。

RF OUTPUT 连接器上的功率变成 -10 dBm。
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7. 输入 10 dB 偏置：按 Ampl Offset > 10 > dB。

AMPLITUDE 区域显示 20.00 dB，这是硬件的功率输出(-10 dBm)减去参考功率(-20 dBm)加上偏置

(10 dB)。OFFS 指示灯激活。RF OUTPUT 连接器上的功率仍是 -10 dBm。

配置扫描 RF 输出

PSG 信号源支持最多三种扫描类型：步进扫描、列表扫描和锯齿波扫描(选项 007)。

信号源在前面板显示屏上使用进度条表明扫描进度。如果扫描时间大于一秒，扫描进度条会根据每

段的频率跨度前进。对跨度中的每个段，进度条会显示整个段，然后进行扫描。在扫描时间小于一秒时，

会画出进度条，进行扫描，然后隐去进度条。

注 列表扫描数据不能保存在仪器状态内部，但可以保存到内存目录中。如需保存列表扫描数据的

说明，请参阅第 60 页“把文件存储到内存目录中”。

在扫描 RF 输出过程中，信号源显示屏的 FREQUENCY 和 AMPLITUDE 区域会根据扫描的

内容变得无效。

步进扫描(参见第 42 页)和锯齿波扫描(参见第 43 页)通过开始频率到停止频率和 / 或幅度值提供了用

直线表示的进度，列表扫描则可以创建任意频率、幅度和驻留时间值组成的列表，并根据这个列表扫描

RF 输出。

在列表扫描实例中，我们使用步进扫描实例中创建的点作为新列表扫描的基础。

锯齿波扫描(参阅第46页)的速度要快于步进扫描或列表扫描，是为了与8757D标量网络分析仪一起

使用而设计的。

信号源提供了一个软键 Sweep Retrace Off On，可以配置单次扫描的行为特点。在回扫打开时，信

号源将回扫到第一个扫描点。如果回扫关闭，扫描将停止，保持在扫描中的最后一点。

在扫描配置中激活标量脉冲

如果扫描设置使用标量网络分析仪和DC检波器，PSG必须使用 27 kHz方波调制扫频信号，也称为

标量脉冲。这个脉冲调制对 DC 检波器正确检测扫频信号必不可少。如果通过 GPIB 连接由 8757D 控制

PSG，那么在8757D上选择DC检测时，标量脉冲会自动打开。在使用任何其它标量分析仪时，可以使用

下面其中一个按键顺序，打开标量脉冲。
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按 Sweep/List > Sweep Type > Scalar Pulse Off On 直到 On

或

按 Pulse > Pulse Source > Scalar > Pulse Off On 直到 On

使用步进扫描

步进扫描通过开始频率到停止频率和/或幅度值提供了用直线表示的进度。可以把扫描方向拨到上或

下。在Sweep Direction Down Up 软键设为 Up(向上)时，会从开始幅度 / 频率到停止幅度 / 频率扫描值。

在设为 Down (向下)时，会从停止幅度 / 频率到开始幅度 / 频率扫描值。

在激活步进扫描时，信号源根据输入的RF输出开始和停止频率和幅度值、驻留的大量等间隔点(步

进)及每个点上驻留的时间扫描RF输出；驻留时间是信号源保持当前状态的稳定时间之后的最小时期。RF

输出的频率、幅度或频率和幅度将从开始幅度 /频率扫描到停止幅度 /频率，并在# Points软键值规定的

等距离时间间隔上驻留。

配置单次步进扫描

在这一程序中，您将创建具有九个等间隔点的步进扫描及下述参数：

频率范围：500 MHz - 600 MHz

幅度：-20 dBm 到 0 dBm

驻留时间：每个点 500 ms

1. 按 Preset。

2. 按 Sweep/List。

打开一个由扫描软键组成的菜单。

3. 按 Sweep Repeat Single Cont。

把扫描重复方式从连续扫描拨到单次扫描。

4. 按 Configure Step Sweep。

5. 按 Freq Start > 500 > MHz。

把步进扫描的开始频率变成 500 MHz。

6. 按 Freq Stop > 600 > MHz。

把步进扫描的停止频率变成 600 MHz。

7. 按 Ampl Start > -20 > dBm。

改变步进扫描开始的幅度电平。

8. 按 Ampl Stop > 0 > dBm。

改变步进扫描结束的幅度电平。
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9. 按 # Points > 9 > Enter。

把扫描点数设为 9。

10. 按Step Dwell > 500 > msec。

把每点驻留时间设为 500 毫秒。

11. 按Return > Sweep > Freq & Ampl。

把步进扫描设置为扫描频率数据和幅度数据。选择这个软键，返回上一级菜单，打开扫描功能。

12. 按RF On/Off。

显示屏报警器从 RF OFF 变成 RF ON。

13. 按Single Sweep。

对步进扫描中配置的频率和幅度执行单次扫描，并在RF OUTPUT连接器上提供扫描结果。在显示屏

上，在扫描过程中会出现 SWEEP警报器，进度条会显示扫描进度。也可以使用Single Sweep软键，

撤销正在进行的扫描。如果想再次查看频率扫描，按 Single Sweep 触发扫描。

配置连续步进扫描

按Sweep Repeat Single Cont。

这会把扫描从单次扫描拨到连续扫描。现在RF OUTPUT连接器上提供了步进扫描中配置的连续重

复的频率和幅度。SWEEP报警器出现在显示屏上，表明信号源正在进行扫描，扫描进度用进度条表示。

使用列表扫描

通过列表扫描，可以创建一个由任意频率、幅度和驻留时间值组成的列表，根据 List Mode Values

表格中的项目扫描 RF 输出。

与包含线性上升 /下降频率和幅度值、以等间隔通过扫描的步进扫描不同，可以以不等间隔、非线性

升序 / 降序或任意顺序输入列表扫描频率和幅度。

为方便起见，可以从以前配置的步进扫描中复制 List Mode Values 表格。每个步进扫描点的相关频

率、幅度和驻留时间值输入到 List Mode Values 表的一行中，如下面的实例所示。

使用步进扫描数据配置单列表扫描

在这一程序中，您将利用步进扫描点，通过编辑List Mode Values表中的多个点，改变扫描信息。如

需使用表格的相关信息，请参阅第 36 页“使用表格编辑器”。
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1. 按Sweep Repeat Single Cont。

把扫描重复方式从连续扫描拨到单次扫描。SWEEP 报警器关闭。只有在触发时才会发生扫描。

2. 按Sweep Type List Step。

把扫描类型从步进扫描拨到列表扫描。

3. 按Configure List Sweep。

打开另一个菜单，显示用来创建扫描点的软键。显示屏会显示最新的列表数据。(在以前没有创建任何

列表时，默认列表会包含一个设成信号源最大频率、最小幅度和驻留时间为 2 ms 的点。)

4. 按More (1 of 2) > Load List From Step Sweep > Confirm Load From Step Data。

在步进扫描中定义的点会自动加载到列表中。

编辑列表扫描点

1. 按Return > Sweep > Off。

关闭扫描，可以编辑列表扫描点，而不会产生错误。如果在编辑过程中扫描一直打开，在没有定义一

点或两点参数(频率、功率和驻留时间)时会发生错误。

2 按Configure List Sweep。

返回扫描列表表格。

3. 使用箭头键，高亮度显示第 1 行中的驻留时间。

4. 按Edit Item。

第 1 点的驻留时间变成活动功能。

5. 按 100 > msec。

输入 100 ms，作为第 1行新的驻留时间值。注：在按终止符软键后，表格中的下一项(在本例中是第

2 点的频率值)高亮度显示。

6. 使用箭头键，高亮度显示第 4 行中的频率值。

7. 按Edit Item > 545 > MHz。

把第 4 行中的频率值变成 545 MHz。

8. 高亮度显示第 7 点行中的任何栏，按 Insert Row。

在第7点和第8点之间增加一个新点。第7点行的副本放在第7点和第8点之间，产生新的第8点，并

对后续点重新编号。

9. 高亮度显示第 8 点的频率项目，然后按 Insert Item。
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按 Insert Item，从第 8 点开始，把频率值向下移动一行。注意，第 8 点和第 9 点的原始频率值向下

移动一行，为第 10 点创建一个项目，其中只包含一个频率值(功率和驻留时间项目没有向下移动)。

第 8 点的频率仍在活动。

10. 按 590 > MHz。

11. 按 Insert Item > -2.5 > dBm。

在第 8 点插入一个新的功率值，使第 8 点和第 9 点的原始功率值向下移动一行。

12. 高亮度显示第 9 点的驻留时间，然后按 Insert Item。

为第 9 点插入高亮度显示的重复的驻留时间，把现有值向下移动，构成第 10 点的项目。

配置单次列表扫描

1. 按Return > Sweep > Freq & Ampl

再次打开扫描。如果已经在以前的编辑过程中为每个点定义了所有参数，那么应该不会发生任何

错误。

2. 按Single Sweep。

信号源将单次扫描列表中的点。在扫描过程中，SWEEP 报警器会激活。

3. 按More (1 of 2) > Sweep Trigger > Trigger Key。

把扫描触发器设成在按 Trigger 硬键时触发。

4. 按More (2 of 2) > Single Sweep。

准备扫描，ARMED 报警器激活。

5. 按 Trigger 硬键。

信号源单次扫描列表中的点，在扫描过程中 SWEEP 报警器激活。
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配置连续列表扫描

按Sweep Repeat Single Cont。

把扫描方式从单次扫描拨到连续扫描。现在在RF OUTPUT连接器上提供了列表扫描中配置的连续重

复的频率和幅度。SWEEP报警器出现在显示屏上，表明信号源正在进行扫描，扫描进度通过进度条显示。

使用锯齿波扫描(选项 007)

锯齿波扫描通过开始到停止频率和/或幅度值提供了用直线表示的进度。锯齿波扫描的速度要比步进

扫描或列表扫描快得多，旨在与 8757D标量网络分析仪一起使用。本节介绍了配备选项 007的PSG信号

源中提供的锯齿波扫描功能。您将了解怎样使用基本锯齿波扫描，怎样为主 /从设置配置锯齿波扫描(参

见第 54 页)。

对在锯齿波扫描系统中采用直传命令的程序实例，请参阅编程指南(直传命令可以临时中断锯齿波扫

描系统交互，从而向 PSG 发送运行指令)。

使用基本锯齿波扫描功能

这一程序演示了下述任务(每项任务都要以前一项任务为基础):

“配置频率扫描”，第 47 页

“使用标尺”，第 49 页

“调节扫描时间”，第 51 页

“使用交替扫描”，第 52 页

“配置幅度扫描”，第 53 页



47第 2 章

基本操作

配置 RF 输出

配置频率扫描

1. 设置设备，如图 2-2 所示。

注 PSG 信号源不能兼容 8757A、8757C 或 8757E 的 GPIB 系统接口。对这些老式标量网络分

析仪，不要连接图2-2中的GPIB电缆。这种方法只提供了8757D功能的子集。详情请参阅PSG

技术数据表。应使用 8757A/C/E 说明书，而不是本程序。

图 2-2 设备设置

2. 打开 8757D 和 PSG。

3. 在 8757D 上，按 System > More > Sweep Mode，检验SYSINTF 软键设成 ON。

这保证了在 8757D 上激活系统接口模式。系统接口模式使仪器能够作为系统工作。

4. 按Utility > GPIB/RS-232 LAN，查看GPIB Address 软键下 PSG 的 GPIB 地址。如果想改变地址，

按GPIB Address，改变地址值。

5. 在 8757D 上，按 LOCAL > SWEEPER，检查 GPIB 地址。如果与 PSG 地址不匹配，改变地址值。
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6. 预置其中一台仪器。

预置其中一台仪器应自动预置另一台仪器。如果两台仪器都没有预置，检查GPIB连接、GPIB地址，

保证 8757D 设成系统接口模式(SYSINTF 设为 ON)。

PSG自动把2 GHz激活为最大频率锯齿波扫描，恒定幅度为0 dBm。注意PSG显示屏上出现RF ON、

SWEEP 和 PULSE 报警器。之所以出现 PULSE 报警器，是因为 8757D 在 AC 模式下工作。

PSG还把远程语言设置切换到 8757D System，在锯齿波扫描操作过程中允许PSG与 8757D通话。过

按Utility > GPIB/RS-232 LAN，观察Remote Language 软键下的选择，可以确认这一点。

注 在扫描 RF 输出过程中，信号源显示屏的 FREQUENCY 和 / 或 AMPLITUDE 区域会变得无

效，具体取决于正在扫描的项目。在本例中，由于正在扫描频率，因此在显示屏的FREQUENCY

区域没有出现任何项目。

7. 按 Frequency > Freq CW。

当前连续波频率设置现在控制 RF 输出，锯齿波扫描关闭。

8. 按 Freq Start。

锯齿波扫描设置再次控制RF输出，CW模式关闭。按任何一个软键(Freq Start, Freq Stop, Freq Center

或 Freq Span)，会使用当前设置激活锯齿波扫描。

注 在频率锯齿波扫描中，开始频率必须低于停止频率。

9. 调节 Freq Center 和 Freq Span 的设置，以便在 8757D 显示屏上清楚地看到被测器件(DUT)的频响。

注意调节这些设备还会怎样改变 Freq Start 和 Freq Stop 软键的设置。您可能需要重新定标 8757D

上的响应，以便更加准确地评估幅度。第 49 页上的图 2-3 显示了带通滤波响应实例。
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图 2-3 8757D 上的带通滤波响应

使用标尺

1. 按Markers。

打开表格编辑器和相关的标尺控制软键。可以使用最多 10 个不同的标尺，标号为 0-9。

2. 按Marker Freq，在扫描范围内选择一个频率值。

在表格编辑器中，注意标尺 0 的状态怎样自动打开。标尺还会出现在 8757D 显示屏上。

3. 使用箭头键，在表格编辑器中把光标移动到标尺1上，在扫描范围内选择一个频率值，但要不同于标

尺 0。

注意标尺1被激活，且是当前选择的标尺，标尺箭头向下表明了这一点。在标尺之间切换时，在使用

箭头键时，可以注意到选择的标尺的箭头向下，其它箭头向上。

还要注意，8757D 上显示了当前选择的标尺的频率和幅度数据。
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4. 把光标向回移动到标尺 0，按Delta Ref Set > Marker Delta Off On 直到 On。

在表格编辑器中，注意每个标尺的频率值现在是相对于标尺0的值。Ref出现在最右边一栏中(也标有

Ref)，表明哪个标尺是参考标尺。参阅图 2-4。

图 2-4 标尺表格编辑器

5. 把光标向回移动到标尺 1，按Marker Freq。旋转前面板旋钮，观察 8757D 上的标尺 1。

在 8757D 上，注意在标尺沿着轨迹移动时，显示的标尺 1 的幅度值和频率值是相对于标尺 0 的值。

参阅图 2-5。
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6. 按 Turn Off Markers。

所有活动标尺关闭。如需与其它标尺软键功能有关的信息，请参阅主要参考资料。

调节扫描时间

1. 按Sweep/List。

打开一个扫描控制软键菜单，显示状态屏幕，其中汇总了所有当前扫描设置。

2. 按Configure Ramp/Step Sweep。

由于当前的扫描类型是锯齿波扫描，这个菜单中的软键专门控制锯齿波扫描设置。在选择的扫描类型

是步进扫描时，软键控制步进扫描设置。注意除 Frequency 硬键菜单外，这个菜单中还出现了 Freq

Start 和 Freq Stop 软键。

图 2-5 8757D 上的增量标尺
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3. 按 Sweep Time，设置 Manual > 5 > sec。

在自动模式下，扫描时间自动设为允许的最快值。在手动模式下，可以选择比允许的最快值慢的任何

扫描时间。允许的最快扫描时间取决于 8757D 上使用的轨迹点和信道数量以及频率跨度。

4. 按Sweep Time，直到 Auto。

扫描时间返回允许的最快设置。

注 在手动扫描模式下使用 8757 网络分析仪时，必须激活信号源的Manual Freq 软键，然后

才能使用前面板旋钮控制扫描。按 Sweep/List > More (2 of 3) > Manual Freq。

使用交替扫描

1. 按Save 硬键。

打开表格编辑器和软键菜单，保存仪器状态。注意Select Reg 软键激活。(如需与保存仪器状态有关

的更多信息，请参阅第 61 页“使用仪器状态寄存器”)

2. 旋转前面板旋钮，直到找到 available寄存器，按SAVE。记住这个已保存的寄存器号码。如果没有提

供任何寄存器，可以按 Re-SAVE，写入 in-use 寄存器。

注 在配备 8757 网络分析仪的系统中使用 PSG时，您只能顺序使用寄存器 1-9，保存和调用状态。

3. 按Sweep/List > Configure Ramp/Step Sweep，输入锯齿波扫描新的开始频率值和停止频率值。

4. 按Alternate Sweep Register，旋转前面板旋钮，选择以前保存的扫描状态的寄存器号码。

5. 按Alternate Sweep Off On 直到 On。

信号源会在最初保存的扫描和当前扫描之间交替。您可能需要调节 8757D 设置，以有效查看这

两个扫描，如把信道 2 设成测量传感器 A。参阅图 2-6。
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图 2-6 在 8757D 进行交替扫描

配置幅度扫描

1. 按Return > Sweep > Off。

关闭当前扫描及以前任务中的交替扫描。当前 CW 连续波设置现在控制 RF 输出。

2. 按Configure Ramp/Step Sweep。

3. 使用Ampl Start 和 Ampl Stop 软键，设置要扫描的幅度范围。

4. 按Return > Sweep > Ampl。

新的幅度锯齿波扫描设置控制 RF 输出，关闭 CW 连续波模式。
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为主/从设置配置锯齿波扫描

这一程序介绍了怎样配置两台PSG和 8757D，以主 /从设置工作。主 /从控制设置必须使用同一信号

源系列中的两部仪器，如两部 PSG 或两部 83640B 或两部 83751B。

注 主 / 从设置只适用于锯齿波扫描，而不适用于步进扫描或列表扫描。为使用这一设置，必须使

用同一信号源系列的两个信号源，如两部 PSG 或两部 83640B 或两倍 83751B。

1. 如图 2-7 所示设置设备。使用 9 针、D 形微型、RS-232 插头电缆，针脚配置如第 55 页图 2-8 所示，

连接两部 PSG 的辅助接口。您还可以从安捷伦公司订购电缆(部件编号 8120-8806)。

通过把主 PSG 的 10 MHz 参考频率标准连接到从 PSG 的 10 MHz 参考输入上，主 PSG 的时基为两部

PSG 提供频率参考。

2. 设置从 PSG 的频率和功率设定值。

通过先设置从 PSG，可以避免同步问题。

3. 设置主 PSG 的频率、功率和扫描时间设定值。

两部 PSG 对锯齿波扫描可以有不同的频率和功率设置。

4. 设置从 PSG 的扫描时间，与主 PSG 的扫描时间相匹配。

两部 PSG 的扫描时间必须相同。

5. 把从 PSG 设置成连续触发。

从 PSG 必须设置成连续触发，但主 PSG 可以设置成任意触发模式。

6. 在从 PSG 上，按Sweep/List > Sweep Type > Ramp Sweep Control > Slave。

把 PSG 设成在从模式下操作。

7. 在主 PSG 上，按Sweep/List > Sweep Type > Ramp Sweep Control > Master。

把 PSG 设成在主模式下操作。
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图 2-7 主/从设备设置

图 2-8 RS-232 针脚配置
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扩展频率范围

可以使用Agilent 83550系列毫米波信号源模块或其它制造商的毫米波信号源模块，扩展信号源的频

率范围。如需了解怎样使用配备毫米波信号源模块的信号源，请参阅第 272 页“毫米波信号源模块”。
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调制信号

本节介绍了怎样打开调制格式及怎样在 RF 输出中使用调制格式。

打开调制格式

在设置信号参数前或设置信号参数后，可以打开调制格式。

1. 进入调制格式内的第一个菜单。

这个菜单显示一个软键，这个软键把格式名称与关和开关联起来，如AM > AM Off On。

对某些格式，关 / 开键可能会出现在第一个菜单之外的其它菜单中。

2. 按调制格式关 / 开键，直到 On 高亮度显示。

图 2-9 是 AM 调制格式第一个菜单的一部分，显示了调制格式状态及活动的调制格式报警器。

调制格式生成，但只有在 RF 输出上使用时才能调制载波信号(参阅第 58 页)。

根据调制格式，信号源可能要求几秒时间构建信号。在数字格式内部(仅适用于配备选 601/602 的

E8267D PSG)，您可能会看到显示屏上出现一个BaseBand Reconfiguring (基带重新配置)状态条。一旦生

成信号，显示屏上会出现显示格式名称的报警器，表明调制格式激活。对数字格式(仅适用于配备选项601/

602 的 E8267D PSG)，除调制格式名称外，还会出现 I/Q 报警器。

图 2-9 AM 调制格式关和开实例

第一个 AM 菜单

调制格式关闭

调制格式打开

活动的调制格式报警器
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对 RF 输出使用调制格式

在Mod On/Off 键设为 On，且激活单独的调制格式时，会调制载波信号。

在 Mod On/Off 键设为 Off 时，显示屏上出现 MOD OFF 报警器。在该键设为 On 时，MOD ON 报

警器出现在显示屏上，而不管是否有活动的调制格式。报警器只是表明在打开调制格式时是否调制载波

信号。

打开 RF 输出调制

按Mod On/Off 键，直到显示屏上出现 MOD ON 报警器。

应使用所有活动的调制格式调制载波信号，这是出厂时的默认值。

关闭 RF 输出调制

按Mod On/Off 键，直到显示屏上出现 MOD OFF 报警器。载波信号不再被调制，在调制格式激活

时也不能调制。

图 2-10 载波信号调制状态

Mod 设为 On - 载波被调制

AM 调制格式激活

Mod 设为Off - 载波没有调制

AM 调制格式激活

Mod 设为 On - 载波没有调制

没有激活的调制格式
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使用数据存储功能

本节介绍了怎样使用两种形式的信号源数据存储器：内存目录和仪器状态寄存器。

使用内存目录

内存目录是信号源查看、存储和保存文件的接口；可以通过信号源前面板进入内存目录，也可以通

过远程控制器进入内存目录。(如需远程执行这些任务的相关信息，请参阅编程指南)

表 2-1 内存目录的文件类型和相关数据

二进制 二进制数据

状态 仪器状态数据(控制着仪器运行参数，如频率、幅度和模式)

LIST 从 List Mode Values 表中扫描数据，包括频率、幅度和驻留时间

用户平坦度 用户平坦度校准校正成对数据(用户定义的频率和相应幅度校正值)

FIR 有穷脉冲响应(FIR)滤波系数

ARB 目录类型 (仅适用于配备选项601/602的E8267D PSG) 用户创建的文件 - 波形目录

类型: WFM1 (波形文件), NVARB目录类型: NVWFM (非易失性, ARB波形

文件), NVMKR (非易失性, ARB波形标尺文件), Seq (ARB 序列文件),

MTONE(ARB 多音文件), DMOD (ARB 数字调制文件), MDMOD (ARB 多

载波数字调制文件)

调制目录类型 (仅适用于配备选项 601/602 的 E8267D PSG) I/Q和 FSK (频移键控)调制

文件的相关数据

形状 脉冲的突发形状

位 位
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把文件存储到内存目录中

为把文件存储到内存目录中，先创建一个文件。在本例中，我们使用默认的列表扫描表。

1. 按Preset。

2. 按Sweep/List > Configure List Sweep > More (1 of 2) > Load/Store。

打开 "Catalog of List Files" (列表文件目录)。

3. 按Store to File。

显示一个由文件命名使用的字母软键组成的菜单。在活动的功能区域中显示 Store to:。

4. 使用字母软键和数字附加键盘(对数字 0-9)输入文件名 LIST1。

5. 按Enter。

文件应显示在 "Catalog of List Files"(列表文件目录)中，其中显示文件名、文件类型、文件大小及文

件修改的日期和时间。

查看内存目录中存储的文件

1. 按Utility > Memory Catalog > Catalog Type。

内存目录中的所有文件都按字母顺序列出，而不管选择哪种目录类型。文件信息出现在显示屏上，包

括文件名称、文件类型、文件大小和文件修改的日期和时间。

2. 按 List。

显示 "Catalog of List Files"。

3. 按Catalog Type > State。

显示 "Catalog of State Files"。

4. 按Catalog Type > All。

显示 "Catalog of All Files"。完整的文件类型列表请参阅第 59 页表 2-1。
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使用仪器状态寄存器

仪器状态寄存器是划分成 10 个序列(编号 0-9)的一段内存，每个序列由 100 个寄存器组成(编号 00 -

99)。仪器状态序列和寄存器用来存储和调用仪器设置，在不同仪器和信号配置之间切换时，为重新配置

信号源提供了一种快捷方式。配备选项005(内置硬驱)的信号源大约为存储仪器状态文件和其它用户数据

提供了大约 4 GB 的容量。如果没有选项 005，信号源会为存储数据和仪器状态提供 20 MB 的容量。根

据信号源的配置，仪器状态的文件长度会有所变化。

不能使用保存功能存储调制格式、任意波形发生器设置和表项等文件数据。只有频率、衰减、功率

和用户定义的在电源开关或仪器复位时会丢失的其它设置，才能保存到序列和寄存器中。只能根据文件

名参考与仪器状态有关的任意数据文件，如任意波形发生器格式文件。一旦仪器状态已经保存，调用该

状态将使用保存的设定值设置发生器，并加载相关的文件数据。

如需与存储文件数据(如调制格式、任意波形发生器设置和表项)的更多信息，请参阅第 60页“把文

件存储到内存目录中”。如需与保存和调用功能有关的更多信息，请参阅 PSG编程指南和 PSG主要参考

资料。

注 文件参考数据与仪器状态一起保存。但是，保存功能不能保存任何数据，必须使用存储命令把

文件数据存储到不同的内存位置。

保存仪器状态

1. 预置信号源，然后打开幅度调制(AM 报警器将打开)：

a. 按 Frequency > 800 > MHz。

b. 按Amplitude > 0 > dBm。

c. 按AM > AM Off On。

2. 按Save > Select Seq。

序列号码变成活动功能。信号源显示最后一次使用的序列。使用箭头键，把序列设为 1。

3. 按Select Reg。

序列 1 中的寄存器号码变成活动功能。信号源显示最后一次使用的序列及文字：(in use); 或

(如果没有使用寄存器) 寄存器 00 伴以文字: (available)。使用箭头选择寄存器 01。

4. 按Save Seq[1] Reg[01]。
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把这一仪器状态保存在仪器状态寄存器的序列 1、寄存器 01 中。

5. 按Add Comment to Seq[1] Reg[01]。

可以在序列 1、寄存器 01 中增加描述性说明。

6. 使用字母数字软键或旋钮，输入说明，按Enter。

7. 按Edit Comment In Seq[1] Reg[01]。

如果愿意，现在可以改变序列 1寄存器 01的描述性说明。在改变仪器状态后，可以把它保存回到某

个寄存器中，方法是高亮度显示该寄存器，然后按Re-SAVE Seq[n] Reg[nn]。

调用仪器状态

通过使用这一程序，您将学习怎样调用保存到仪器状态寄存器中的仪器设置。

1. 按Preset。

2. 按Recall 硬键。

注意，Select Seq 软键显示序列 1。(这是最后一次使用的序列。)

3. 按RECALL Reg。

在序列 1中调用的寄存器成为活动功能。按向上箭头一次，选择寄存器1。应该已经调用存储的仪器

状态设置。

删除寄存器和序列

这些程序说明了怎样删除保存到仪器状态寄存器中的寄存器和序列。

删除序列内的某个寄存器

1. 按Preset。

2. 按Recall 或Save 硬键。

注意，Select Seq 软键显示了最后一次使用的序列。

3. 按Select Seq，输入包含着希望删除的寄存器的序列号。

4. 按Select Reg，输入希望删除的寄存器号码。

注意，应装载Delete Seq[n] Reg[nn]及希望删除的序列和寄存器。

5. 按Delete Seq[n] Reg[nn]。

删除选择的寄存器。
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删除序列内的所有寄存器

1. 按Preset。

2. 按Recall 或Save 硬键。

注意，Select Seq 软键显示了最后一次使用的序列。

3. 按Select Seq，输入包含着希望删除的寄存器的序列号。

4. 按Delete all Regs in Seq[n]。

删除选定序列内的所有寄存器。

删除所有序列

小心 确认希望删除的所有寄存器的内容及仪器状态寄存器中的所有序列。

1. 按Preset。

2. 按Recall 或Save 硬键。

注意，Select Seq 软键显示了最后一次使用的序列。

3. 按Delete All Sequences。

删除仪器状态寄存器中保存的所有序列。

8757 网络分析仪保存和调用功能

8757 网络分析仪系列可以保存和调用信号源仪器状态，但仪器之间的通信受到限制。

8757发出的清除寄存器命令会导致信号源使用默认值代替寄存器的内容。可以使用Delete All软键菜

单，或使用相应的 SCPI (程控仪器标准命令)命令，从信号源清除默认值。

信号源不直接与8757网络分析仪通信。如果8757把仪器状态保存到信号源寄存器中，用户删除该寄

存器，8757将不会识别删除操作。8757调用所有被删除状态的企图会导致PSG生成错误信息：+700 "State

Save Recall Error..."。
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使用安全功能

本节介绍了怎样使用PSG的安全功能，保护和删除仪器中存储或显示的分类专有信息。本节中介绍

的所有安全功能还为远程操作提供了同等的 SCPI 命令。(如需更多信息，请参阅 SCPI 命令参考数据 " 系

统命令 " 一章)

理解 PSG 内存类型

PSG包括多种内存类型，每种内存都用来存储特定类型的数据。在删除敏感的数据前，应理解在PSG

中怎样使用每种内存。下表说明了基本仪器、选装的基带发生器和选装硬盘中使用的每种内存。

表 2-2 基本仪器内存

在
正

常
操

作
过

程
中
可
以
写
入
?

在
关

机
时

保
留
数
据
?

内存类型 用途/内容 数据输入方法 在 PSG 中的位置和备注

和容量

主内存 是 否 固化软件操作 操作系统(非用户) CPU 电路板

(SDRAM) 内存

64 MB

主内存 是 是 工厂校准 / 固化软件升级和 CPU 电路板 (芯片与固化软件内存相同，

(Flash) 配置数据 用户保存的数据 但单独管理)

20 MB 用户文件系统， 如果安装了硬盘(选项 005)，这个存储器中

包括平坦度校准、 不存储用户数据

IQ 校准、仪器状 由于这个 32-MB 内存芯片包含 20 MB 的用户

态、波形(包括标 数据(这里介绍)和 12 MB 的固化软件内存，

题和标尺数据)、 因此最好不要使用擦除整个芯片的命令。在执

调制定义和扫描 行擦除和清理功能时，可以选择清理和全面

列表 清理用户数据区域。
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固化软件 否 是 主固化软件映像 出厂时安装或 CPU 电路板 (芯片与固化软件内存相同，

内存(闪存) 固化软件升级 但单独管理)

12 MB 在正常操作过程中，这个内存不能覆盖。只有

在固化软件安装或升级过程中才能覆盖内存

由于这个32-MB内存芯片包含20 MB的用户数

据(这里介绍)和 12 MB的固化软件内存，因此

最好不要使用整个芯片擦除命令。在执行擦除

和清理功能时，可以选择清理和全面清理用户

数据区域。

带电池后备 是 是 用户可以编辑的 固化软件操作 CPU 电路板

电源的内 数据(表格编辑器)

存(SRAM) 最后使用的仪器 可以拆下电池，清除内存，但为使仪器工作，

512 kB 状态和最后使用 必须重新安装电池

的仪器状态备份

用户存储的仪器

状态

Bootrom 否 是 CPU 引导程序和 出厂时编程 CPU 电路板

内存(闪存) 固化软件加载程

128 kB 序 /更新程序 在正常操作过程中，这个内存不能覆盖或擦除。

这些只读数据在出厂时进行编程

表 2-2 基本仪器内存

在
正

常
操

作
过

程
中
可
以
写
入
?

在
关

机
时

保
留
数
据
?

内存类型 用途/内容 数据输入方法 在 PSG 中的位置和备注

和容量
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在
正

常
操

作
过

程
中
可
以
写
入
?

在
关

机
时

保
留
数
据
?

内存类型 用途/内容 数据输入方法 在 PSG 中的位置和备注

和容量

校准备份 否 是 出厂校准 / 配置 仅用于工厂或维护 主板

内存(闪存) 数据备份

512 KB 非用户数据

电路板内 否 是 出厂校准和信息 仅用于工厂或维护 所有 RF 电路板、基带发生器和主板

存(闪存) 文件、代码映像

512 字节 和自检限制

微处理器 是 否 CPU 数据和指 内存由 CPU 管理， CPU 电路板

高速缓存 令高速缓存 而不是由用户管理

(SRAM)

表 2-2 基本仪器内存

表 2-3 基带发生器内存(选项 601和 602)

在
正

常
操

作
过

程
中
可
以
写
入
?

在
关

机
时

保
留
数
据
?

内存类型 用途/内容 数据输入方法 备注

和容量

波形内存 是 否 波形(包括标题和 正常用户操作 在执行擦除和清理功能时，用户数据被

(SDRAM) 标尺数据)和 全面清理

40-320MB PRAM

BBG 固化 否 是 基带发生器的 固化软件升级

软件内存 固化软件映像

(闪存)

32 MB
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协处理器 是 否 基带协处理器 在正常操作过程 在正常基带发生器操作过程中使用这个内存。

内存 CPU 的工作内存 中，部分用户信息 用户不能直接访问这个内存

(SDRAM) (如净荷数据)可以

32 MB 保留在内存中

缓冲内存 否 否 支持 ARB 和 正常用户操作 在正常基带发生器操作过程中使用这个内存。

(SRAM) 实时应用使用 用户不能直接访问这个内存

5 x 512 kB 的缓冲内存

表 2-3 基带发生器内存(选项 601和 602)

在
正

常
操

作
过

程
中
可
以
写
入
?

在
关

机
时

保
留
数
据
?

内存类型 用途/内容 数据输入方法 备注

和容量

表 2-4 硬盘内存(选项 005)

在
正

常
操

作
过

程
中
可
以
写
入
?

在
关

机
时

保
留
数
据
?

内存类型 用途/内容 数据输入方法 备注

和容量

媒体存储 是 是 用户文件，包括 用户保存的数据 磁性残留数据要求多个重写周期或删除和

器(内置 平坦度校准、IQ 破坏驱动器

硬盘) 校准、仪器状态、

6 GB 或 波形(包括标题 硬盘是一个选项，因此部分仪器中没有安装

10 GB (在 和标尺数据)、 硬盘。如果安装了硬盘，这些文件会存在硬

这两种情况 调制定义和 盘上，而不是闪存中

下可用值 扫描列表

为 4 GB) 在执行擦除和清理功能时,用户数据会全部清理

缓冲内存 否 否 缓冲(高速缓存) 通过硬盘正常

(DRAM) 内存 操作

512 kB
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从 PSG 内存中删除敏感的数据

在把PSG从一个安全开发环境中移出时，可以删除仪器中存储的任何分类专有信息。本节介绍了可

以用来从仪器中删除敏感数据的多个安全功能。

Erase All (全部擦除)

这个功能删除所有用户文件、用户平坦度校准、用户 I/Q校准，并使用原始出厂值复位所有表格编辑

器，确保不能访问或查看用户数据和配置。仪器就象处于原厂状态一样，但内存没有清理。这一操作相

对快捷，所需时间不到一分钟。

为执行这一功能，按Utility > Memory Catalog > More (1 of 2) > Security > Erase All > Confirm Erase。

注 这个功能不同于按Utility > Memory Catalog > More (1 of 2) > Delete All Files，后者会删除所有

用户文件，但不会复位表格编辑器。

Erase and Overwrite All (全部擦除和重写)

这一功能执行的操作与Erase All (全部擦除)相同，然后它根据国防部(DoD)标准清除和重写各种内存

类型，如下所述。

SRAM：使用随机字符重写所有可寻址的位置。

CPU闪存：使用随机字符重写所有可寻址的位置，然后擦除闪存块。这可以实现与芯片擦除相同的目

的，但只会擦除不再使用的区域，出厂校准文件保持不变。

DRAM：使用随机字符重写所有可寻址的位置。

硬盘：使用一个字符重写所有可寻址的位置。(根据美国国防部标准，这对顶级机密数据是不够的。对

顶级机密数据，必须删除和破坏硬驱。)

为执行这一功能，按 Utility > Memory Catalog > More (1 of 2) > Security > Erase and Overwrite All >

Confirm Overwrite。
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Erase and Sanitize All (全部擦除和清理)

这一功能执行的操作与 Erase and Overwrite All (全部擦除和清理)相同，但增加了更多的重写操作。

在执行这一功能后，必须手动执行某些其它步骤，以使清理符合美国国防部(DoD)标准。下面介绍了这些

操作和步骤。

SRAM：在使用这一功能后，仪器必须在安全区域内保留足够长的时间，以保证随机重写装在内存中

的时间长于装在内存中的分类数据。也可以拆下SRAM电池，然后手动重新插入电池，但这要求打开

仪器。

DRAM：使用一个字符重写所有可寻址的位置。然后必须关闭仪器电源，清除内存内容。

硬盘：使用一个字符、然后使用一个随机字符重写所有可寻址的位置。(根据美国国防部标准，这对顶

级机密数据是不够的。对顶级机密数据，必须删除和破坏硬驱。)

为执行这一功能，按Utility > Memory Catalog > More (1 of 2) > Security > Erase and Sanitize All >

Confirm Sanitize。

使用安全模式

在下次仪器开机时，安全模式会自动使用选择的Security Level(安全等级)操作。

为设置安全模式的等级，按 Utility > Memory Catalog > More (1 of 2) > Security > Security Level，选

择下述选项：

None：相当于出厂预置值，不会丢失任何用户信息。

Erase：相当于Erase All (全部擦除)。

Overwrite：相当于Erase and Overwrite All (全部擦除和重写)。

Sanitize：相当于Erase and Sanitize All (全部擦除和清理)。

为激活安全模式，按Utility > Memory Catalog > More (1 of 2) > Security > Enter Secure Mode > Confirm。

Enter Secure Mode 软键变成Secure Mode Activated。

小心 一旦选择了安全等级操作，通过按Confirm激活安全模式，您将不能使安全等级无效或降低安

全等级。在下次仪器开机时，将执行该安全等级的擦除操作。安全模式一旦激活，您只能提高

安全等级。例如，您可以把Erase 变成Overwrite，但不能做相反操作。

注 在重新开机后，安全等级选择保持不变，但安全模式不会激活。
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如果仪器没有正确运行

如果仪器没有正确运行，不能使用安全功能，必须从仪器中拆下物理存储介质。这要求拆下硬盘和

处理器电路板，其应视为不能使用，并丢掉。然后可以把仪器送到修理厂，换上新部件，进行维修和校

准。拆卸程序请参阅维护指南。

使用安全显示

这个功能可以防止未经授权的人员读取仪器显示屏，通过前面板篡改当前配置。显示屏被隐去，只

显示 *** SECURE DISPLAY ACTIVATED ***，同时前面板各键会禁用。一旦激活这一功能，必须重新

开机，才能重新启动显示屏和前面板各键。

为使用这个功能，按 Utility > Display > More (1 of 2) > Activate Secure Display > Confirm Secure

Display

图 2-11 激活安全显示时的 PSG 屏幕
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启动选项

购买信号源后，可以进行翻新，增加新的功能。某些新的选装功能在必须安装的硬件中实现，某些

选项在软件中实现，但要求仪器中存在选装硬件。下面的实例说明怎样启动软件选项。

启动软件选项

为启动每个软件选项，要求一个许可密码(在许可密码证书上提供)。

1. 进入 Software Options(软件选项)菜单:

Utility > Instrument Adjustments > Instrument Options >Software Options。

下面是信号源显示屏实例，其中列明了启动的任何软件选项以及可以启动的任何软件选项。

2. 检验显示屏上显示的主机 ID与许可密码证书上的主机 ID相一致。主机 ID号码对每部仪器是唯一的。

如果许可密码中的主机 ID 与仪器不符，许可密码将不能启动软件选项。

3. 检验已经安装了要求的任何硬件。由于某些软件选项与特定的硬件选项相关，因此在启动软件选项

前，必须安装相应的硬件选项。例如，选项 420 (雷达模拟调制格式) 要求安装选项 601/602 (内置基

带发生器)。如果要安装的软件选项用灰色字体列出，那么可能没有安装要求的硬件(在 Hardware

Options 菜单相应硬件选项 "Selected" 一栏中看是否有一个 X)。
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4. 启动软件选项：

a. 高亮度显示希望启动的选项。

b. 按 Modify License Key，输入由 12 个字符组成的许可密码(见许可密码证书)。

c. 确定希望使用新选项重新配置信号源：Proceed With Reconfiguration > Confirm Change。

仪器启动选项，重新引导。
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使用网络服务器

可以使用网络服务器与信号源通信。这一服务使用 TCP/IP (传输控制协议 / 互联网协议)，通过互联

网与信号源通信。

网络服务器采用客户端/服务器模型，其中客户端是PC或工作站上的网络浏览器，服务器是信号源。

在启动网络服务器时，可以进入信号源上装载的网页。

如图2-12所示，基于网络的PSG网页提供了与信号源有关的整体信息，并提供了一种手段，可以使

用远程前面板接口或使用 SC[I(程控仪器标准通信)命令控制仪器。这个网页还提供了到安捷伦产品、支

持、手册和网站的链接。

注 网络服务器兼容最新版本的 Microsoft© Internet Explorer 网络浏览器。1

通过基于网络的PSG网页上的信号源Web Control菜单按钮，可以进入第二张网页。如图2-13所示，

这张网页提供了一个虚拟仪器接口，可以用来控制信号源。可以使用鼠标点击信号源的前面板硬键、软

键和数字附加键盘。还有一个文本框，可以用来把 SCPI 命令发送到仪器上。

激活网络服务器

通过下述步骤使用网络服务器。

1. 按Utility > GPIB/RS-232 LAN > LAN Services Setup > Web Server On，打开网络服务器。

2. 按Proceed With Reconfiguration 软键。

3. 按Confirm Change (仪器将重新引导)软键。信号源将重新引导。

4. 启动 PC 或工作站上的网络浏览器。

5. 在网络浏览器地址一栏中输入信号源的 IP 地址，如 http://101.101.101.101，用信号源的 IP

地址代替 101.101.101.101。按电脑键盘上的回车键。

1. Microsoft 是微软公司的注册商标。
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注 根据局域网配置，IP (互联网协议) 地址可能会变化。使用 LAN Config Manual DHCP 软键，

选择 Manual 或 DHCP (动态主机通信协议)局域网配置。详情请参阅 PSG 主要参考资料。

6. 按电脑键盘上的回车键。网络浏览器将显示信号源首页，如图 2-12 所示。这个网页显示与信号

发生器有关的信息，可以访问安捷伦网站。

图 2-12 信号源网页

7. 点击网页左边的信号源 Web Control 菜单按钮。将显示一个新网页，如图 2-13 所示。
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图 2-13 网页前面板

这个网页远程访问所有信号源的功能和操作。使用鼠标指针，点击信号源的硬键和软键。网页上将

显示每次点击鼠标的选择结果。例如，点击 Frequency硬键，然后使用前面板附加键盘，输入一个频率。

还可以使用向上和向下箭头键，提高或降低频率。

可以使用前面板显示屏底部的SCPI Command文本框，把命令发送到信号源。输入一条有效的SCPI

命令，然后点击 SEND按钮。将在标为 "SCPI Command Processed"的单独网页上显示命令结果。可以继

续使用这个网页，输入 SCPI 命令，也可以返回前面板网页。

注 如果网页没有使用新设置更新，可能需要使用网络浏览器的刷新功能。
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本章介绍了配备选项 601 或 602 的 E8267D PSG 矢量信号源提供的功能和特点。

“定制调制”，第 78 页

“任意(ARB)波形文件标题”，第 80 页

“使用双 ARB 波形播放器”，第 91 页

“使用波形标尺”，第 97 页

“触发波形”，第 113 页

“使用波形削波”，第 119 页

“使用波形定标”，第 127 页

另外还包括：

“定制任意波形发生器”，第 163 页

“多音波形发生器”，第 215 页

“双音波形发生器”，第 225 页

3   基本数字操作
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定制调制

为创建定制调制，信号源提供了两种工作模式：任意波形发生器模式和实时 I/Q基带模式。任意波形

发生器模式具有内置调制格式(如NADC或GSM)及预先定义的调制类型(如BPSK和16QAM)，可以用来

生成信号。实时 I/Q基带模式可以使用内置PN序列或用户自定义文件及各种调制类型和不同的内置滤波

器(如高斯滤波器或内奎斯特滤波器)，创建定制数据格式。

这两种工作模式都可以用来构建复杂的、数字调制信号，模拟通信标准，并可以灵活地修改现有数

字格式，定义或生成数字调制信号，增加信号损伤。

定制任意波形发生器

信号源的任意波形发生器模式是为带外测试应用设计的。可以使用这一模式生成模拟随机通信业务

的数据格式，还可以把它作为元器件测试的激励源使用。任意波形发生器模式的其它功能包括：

配置单载波或多载波信号。最多可以配置 100 个载波。

使用信号源的前面板接口创建波形文件。在作为随机数据创建时，波形文件可以作为元器件测试使用

的信号源，在这些测试中，可以测量邻道功率(ACP)等器件性能。在启动任意波形发生器时自动创建

的AUTOGEN_WAVEFORM文件可以重新命名，并存储在信号源的非易失性内存中。可以在以后把

这个文件加载到易失性内存中，并使用双 ARB 波形播放器进行播放。

如需更多信息，请参阅第 91 页“使用双 ARB 波形播放器”和第 7 页“工作模式”。
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定制实时 I/Q 基带

实时模式使用用户定义的调制类型及定制 FIR滤波器和码速率，模拟单通道通信。可以把数据从外

部信号源下载到 PRAM 内存中，或使用外部输入作为实时数据提供。实时 I/Q基带模式还生成预先定义

的数据格式，如PN9或FIX4。在这种模式下生成的连续数据流可以用来分析接收机误码。这种模式仅限

于单载波。实时 I/Q 基带模式：

提供的数据类型和调制类型要多于任意波形发生器模式。

支持定制 I/Q 星座格式。

能够为误码率测试(BERT)生成连续的 PN 序列。

在改变信号参数时，不需要波形构建时间。

如需更多信息，请参阅第164页定制任意波形发生器“概述”、第192页定制实时波形发生器“概述”

和第 7 页“数字调制”。
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任意(ARB)波形文件标题

任意波形文件标题可以与波形一起保存仪器设置信息(主要格式设置)。在检索存储的波形时，在波形

开始显示时会应用标题信息，每次双 ARB 播放器会以相同的方式进行设置。

标题还可以包括用户指定的存储波形或序列文件的 32 个字符说明。

在生成波形、生成波形序列或把波形文件下载到PSG时，将自动创建默认标题(下载文件详情请参阅

PSG 编程指南 )。

下述信号源设置保存在文件标题中：

ARB 取样时钟速率

运行时定标(仅适用于双 ARB 播放器中)

标尺设置和路由功能(第 97 页)

－极性

－ ALC 保持

－ RF 消隐

高波峰模式(仅适用于双 ARB 播放器中)

调制器衰减

调制器滤波器

I/Q 输出滤波器(在把信号路由到后面板 I/Q 输出时使用)

用户不能设置的其它仪器优化设置(适用于 PSG 生成的文件)
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为调制格式波形创建文件标题

在打开调制格式时，PSG 生成一个临时的波形文件(AUTOGEN_WAVEFORM)，并具有默认的文件

标题。默认标题没有保存任何信号源设置。

所有 ARB 格式都采用下述程序，说明了怎样为定制数字调制格式创建文件标题：

1. 预置信号源。

2. 打开定制调制格式：

按Mode > Custom > ARB Waveform Generator > Digital Modulation Off On 到 On。

创建默认文件标题，播放临时波形文件(AUTOGEN_WAVEFORM)。

图 3-1 是 PSG 的显示画面。

图 3-1 定制数字调制第一级软键菜单

这时，已经创建了默认文件标题，并采用默认(没有指定的)设置，其没有体现活动调制的当前信号

发生器设置。为保存活动调制的设置，必须在与波形文件一起保存标题信息前，修改默认设置(参阅

第82 页“修改调制格式中的标题信息”)。

注 每次在打开ARB调制格式时，会生成一个新的临时波形文件(AUTOGEN_WAVEFORM)和文件

标题，覆盖以前的临时文件和文件标题。由于所有ARB格式都采用相同的文件名，即使以前的

AUTOGEN_WAVEFORM 文件是由不同的 ARB 调制格式创建的，仍会发生覆盖。

第一级软键菜单 ( 某些

ARB格式有第二页)
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修改调制格式中的标题信息

这一程序以上面的程序为基础，介绍了文件标题的不同区域，说明了怎样访问、修改及保存信息变化。

在调制格式中，可以只在调制格式激活(打开)时才访问文件标题。这一程序使用定制数字调制格式。

所有ARB调制格式和双ARB播放器以相同方式访问文件标题，但有一点例外，即在某些调制格式中，您

可能必须进入第一级软键菜单的第二页。

1. 从第一级软键菜单中(如第 81 页图 3-1 所示)，打开 Header Utilities 菜单：

按ARB Setup > Header Utilities

图 3-2 显示了定制数字调制波形的默认标题。Saved Header Settings (保存的标题设置)一栏显示了

Unspecified(没有指定的)活动格式的信号源设置，“没有指定”意味着没有把任何设置保存到文件

标题中。

注 如果文件标题中没有指定设置，在将来选择和播放波形时，信号源对该设置的当前值保持

不变。

Current Inst. Settings一栏显示了活动调制的当前信号源设置。在保存到文件标题中时(如第2步所示)，

这些设置变成保存的标题设置。

图 3-2 定制数字调制默认标题显示
允许输入和编辑 Description

字段

把Saved Header Settings一栏

清除到默认设置

把 Current Inst. Settings 一栏

保存到Saved Header Settings

一栏

当前信号源设置

第 1页

第 2页

默认标题设置

注：

只能在双ARB播放器中设置没有

活动的参数(如 Runtime Scaling)
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2. 把 Current Inst. Settings 一栏中的信息保存到文件标题中：

按Save Setup To Header。

Saved Header Settings一栏和Current Inst. Settings一栏现在显示相同的设置；Saved Header Settings一

栏列明了文件标题中保存的设置。

文件标题包含下述信号源设置：

32 个字符描述： 输入标题的描述信息，如波形的功能(使用 Edit Description 键保存 / 编辑，

参阅第 82 页图 3-2)。

取样速率： ARB 取样时钟速率

运行时定标 运行时定标值。在播放波形时实时应用运行时定标。只能对双ARB播放器

中的文件改变这一设置

标尺 1...4 极性： 标尺极性，正或负(参阅第 112 页)

ALC 保持路由： 如有，表明哪个标尺实现 PSG 的 ALC 保持功能(参阅第 99 页)

RF 消隐路由： 如有，表明哪个标尺实现 PSG 的 RF 消隐功能(参阅第 111 页)

I/Q 调制滤波器： I/Q 输出滤波器设置。I/Q 输出滤波器用于路由到后面板 I 输出和 Q 输出的

I/Q 信号

调制衰减 I/ 调制器衰减设置

3. 返回 ARB Setup 菜单：按 Return。

在 ARB Setup 菜单下(如图 3-3 所示)，可以改变当前仪器设置。图 3-3 还显示了第 4 步到第 9 步使用

的软键路径。

4. 把 ARB 取样时钟设为 5 MHz：按ARB Sample Clock > 5 > MHz。

5. 把调制器衰减设为 15 dB：

按More (1 of 2) > Modulator Atten n.nn dB Manual Auto 直到 Manual > 15 > dB。

6. 把 I/Q 调制滤波器设为直传滤波：

按 I/Q Mod Filter Manual Auto，直到 Manual > Through。

7. 把标尺 1 设为在设定标尺点上消隐 RF 输出：

按More (2 of 2) > Marker Utilities > Marker Routing > Pulse/RF Blank > Marker 1。

如需与标尺设置有关的信息，请参阅第 97 页“使用波形标尺”。

8. 把标尺 1 的极性设为负：

按Return > Marker Polarity > Marker 1 Polarity Neg Pos 直到 Neg。
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9. 返回 Header Utilities 菜单：按 Return > Return > Header Utilities。

注意 Current Inst. Settings 一栏现在反映了第 4 步到第 8 步当前信号源设置中所作的变化，但保存的

标题值没有变化(如第 86 页图 3-4 所示)。

10. 把当前设置保存到文件标题中：按Save Setup To Header 软键。

Current Inst. Settings一栏的设置现在显示在 Saved Header Settings 一栏中。文件标题已经修改，当前

仪器设置已经保存，如第 86 页图 3-5 所示。

在调制格式激活(打开)时，波形文件(AUTOGEN_WAVEFORM)播放，可以在活动的调制格式内修改

标题信息。一旦关闭调制格式，只能通过双 ARB 播放器提供标题信息。

注 如果关闭调制格式，然后再打开调制格式，会覆盖以前的 AUTOGEN_WAVEFORM 文件及其

文件标题。为避免这种情况，在重新打开调制格式前，应重新命名文件(参阅第 96 页)。

存储波形文件功能(参阅第 96 页)可以与波形一起存储保存的标题信息。
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图 3-3 ARB 设置软键菜单和标尺辅助工具

双 ARB 播放器软键

(它没有出现在 ARB格式中)
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图 3-4 取值在标题栏和当前设置栏之间不同

图 3-5 保存的文件标题变化

两栏的值不同

两栏的值不同

第 1页

第 2 页

第 1页

第 2页
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为双 ARB 播放器波形序列存储标题信息

在创建波形序列时(参阅第 93页)，PSG自动创建默认的文件标题，其优先权要高于构成波形序列的

波形段的标题。在波形序列播放过程中，会忽略波形段标题(检验是否安装了所有要求的选项时除外)。在

存储波形序列时，其文件标题与其一起存储。

修改和查看双 ARB 播放器中的标题信息

一旦调制格式关闭，那么只有双ARB播放器才能使用波形，这也适用于下载的波形文件。正因如此，

将来编辑波形标题信息必须使用双 ARB 播放器执行。

为在双ARB播放器中修改标题信息，必须在双ARB播放器中播放波形文件(但可以在不播放文件的

情况下，在双 ARB 播放器中查看标题信息)。

通过重新选择播放的波形文件，可以重新应用保存的标题设置。在进行这一操作时，Saved Header

Settings 一栏的值应用到 PSG 中。

修改标题信息

第 82 页的“修改调制格式中的标题信息”所示的相同的标题特点也同样适用于双 ARB 播放器。这

一任务可以引导您选择波形文件，访问选择的文件标题，然后您可以重新参阅上述程序，执行修改操作。

1. 选择一个波形：

a. 按Mode > Dual ARB > Select Waveform。

b. 使用箭头键，高亮度显示希望的波形文件。

c. 按Select Waveform 软键。

2. 播放波形：按 ARB Off On 直到 On。

3. 访问标题：按 ARB Setup > Header Utilities。

4. 请参阅“修改调制格式中的标题信息”，编辑标题信息：

    对默认标题，请参阅第 82 页第 1 步中的信息，然后执行程序中的其余步骤。

    为修改现有文件标题，从第 83 页第 3 步开始。

本节其余部分将把重点放在双 ARB 播放器中的其它文件标题操作上。
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在关闭双 ARB 播放器时查看标题信息

调制格式与双 ARB播放器之间的一个差别是，即使在双 ARB 播放器关闭时，您仍可以查看文件标

题。但是，只有双ARB播放器打开，且选择了显示的标题进行播放时，才能修改显示的文件标题。在双

ARB 播放器关闭时，执行下述步骤。

1. 选择一个波形：

a. 按Mode > Dual ARB > Select Waveform。

b. 高亮度显示希望的波形文件。

c. 按Select Waveform 软键。

2. 访问文件标题：按 ARB Setup > Header Utilities。

现在可以在PSG显示屏中查看标题信息。如图3-6所示，标题编辑软键用灰色显示，表明其没有激活。

图 3-6 查看标题信息

标题编辑软键用灰色显示

文件标题信息和当前信号

源设置

注：在双ARB播放器关闭时，

当前仪器设置栏没有更新；

显示的值无效。
第 1页

第 2页
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查看不同波形文件的标题信息

在双ARB播放器中播放波形时，可以查看不同波形文件的标题信息，但只能修改目前播放的波形的

标题信息。在选择另一个波形文件时，标题编辑软键用灰色显示(参阅图 3-6)。这一操作将引导您完成提

供的查看选项。

1. 查看波形文件列表:按Mode > Dual ARB > ARB Setup > Header Utilities > View Different Header。

如图 3-7 所示，在表中有一个波形文件的字母列表。

图 3-7 查看不同标题的波形文件列表

2. 查看非易失性内存中的所有波形段：

a. 按 Catalog Type 软键。如图 3-7 所示，在第一步访问的表格中能够显示的波形文件类型有三种。

NVWFM 显示非易失性内存中存储的所有波形段

Seq 显示所有波形序列文件

WFM1 显示易失性内存中存储的所有波形段

b. 按 NVWFM 软键。 表格显示非易失性内存中的波形文件。

3. 查看波形文件的标题信息：高亮度显示文件，按 View Header 软键。

选择的波形文件的标题信息出现在 PSG显示屏中。如果波形正在播放，将用这些信息代替其标题信

息，但信号源使用的波形设置不变。为返回正在播放的波形的标题信息，按View Different

Header，选择当前正在播放的波形文件，按 View Header；或按Return > Header Utilities。

当前波形文件类型

波形文件类型

表格
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播放包含标题的波形文件

在调制格式中生成波形文件(AUTOGEN_WAVEFORM)、且关闭格式后，可以存取文件，但只有双

ARB 播放器才能播放文件。这也适用于下载的波形文件(编程指南中介绍了文件下载)。在选择波形进行

播放时，信号源使用保存的标题信息。部分设置作为设置参数使用的软键标签的一部分显示，另外还显

示在双 ARB 摘要显示屏上(参阅图 3-8)。

注 播放存储的波形文件使用的信号源必须拥有生成文件所要求的相同选项。

应用文件标题设置和播放波形详情请参阅第 94 页“播放波形”。

为正确设置仪器：

1. 选择波形。

2. 根据需要修改信号源设置。

3. 关闭双 ARB。

图 3-8 文件标题设置

在选择波形时会变化

没有选择波形；应用预置设置

摘要显示

标题设置与预置设置相同

应用标题设置

选择波形；应用保存的

标题设置

摘要显示
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使用双ARB波形播放器

双任意(ARB)波形播放器用来创建、编辑和播放波形文件。波形文件分成两类：波形段和波形序列。

波形段是使用信号源预先定义的其中一种ARB格式创建的波形文件。波形序列是被串在一起的多个波形

段，从而形成一个新的波形文件。还可以使用另一部信号源或使用计算机程序远程创建波形文件，并把

波形文件下载到PSG中，由双ARB波形播放器进行播放。如需与波形下载有关的更多信息，请参阅PSG

编程指南。

在打开 A R B 调制格式时，会自动生成波形文件。自动生成的这一文件被命名为

AUTOGEN_WAVEFORM。由于这一默认文件名称在所有ARB格式之间共享，因此如果想保存信息，必

须重新命名。如果文件没有重新命名，那么在打开另一种 ARB 格式时将覆盖这个文件。

双 ARB 波形播放器提供了标尺(第 97 页)、触发(第 113 页)和削波(第 119 页)功能。

在能够处理任何波形文件前，波形文件必须装在易失性内存中。信号源有两类内存：WFM1 (易失性

波形内存)和 NVWFM (非易失性波形内存)。在任何波形发生器打开时创建的新生成的波形文件

(AUTOGEN_WAVEFORM )在开始时装在 WFM1 中。如果想保存这个文件，重新命名，把它存储在

NVWFM中。把一个存储的波形文件从NVWFM加载到易失性内存中(WFM1)，然后可以通过ARB波形

播放器进行编辑或播放。详情请参阅第 78 页“定制调制”。

访问双 ARB 播放器

按Mode > Dual ARB。

下图中显示了这个第一级软键菜单，大多数程序从这个菜单开始。
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创建波形段

有两种方式提供波形排序器使用的波形段。既可以通过远程接口下载波形，也可以使用其中一种

ARB 调制格式生成波形。通过远程接口下载波形的详情请参阅编程指南。

波形序列由多个段组成，同时还包含其它序列。可以使用任意数量的波形段(最多32768个)创建一个

序列。这一极限数量取决于波形序列中的段数。段和序列可以在一个波形序列内重复，所有段和重复段

的总数不能超过极限数量。下图显示了由最多两个序列和三个段组成的一个波形序列。在本例中，段数

是 11。

图 3-9 波形序列图

下述程序介绍了怎样创建两个波形段，然后命名、并存储到ARB内存中。在命名及把两个波形段存

储到 ARB 内存中后，可以使用这两个波形段构建波形序列，参见第 93 页说明。

1. 生成第一个波形：

a. 按Preset > Mode > Two Tone > Alignment Left Cent Right，直到 Right。

b. 按 Two Tone Off On，直到 On，然后直到 Off。

在生成后关闭 Two Tone 模式，因为在使用时不能把波形重新命名为波形段。

生成一个双音波形，右边的音调放在载频上。在波形生成过程中，T-TONE和 I/Q报警器激活。波形

存储在易失性内存中，默认文件名为 AUTOGEN_WAVEFORM。
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注 由于在任何给定时间内存中只能有一个 AUTOGEN_WAVEFORM 波形，必须重新命名这个文

件，以便为第二个波形清出道路。

2. 创建第一个波形段：

a. 按 Mode > Dual ARB > Waveform Segments > Load Store 直到 Store。

b. 高亮度显示默认波形段 AUTOGEN_WAVEFORM。

c. 按 Rename Segment > Editing Keys > Clear Text。

d. 输入文件名(例如 TTONE)，按 Enter > Store Segment To NVWFM Memory。

重新命名波形段，在非易失性内存中存储副本。

3. 生成第二个波形：

a. 按 Mode > Multitone > Initialize Table > Number Of Tones > 9 > Enter > Done。

b. 按 Multitone Off On，直到 On，然后按到 Off。

记住，在使用时不能把波形重新命名为波形段。生成带有 9个音调的多音波形。在波形生成过程中，

M-TONE 和 I/Q 报警器激活。波形存储在易失性内存中，默认文件名为 AUTOGEN_WAVEFORM。

4. 创建第二个波形段：

重复第 2 步，为这个波形段提供一个描述性名称(如 MTONE)。

构建和存储波形序列

本例说明了怎样使用第 92 页创建的两个波形段构建和编辑波形序列。为使用序列中的波形段，波

形段必须装在易失性内存中。如需与把波形段从非易失性内存装载到易失性内存中的更多信息，请参阅

第 96 页。

1. 选择波形段：

定义一个序列，其中包括重复一次的双音波形段，后面跟着重复一次的九音多音波形段。

a. 按Mode > Dual ARB > Waveform Sequences > Build New Waveform Sequence > Insert Waveform。

b. 高亮度显示波形段(如 TTONE)，按 Insert Selected Waveform。

c. 高亮度显示第二个波形段(如 MTONE)，按 Insert Selected Waveform。

d. 按 Done Inserting。

2. 可选：根据需要对新序列的波形段启动标尺：参见第 108 页。

3. 命名、并把波形序列存储到内存目录中的 Catalog of Seq Files 中:
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a. 按Name and Store。

b. 输入文件名(如 TTONE+MTONE)。

c. 按Enter。

播放波形

这一程序适用于播放波形段或播放波形序列。本例播放前面的程序中创建的波形序列。

1. 选择一个波形序列：

a. 按Mode > Dual ARB > Select Waveform。

b. 高亮度显示 Select Waveform 目录 Sequence 一栏中的波形序列(在本例中是 TTONE+MTONE)，

按Select Waveform。

显示屏显示目前选择的波形(如 Selected Waveform: SEQ:TTONE+MTONE)。

2. 生成波形：

按ARB Off On 直到 On。

播放选择的波形序列。在生成波形序列过程中，ARB 和 I/Q 报警器激活。

编辑波形序列

本例说明了怎样编辑波形序列内部的波形段，然后用新名称保存编辑的序列。在编辑显示画面中，可

以改变波形段播放的次数(重复次数)，删除波形段，增加波形段，拨动标尺(参阅第 108 页)，保存变化。

注 如果在退出波形序列编辑显示画面前没有把变化存储到波形序列中，变化会被删除。

1. 按Waveform Sequences > Edit Selected Waveform Sequence，高亮度显示第一项。

2. 按Edit Repetitions > 100 > Enter。自动选择第二个波形段。

3. 按Edit Repetitions > 200 > Enter。

4. 把编辑后的文件保存为新的波形序列：

a. 按Name And Store。
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b. 按 Editing Keys > Clear Text，然后输入新的文件名(如 TTONE100+MTONE200)。

c. 按 Enter。

现在已经分别把每个波形段项目的重复次数从1变成100和200。序列已经用新名称存储到信号源内

存目录的 Catalog of Seq Files 中。

播放波形序列的详情请参阅第 94 页。

在双 ARB 波形中增加实时噪声

在双ARB波形发生器播放调制波形文件时，配备选项403的信号源可以实时把AWGN (附加白高斯

噪声)应用到载波中。AWGN可以使用前面板软键配置。Carrier to Noise Ratio软键可以指定相对于信号

上应用的载波功率的噪声功率数量。Carrier Bandwidth软键设置噪声积分的带宽，Noise Bandwidth Fac-

tor 软键允许选择平坦的噪声带宽。PSG 主要参考资料中介绍了这些软键。

下述程序设置载波，并使用预先定义的 SINE_TEST_WFM 波形文件调制载波。然后对该载波应用

AWGN。

配置 AWGN

1. 预置信号源。按Preset 硬键。

2. 按 Frequency 硬键，输入 15 GHz。

3. 按Amplitude 硬键，输入 -10 dBm。

4. 按RF On Off 直到On。

5. 按Mode > Dual ARB > Select Waveform，选择 SINE_TEST_WFM 波形。

6. 按Select Waveform。

7. 按ARB Off On 直到On。

8. 按ARB Setup > ARB Sample Clock，输入 50 MHz。

9. 按Real-time Noise Setup > Carrier to Noise Ratio，输入 30 dB。

10. 按Carrier Bandwidth，输入 40 MHz。

11. 按Real-time Noise Off On 直到On。

这一程序对 15 GHz 载波增加 AWGN。信号源显示的功率电平为 -10 dBm，其中包括其设为 30 dB

载波噪声比(C/N)的噪声功率。对 C/N，在 40 MHz 的载波带宽中增加噪声功率。默认的噪声带宽系数是

1，其提供的平坦噪声信号带宽至少是 50 MHz 取样速率的 0.8 倍。
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存储和加载波形段

波形段可以作为WFM1文件装在易失性内存中，也可以作为NVWFM文件存储到非易失性内存中，

也可以是两者。为播放或编辑波形文件，它必须装在易失性内存中。由于存储在易失性内存中的文件在

重新开机时会丢失，因此最好把重要文件存储到非易失性内存中，在希望使用时再把其加载到易失性内

存中。

把波形段存储到非易失性内存中

1. 按 Mode > Dual ARB > Waveform Segments。

2. 如果需要，按 Load Store 直到 Store。

3. 按Store All To NVWFM Memory。

所有WFM1波形段文件的副本已经作为NVWFM文件存储在非易失性内存中。如果想单独存储文件，

高亮度显示文件，按Store Segment To NVWFM Memory。

从非易失性内存中加载波形段

1. 清空易失性内存，删除所有 WFM1 文件，关闭仪器电源。

2. 按Mode > Dual ARB > Waveform Segments。

3. 如果需要，按 Load Store 直到 Load。

4. 按 Load All From NVWFM Memory。

所有 NVWFM 波形段文件的副本已经作为 WFM1 文件加载到易失性内存中。如果想单独加载文件，

高亮度显示文件，按 Load Segment From NVWFM Memory。

重新命名波形段

1. 按Mode > Dual ARB > Waveform Segments。

2. 高亮度显示希望的文件，按Rename Segment > Editing Keys > Clear Text。

3. 输入希望的文件名，然后按Enter。



97第 3 章

基本数字操作

使用波形标尺

使用波形标尺

信号源为标记波形段上的特定点提供了四个波形标尺。在信号源遇到启动的标尺时，辅助输出信号

路由到与标尺号码对应的后面板事件连接器上(参见第22页“后面板”)。可以使用这个辅助输出信号，把

另一台仪器与波形同步，或作为触发信号，在波形给定点上开始测量。

还可以配置标尺，启动 ALC 保持或 RF 消隐(包括 ALC 保持)。

创建波形段(第92页)还会创建一个标尺文件，把标尺点放在标尺1和标尺2波形段的第一个样点上。

在下载的波形文件没有相关的标尺文件时，信号源创建没有任何标尺点的标尺文件。出厂时提供的波形

段在所有四个标尺的第一个样点上有一个标尺点。

下面的程序说明了怎样在双ARB 播放器中工作时使用标尺，但在处理任何ARB 格式时也采用这一

流程。

这些程序还讨论了两类点：标尺点和样点。标尺点是波形上设置给定标尺的点；可以为每个标尺设

置一个或多个标尺点。样点则是构成波形的多个点中的一个点。

使用波形标尺有三个基本步骤：

“1. 从波形段中清除标尺点”，第 104 页

“2. 在波形段中设置标尺点”，第 105 页

“3. 控制波形序列中的标尺(仅适用于双 ARB)”，第 108 页

本节还提供了下述信息：

“波形标尺的概念”，第 98 页

“访问标尺辅助工具”，第 102 页

“查看波形段标尺”，第 103 页

“查看标尺脉冲”，第 110 页

“使用 RF 消隐标尺功能”，第 111 页

“设置标尺极性”，第 112 页
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波形标尺的概念

信号源的ARB格式为标记波形段上的特定点提供了四个波形标尺。可以设置每个标尺的极性和标尺

点(在一个样点上或在一个样点范围内)。每个标尺还可以执行 ALC 保持或 RF 消隐和 ALC 保持功能。

在信号源遇到启动的标尺时(参阅第108页)，会生成一个辅助输入信号，并路

由到与标尺编号(N)对应的后面板事件连接器上。EVENT 3 和 4 连接器是

AUXILIARY I/O 连接器上的针脚(连接器位置如第 22 页图 1-3 所示)。

标尺文件生成

生成波形段(参阅第 92 页)自动创建一个标尺文件，把标尺点放在标尺 1和标尺 2 的波形段的第一个

样点上。

下载没有相关的标尺文件的波形文件(参阅PSG编程指南)会创建一个不会放置任何标尺点的标尺文件。

标尺点编辑要求

在能够修改波形段的标尺点之前，波形段必须装在易失性内存中(参阅第96页“从非易失性内存中加

载波形段”)。

在双ARB 播放器中，可以修改波形段的标尺点，而不必播放标波，或在 ARB 调制格式中同时播放

波形。

在 ARB 调制格式中，在修改波形段的标尺点之前，必须播放波形。

保存标尺极性和路由设置

标尺极性和路由设置会保持不变，直到重新配置这些设置、预置信号源或关闭PSG电源。为保证波

形播放时采用正确的设置，设置标尺极性或路由(RF消隐和ALC保持)，把信息保存到文件标题中(第 80

页)。在波形段作为序列的一部分播放时，这一点尤其重要，因为以前播放的波形段可能会有不同的标尺

和路由设置。
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ALC 保持标尺功能

尽管可以在设置标尺点之前或之后(第105页)设置标尺功能(在软键标签上描述为Marker Routing)，但

在设置标尺点之前设置标尺功能可能会在 RF 输出上导致功率峰值或掉电。

在拥有采用空闲周期的波形信号时，或不希望更高的动态范围遇到RF消隐时(第 111页)，应自行使

用 ALC 保持功能。

ALC保持标尺功能把ALC电路保持在标尺设置的取样点的平均(RMS)值。对正标尺极性和负标尺极

性，在标尺信号变高时 ALC 对 RF 输出信号取样(载波加任何调制信号)：

正： 在 on 标尺点过程中对信号取样。

负： 在 off 标尺点过程中对信号取样。

标尺信号的响应相对于波形信号响应有最低两个样点的延迟。为补偿标尺信号延迟，把标尺点从希

望 ALC 取样开始的波形样点偏移开。

注 由于其可能会影响波形的输出幅度，使用 ALC 保持功能的时长不能超过 100 ms。对更长的时

间间隔，请参阅第 283 页“设置功率搜索模式”。

小心 ALC取样不正确可能会导致突然不置平情况，其可能会在RF输出中产生峰值，可能会损坏DUT

或连接的仪器。为防止这种情况，应保证把标尺设置成允许ALC在考虑了信号内部遇到较高功

率电平的幅度上取样。
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正确使用的实例

波形：1022 点

标尺范围：95-97

标尺极性：正

本例说明了标尺设成对波形幅度最高的区域取样。

注意在波形幅度最低的区域前设置了标尺，这考虑了

标尺和波形信号之间的响应差异。

使用不正确的实例

波形：1022 点

标尺范围：110-1022

标尺极性：正

本例说明了一个设为对同一波形较低部分取样的标尺，

它设置该电平的 ALC 调制器；在遇到脉冲的高幅度时，

这通常会导致信号源发生没有置平的情况。

在标尺信号变高时，ALC 对波形取样，

使用取样的波形的平均值，设置 ALC 电路。

这里，ALC 在 on 标尺点(正极性)过程中取样。

平均特写

脉冲没有置平

标尺 标尺
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使用不正确的实例

波形：1022 点

标尺范围：110-1022

标尺极性：负

本图显示了在标尺on点过程中负极性标尺变低；在

off点过程中标尺信号变高。ALC在off标尺点过程中对

波形取样。

对on时间和off时间取样会把调制电路不正确地设

置成较高的信号电平。注：幅度在脉冲开始处提高。

取样范围在信号的第一点上开始

在信号和 off时间之间设置负的范围
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访问标尺辅助工具

使用下述程序，显示标尺参数。这个程序使用双ARB播放器，但在所有ARB格式中都可以通过ARB

Setup 软键访问标尺辅助工具。

1. 选择 ARB 波形播放器：

按Mode > Dual ARB

2. 按ARB Setup > Marker Utilities。

在使用双ARB之外的ARB格式时，必

须打开该格式，启动Set Markers软键。

注 本节中的大多数程序是从Marker Utilities 软键菜单开始的。
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查看波形段标尺

对波形段应用标尺，使用下述步骤查看为波形段设置的标尺(本例使用出厂时提供的波形段

SINE_TEST_WFM)。

1. 在 Marker Utilities 菜单中(第 102 页)，按Set Markers。

2. 高亮度显示希望的波形段。

在 ARB 格式下，只有一个文件(AUTOGEN_WAVEFORM)，并已经高亮度显示。

3. 按Display Markers > Zoom in Max。最大放大范围是 28点。试验Zoom功能，查看其怎样显示标尺。

显示屏可以显示最多 460 点；显示的波形样点范围超过 460 点的，可能会不能显示标尺的位置。

选择一个段

Set Marker 显示

下面的画面显示了波形的 I和Q成分及出厂提供的波形段中设置的标尺点。

第一个

样点上的

标尺点

显示屏上显示

的第一个样点

这些软件改变

了标尺显示画

面上显示的波

形样点

每次按软键，都

会以系数2近似

改变取样范围
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1. 从波形段中清除标尺点

在设置标尺点时，它们不会代替已经存在的点，而是在现有点基础上设置。由于标尺是累积的，因

此在设置标尺点之前，要先查看波形段(第103页)，去掉任何不想要的标尺点。在清除所有标尺后，事件

输出信号的电平是 0V。

清除所有标尺点

1. 在 Marker Utilities 菜单(第 102 页)，按Set Markers。

2. 高亮度显示希望的波形段。

在 ARB 格式下，只有一个文件(AUTOGEN_WAVEFORM)，并且已经高亮度显示。

3. 高亮度显示希望的标尺编号：

按Marker 1 2 3 4。

4. 对选择的标尺编号，删除选择的波形段中所有标尺点：

按Set Marker Off All Points。

5. 对希望删除的任何其余标尺点，从第 3 步重复操作。

清除一个范围内的标尺点

下面的实例采用的波形标尺点 (标尺1)设为第10个到第20个点，这可以简便地查看受影响的标尺点。

不管是在一个范围内设置现有点(第 105 页)还是作为单独的点设置现有点(第 106 页)，都适用同一流程。

1. 在 Marker Utilities 菜单中(第 102 页)，选择希望的标尺(在本例中是 Marker 1)。

2. 设置要关闭的第一个样点 (本例中是 13):

按Set Marker Off Range Of Points > First Mkr Point > 13 > Enter。

3. 把希望关闭的范围内最后一个标尺点设成小于等于波形中的点数、且大于等于第2步中设置值的值(在

本例中是 17):

按 Last Mkr Point > 17 > Enter > Apply To Waveform > Return。

关闭第 2 步和第 3 步中设置的范围内活动标尺的所有标尺点，如下图所示。

第103页介绍了怎样查看标尺
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清除单个标尺点

使用第 104 页“清除一个范围内的标尺点”中介绍的步骤，但要把第一个标尺点和最后一个标尺点

都设成希望清除的点值。例如，如果想清除第 5 个点上的标尺，把第一个点和最后一个点都设成 5。

2. 在波形段中设置标尺点

为在波形段上设置标尺点，波形段必须位于易失性内存中(第 96页)。在设置标尺点时，它们不会代

替已经存在的点，而是在现有点基础上设置。由于标尺是累加的，因此在波形段内设置标尺点之前，要

先查看波形段(第 103 页)，去掉任何不想要的点(第 104 页)。

把标尺放在一个范围内的点上

1. 在 Marker Utilities 菜单中(第 102 页)，按Set Markers。

2. 高亮度显示希望的波形段。

在 ARB 格式下，只有一个文件(AUTOGEN_WAVEFORM)，并且已经高亮度显示。

3. 高亮度显示希望的标尺编号：

按Marker 1 2 3 4

4. 设置范围内的第一个样点(在本例中是 10):

按Set Marker On Range Of Points > First Mkr Point > 10 > Enter。

5. 把范围内的最后一个标尺点设成小于等于波形中的点数、且大于等于第一个标尺点的值

(在本例中是 20):

按 Last Mkr Point > 20 > Enter。
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6. 按Apply To Waveform > Return。

设置一个波形标尺点范围。标尺信号从样点 10 开始，在样点 20 结束，如下图所示。

第 103 页介绍了怎样查看标尺

把标尺放在一个点上

在第一个点上

1. 在Marker Utilities 菜单中(第 102 页)，按Set Markers。

2. 高亮度显示希望的波形段。

在 ARB 格式下，只有一个文件(AUTOGEN_WAVEFORM)，并且已经高亮度显示。

3. 高亮度显示希望的标尺编号：

按Marker 1 2 3 4

4. 按Set Marker On First Point。

对第 3 步中选择的标尺编号，在波形段的第一个点上设置标尺。

在任意点上

使用第 105 页“把标尺放在一个范围内的点上”介绍的步骤，但要把第一个和最后一个标尺点都设

成希望设置的点值。例如，如果想在第 5 个点上设置标尺，把第一个值和最后一个值都设成 5。

放置间隔重复的标尺

下面的实例在一个范围内的点上设置标尺，指定了每个标尺之间的间隔(跳过的点)。必须在应用标尺

设置前设置间隔；不能对以前设置的范围内的点应用跳动的点。

1. 删除任何已有的标尺点(第 104 页)。

2. 在Marker Utilities 菜单中(第 102 页)，按Set Markers。
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3. 高亮度显示希望的波形段。

在 ARB 格式下，只有一个文件(AUTOGEN_WAVEFORM)，并且已经高亮度显示。

4. 高亮度显示希望的标尺编号：按Marker 1 2 3 4

5. 设置范围内的第一个样点(在本例中是 5):

按Set Marker On Range Of Points > First Mkr Point > 5 > Enter。

6. 把范围中的最后一个标尺点设成小于波形中的点数、且大于等于第一个标尺点的值(在本例中是 25):

按 Last Mkr Point > 25 > Enter。

7. 输入想跳过的样点数量(在本例中是 1):

按 # Skipped Points > 1 > Enter。

8. 按Apply To Waveform > Return。

导致标尺点范围内每隔一个点发生标尺 (跳过一个样点)，如下图所示。

第 103 页介绍了怎样查看标尺

跳过的点功能的一个应用是作为辅助输出创建一个时钟信号。
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3. 控制波形序列中的标尺(仅适用于双 ARB)

在波形段中，启动标尺点生成一个辅助输出信号，这个信号路由到与该标尺编号相对应的后面板事

件连接器上(参见第 22页“后面板”介绍)。对波形序列，可以逐段启动或禁止标尺；这可以对某些波形

段顺序输出标尺，但对某些波形段不输出标尺。除非改变标尺设置或重新开机，设置对下一个加载序列

保持不变。

在创建波形序列时

在选择波形段创建波形序列后，且在命名和保存序列前，可以独立启动或禁用每个段的标尺。启动

没有任何标尺点的标尺(第 105 页)对辅助输出没有任何影响。

1. 选择波形段(第 93 页第 1 步)。

2. 把标尺拨到希望的位置：

a. 高亮度显示第一个波形段。

b. 按Enable/Disable Markers。

c. 根据需要按 Toggle Marker 1, Toggle Marker 2, Toggle Marker 3 和 Toggle Marker 4。

拨动没有任何标尺点的标尺(第 105 页)对辅助输出没有任何影响。

Mkr一栏中有项目(参阅下图)表明为该段启动了标尺;这一栏中没有项目表明为该段禁用了所有标尺。

d. 依次高亮度显示每个其余波段，重复步骤 c。

3. 按 Return。

4. 命名和存储波形序列(第 93 页第 3 步)。

下图说明了重用相同的出厂时提供的波形段构建的序列；出厂时提供的波形段在所有四个标尺的第

一个标尺上有一个标尺点。在本例中，对第一个段启动了标尺 1，对第二个段启动了标尺 2，对第三个段

启动了标尺 3 和标尺 4。

对每个段，只有为该段启动的标尺生成后面板辅助输出信号。在本例中，只对第一个段才出现标尺

1辅助信号，因为对其余段禁用这个信号。只对第二个段才出现标尺2辅助信号，只对第三个段才出现标

尺 3 和标尺 4 辅助信号。

序列标尺栏

这一项目表明对这个段启动了标

尺 3和标尺 4
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在现有的波形序列中

如果还没有这样做，应创建和存储至少包含三个段的波形序列(第 93页)。保证这个段或这些段已经

在易失性内存中提供(第 96 页)。

1. 按Mode > Dual ARB > Waveform Sequences，高亮度显示希望的波形段。

2. 按Edit Selected Waveform Sequence，高亮度显示第一个波形段。

3. 按Enable/Disable Markers > Toggle Marker 1, Toggle Marker 2, Toggle Marker 3 和 Toggle Marker 4。

拨动没有任何标尺点的标尺(第 105 页)对辅助输出没有任何影响。

Mkr一栏中有项目(参阅下图)表明为该段启动了标尺；这一栏中没有项目表明为该段禁用了所有标尺。

4. 高亮度显示下一个波形段，拨动希望的标尺(在本例中是标尺 1 和标尺 4)。

5. 根据需要重复第 4 步 (在本例中，选择第三个段，拨动标尺 3)。

6. 按Return > Name And Store > Enter。

根据选择启动或禁用标尺，变化已经保存到选择的序列文件中。

序列标尺栏

这一项目表明对这个

段只启动了标尺 3
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查看标尺脉冲

在播放波形(第94页)时，可以在与该标尺编号对应的后面板事件连接器上检测到一个集合及启动的

标尺的脉冲。下面的实例演示了怎样查看至少有一个标尺点集合的波形段生成的标尺脉冲(第105页)。波

形序列使用的流程与此相同。

下面的实例在双ARB播放器中使用出厂时提供的波形段SINE_TEST_WFM。出厂时提供的波形段对

所有四个标尺在第一个样点上有一个标尺点，如下图所示。

1. 按Mode > Dual ARB > Select Waveform，高亮度显示希望的波形段(在本例中是 SINE_TEST_WFM)。

2. 按ARB Off On，直到 On。

3. 把示波器输入连接到EVENT 1连接器上，在事件 1信号上触发采集。在存在标尺时，示波器会显示

标尺脉冲，如下面的实例所示。

波形段第一个样点

上的标尺点

第 103 页介绍了怎样查看标尺

RF 输出

事件 1信号上的标尺脉冲
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使用 RF 消隐标尺功能

尽管可以在设置标尺点之前或之后设置标尺功能(在软键标签上描述为 Marker Routing) (第 105 页)，

但在设置标尺点前设置标尺功能可能会改变RF输出。RF消隐功能包括ALC保持(参阅第 99页介绍，注

意与没有置平的功率有关的小心事项)。在标尺信号变低时，信号源会隐去 RF 输出。

1. 使用出厂时提供的波形段 SINE_TEST_WFM，在第 1 个点到第 180 个点上设置标尺 1 (第 105 页)。

2. 从Marker Utilities 菜单中(第 102 页)，把 RF 消隐功能分配给标尺 1：

按Marker Routing > Pulse/RF Blank > Marker 1。
标尺极性 = 正

在标尺极性为正时(默认设置)，在

标尺点关闭过程中隐去RF 输出

RF 信号

第 1 个点
标尺

段

极性 = 负

在标尺极性为负时，在标尺

点打开过程中隐去RF 输出

RF 信号

≈ 3.3V

0V

≈ 3.3V

0V

180 200

第 1个点
标尺

段
180 200
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设置标尺极性

设置负标尺极性会反转标尺信号。

1. 在Marker Utilities 菜单中(第 102 页)，按Marker Polarity。

2. 根据需要为每个标尺编号选择标尺极性。

如第 111 页所示。

正极性: On 标尺点为高 (≈ 3.3V)。

负极性: On 标尺点为低 (0V)。

默认标尺极性 = 极性

独立设置每个标尺极性

另请参阅第 98页“保存标尺极性和路由设置”
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触发波形

ARB格式和实时格式都提供了触发功能。ARB触发控制波形文件播放；实时定制触发控制数据码型

传输。本节中的实例和讨论采用双ARB播放器，但功能和接入方法(参见第115页介绍)在所有格式(ARB

和实时)下类似。

通过告诉PSG什么时候传输调制信号，触发器控制着数据传输。根据触发设置，数据传输可以发生

一次，可以连续发生，或 PSG 可以重复开始和停止传输(选通模式)。

触发信号由正负信号转换(状态)组成，也称为高低周期；可以把 PSG配置成在任一状态上触发。通

常会有多个触发器（也称为触发发生或触发事件），在信号源只要求一个触发时会发生触发。在这种情况

下，PSG 识别第一个触发事件，而忽略其余事件。

在选择触发模式时，您可能会从RF输出中丢失信号(载波加调制)，直到调制信号被触发。这是因为

在第一个触发事件前 PSG把 I信号和Q信号设成零伏，这会抑制载波。如果创建一个数据码型，其初始

I电压和Q电压设置成零以外的值，则不会发生这种情况。在第一个触发事件后，信号的最终 I和Q电平

决定着能否看到载波信号(零=没有载波，其它值=可以看见载波)。在大多数数据码型末尾，最后 I和Q

点被设成零以外的值。

配置波形触发器分成四个部分：

Source (触发源)决定着 PSG 怎样接收启动波形播放的触发器。

Mode (模式)决定着在播放时波形的整体行为。

Response (响应)决定着波形怎样对触发作出响应的详细信息。

Polarity (极性)决定着波形响应的触发器的状态(只和外部触发源一起使用)；可以把极性设为正或负。

信号源

Trigger 硬键

通过后面板 GPIB、LAN 或辅助(RS-232)接口发送命令

外部触发信号应用到 PATTERN TRIG IN 连接器或 AUXILIARY I/O 连接器上 PATT TRIG IN 2 针脚上

(连接器位置如第 22 页图 1-3 所示)。

下面的参数影响着外部触发信号：

外部触发信号的来源(Input 连接器) (参阅第 115 页)

外部触发器的极性(参阅第 115页)

在 PSG 收到外部触发和波形对其响应之间的任何希望的延迟(参阅第 115页)
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模式和响应

任意波形播放器提供了四种触发模式；每种模式都有一个或多个可能的响应：

Single 播放波形一次。Arb formats 拥有下述二次触发选项：

－ Off 忽略播放过程中收到的触发；在播放后收到的触发会重新开始播放。

－ On 导致播放过程中收到的触发在当前播放结束后重复波形。

－ Immediate 导致在播放过程中收到的触发立即重新开始波形。

Gated 导致波形等待第一个活动的触发信号状态开始传输，然后重复启动和停止，以对外部应用的选

通信号作出响应(第 116 页实例)。使用Gate Active Low High 软键选择活动的状态(参阅第 115 页)。

在 ARB 格式下，波形在 inactive 状态期间播放，在 active 状态期间停止。

在实时 Custom 模式下，行为取决于信号是包含成帧数据还是未成帧数据。

由于PSG只提供未成帧数据，为传输成帧数据信号，必须创建一个包含成帧的外部文件，然后把它下

载到 PSG 上 (参阅编程指南)。

－Unframed data 在活动状态期间传输，在不活动状态期间停止。信号会在最后传输的码上停止，在

下一个码上重新开始。

－Framed data在活动状态期间在帧开始时开始传输，在未活动状态期间出现末尾时在帧末尾停止。如

果帧末尾延伸到下一个活动状态中，信号会连续传输。

Segment Advance (仅双ARB)导致序列中的段要求播放触发器。trigger source控制着怎样在段之间移

动播放(第 118页实例)。在最后一段循环过程中收到的触发播放到序列中的第一个序列。在怎样播放

波段段方面有两个选择：

－Single导致序列中的波形段播放一次，然后停止，等待触发，然后推进到下一段，直到播放结束。

播放过程中收到的触发会导致当前段完成，然后向前播放下一段，直到播放结束。

－Continuous 导致序列中的波形段连续播放，直到波形收到另一个触发。在播放过程中收到的触发

导致波形段完成，然后向前播放下一段，下一段会连续播放。

Continuous重复波形，直到关闭信号或选择另一个波形、触发模式或响应。Continuous具有下述选项：

－Free Run 立即触发和播放波形；在播放过程中收到的触发被忽略。

－Trigger & Run 在收到触发时播放波形；后续触发被忽略。

－Reset & Run (在实时 Custom 模式下没有提供)在收到信号时播放波形；后续触发重新开始波形。
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使用触发辅助工具

下图显示了触发参数的菜单，这些图显示了双ARB播放器，但可以在所有ARB格式下通过Trigger

软键、在实时 I/Q 基带(定制)格式下通过 Pattern Trigger 软键使用触发辅助工具。

为显示触发模式，按Mode > Dual ARB > Trigger。

为显示给定触发模式使用的耦合选择，按 Trigger Setup，然后选择希望的触发模式。为查看 ARB 格

式中 Single模式的选择，选择Retrigger Mode; 在实时Custom格式下，选择 Single模式会导致触发播

放数据码型一次。

为显示触发源选项，按 Trigger Setup > Trigger Source。

设置外部触发器的极性

选通模式

选通活动参数提供的选择取决于外部触发信号的高低状态。例如，在选择High时，在触发信号高过

程中发生活动状态。

ARB 格式 在发生活动状态时，PSG在播放的最后样点上停止波形文件播放，在发

生未活动状态时在下一个样点重新开始播放。

Real-Time Custom 在发生活动状态时，PSG传输数据码型。在未活动状态发生时，传输在

最后传输的码上停止，在发生活动状态时在下一个码上重新开始。

连续模式, 单次模式或 Segment Advance 模式

Ext Polarity Neg Pos 软键选择取决于外部触发器的低(负)和高(正)状态。在选择 Neg 时(默认状态)，

PSG 会在触发信号的低状态期间响应。

PATTERN TRIG IN连接器

只在选择 Ext 时激活

AUXILARY I/O 连接器上的

PAT TRIG IN 2 针脚
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使用选通触发

选通触发可以定义调制波形的开(播放)状态和关状态。下面的实例采用出厂时提供的波形段

SINE_TEST_WFM。

1. 把函数发生器的输出连接到信号源的后面板 PATTERN TRIG IN 上，如下图所示。

这一连接适用于所有外部触发方法。可选的示波器连接可以查看触发信号对 RF 输出的影响。

2. 预置信号源。

3. 配置载波信号输出：

设置希望的频率。

设置希望的幅度。

打开 RF 输出。

4. 选择一个波形进行播放(序列或段)：

a. 预置信号源。

b. 按Mode > Dual ARB > Select Waveform。

c. 高亮度显示一个波形文件(在本例中是 SINE_TEST_WFM)。

d. 按Select Waveform。

5. 选择波形触发方法：

a. 按 Trigger > Gated。

b. 按 Trigger > Trigger Setup，注意对Gate Active Low High 软键，默认选择是 High，本例中使

用这一选择。

函数发生器

信号源 示波器

通道 1 通道 2
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6. 选择触发源和后面板输入：

a. 对 Trigger Source 软键，默认选择是 Ext，本例中使用这一选择(选通触发要求外部触发器)。

b. 按 Trigger Source，注意对Ext Source 软键，默认选择是 Patt Trig In 1，本例中使用这一选择。

7. 生成波形：

按ARB Off On，直到 On。

8. 在函数发生器上，为外部选通触发器配置一个 TTL 信号。

9. (可选) 监视当前波形：

把示波器配置成显示信号源的输出和外部触发信号。您将看到在选通 inactive 期间(低)调制输出

的波形。

下图显示了显示画面实例。

注 在实时 Custom 模式下，行为相反：在选通信号为 high 时，会看到被调制的波形。

调制波形 RF 输出

外部应用的选通信号

选通活动 = 高
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使用 Segment Advance 触发

Segment advance 触发可以控制波形序列内部的波形段播放。下面的实例采用有两个段的波形序列。

如果您还没有创建和存储波形序列，应先完成第92页“创建波形段”和第93页“构建和存储波形序列”

中说明的步骤。

1. 预置信号源。

2. 配置 RF 输出：

设置希望的频率。

设置希望的幅度。

打开 RF 输出。

3. 选择一个波形序列进行播放：

a. 预置信号源。

b. 按Mode > Dual ARB > Select Waveform。

c. 高亮度显示一个波形文件。

d. 按Select Waveform。

4. 选择波形触发方法和触发源：

a. 按 Trigger > Segment Advance。

b. 按 Trigger > Trigger Setup，注意 Seg Advance Mode 软键显示默认选择(Continuous)，

本例中使用这一选择。

c. 按 Trigger Source > Trigger Key。

5. 生成波形序列：

按Return > Return > ARB Off On，直到 On。

6. 触发第一个波形段，开始重复播放：

按 Trigger 硬键。

7. (可选) 监视当前波形：

把信号源的输出连接到示波器的输入上，配置示波器，以便能够看到信号源的输出。

8. 触发第二个波形段：

按 Trigger 硬键。

序列中的第二个段现在播放。按Trigger硬键导致当前播放完成，下一个段开始播放；在最后一段播

放时，按 Trigger 硬键导致在当前段完成时波形序列中的第一个段开始播放。
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使用波形削波

具有高功率峰值的波形可能会导致互调失真，这会产生频谱再生(干扰相邻频段中的信号的情况)。削

波功能使您能够把 I和Q数据削到最高峰值的选定百分比，降低高功率峰值。削波功能只能用于双ARB

模式。

功率峰值怎样发展

为理解削波怎样降低高功率峰值，重要的一点是知道在信号构建时峰值怎样发展。I/Q波形可以是多

条通道的总和(参阅图3-10)。在大多数或所有通道波形同时包含相同状态(高或低)的位时，在加总的波形

中通常会出现高功率峰值(负或正)。这不会频繁发生，因为这些通道波形上位的高低状态是随机的，其会

导致抵消效应。

图 3-10 多条通道加总

加总的 I 或 Q 波形

多条通道加总到一个 I 或 Q 波形中
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I和Q波形综合在 I/Q调制器中，创建一个RF波形。RF包络的幅度由公式                   确定，其中 I和

Q 的平方一直为正值。

如图 3-11 所示，I 和 Q 波形中同时出现的正负峰值不会互相抵消，而会结合在一起，构成一个更大

的峰值。

图 3-11 I 和 Q 波形结合在一起

I2 + Q2√
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峰值怎样导致频谱再生

由于高功率峰值的相对频次较低，波形的峰值均值功率比会很高(参阅图3-12)。由于发射机的功放器

增益设成提供特定的平均功率，因此高峰值可能会导致功放器转向饱和。这会导致互调失真，进而产生

频谱再生。

图 3-12 峰值均值功率比

频谱再生是一个频率范围，它在载波的每一侧发展(类似于边带)，扩展到相邻频段中(参阅图 3-13)。

结果，频谱再生会干扰相邻频段中的通信。削波可以解决这个问题。

图 3-13 干扰相邻频段的频谱再生

峰值功率

平均功率

频谱再生

RF 信号 相邻频段
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削波怎样降低峰值均值功率比

通过把波形削到峰值功率选定百分比，可以降低峰值均值功率比，进而降低频谱再生。PSG矢量信

号源提供了两种不同的削波方法：圆形削波和矩形削波。

在圆形削波过程中，削波应用到 I 和 Q 综合波形上(|I + jQ|)。注意在图 3-14 中，削波电平对矢量表

示的所有相位是恒定的，表现为一个圆。在矩形削波过程中，削波独立应用到 I波形和Q波形上(|I|, |Q|)。

注意在第 123页图 3-15中，削波电平对 I和 Q 是不同的，因此，它在矢量表示中表现为一个矩形。不管

是哪种方法，其目标都是把波形削到可以有效地降低频谱再生的水平，但又不会降低信号的完整性。第

124页上的图3-16使用两个互补累积分布图，表明在对波形应用圆形削波后发生的峰值均值功率比下降。

削波值设得越低，传送的峰值功率越低(或削掉的信号越多)。通常情况下，可以成功地削掉峰值，而

不会明显影响波形的其余部分。由于编码系统本身的纠错能力，可以抢救削波过程中可能会丢失的数据。

但是，如果波形削得太多，丢失的数据是不能恢复的。您可能必须尝试多个削波设置，以找到工作状况

良好的百分比。

图 3-14 圆形削波

没有削波的峰值功率

(削波设为 100%)

削波设为 80%

削掉的基带波形

削掉的峰值的矢量表示

4.53V

4.53V

Q

I
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图 3-15 矩形削波

a) 削波设为 100% (没有削波)

b) 削波设为最大峰值的 75%

c) 削波设为 100% (没有削波)

d) 削波设为最大峰值的 50%

削掉的 I 波形

削掉的 Q 波形

削掉的峰值的矢量表示

I

3V b
a

a

b

Ｑ

3V

2V

c
d

Ｑ

2V d

c
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图 3-16 峰值均值功率比

互补累积分布

生

产

力

CCDF, 削波 =100%(没有削波)

CCDF, 削波 = 80%

降低峰值

均值功率比

生

产

力
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配置圆形削波

这一程序说明了怎样配置圆形削波。圆形设置削掉合成的 I/Q数据(I和Q数据同等削波)。如需与圆

形削波有关的更多信息，请参阅第 122 页“削波怎样降低峰值均值功率比”。

1. 按Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On，直到On，生成这

一程序中使用的定制任意波形。还可以使用以前存储或下载的波形。

2. 按Mode > Dual ARB > Select Waveform，确保显示屏上高亮度显示 AUTOGEN_WAVEFORM。

AUTOGEN_WAVEFORM 是为上一步中生成的波形分配的默认名称。

3. 按Select Waveform，选择波形，返回以前的软键菜单。

4. 按ARB Off On，直到 On。双 Arb 播放器必须打开，以便在下面的各步中显示 CCDF 图。

5. 按ARB Setup > Waveform Utilities > Waveform Statistics，保证显示屏上高亮度显示

AUTOGEN_WAVEFORM。

6. 按CCDF Plot，观察波形曲线的位置，也就是最黑的线。

7. 按Return > Return > Clipping。

8. 确保Clipping Type |I+jQ| |I|,|Q| 软键设成 |I+jQ|，即圆形削波。

9. 按Clip |I+jQ| To > 80 > % > Apply to Waveform。I数据和Q数据都削掉 80%。一旦波形应用削波，这

一操作不能撤销。重复使用削波功能对波形具有累积效应。

10. 按Waveform Statistics > CCDF Plot，观察波形的曲线。注意在应用削波后峰值均值功率比相对于以

前的图下降了。
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配置矩形削波

这一程序说明了怎样配置矩形削波。矩形设置独立削波 I 数据和 Q 数据。如需与矩形削波有关的更

多信息，请参阅第 122 页“削波怎样降低峰值均值功率比”。

1. 按Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On，直到On，生成这

一程序中使用的定制任意波形。还可以使用以前存储或下载的波形。

2. 按Mode > Dual ARB > Select Waveform，确保显示屏上高亮度显示 AUTOGEN_WAVEFORM。

AUTOGEN_WAVEFORM 是为上一步中生成的波形分配的默认名称。

3. 按Select Waveform，选择波形，返回以前的软键菜单。

4. 按ARB Off On，直到 On。双 Arb 播放器必须打开，以在下面的步骤中显示 CCDF 图。

5. 按ARB Setup > Waveform Utilities > Waveform Statistics，确保显示屏上高亮度显示

AUTOGEN_WAVEFORM。

6. 按CCDF Plot，观察波形曲线的位置，即最黑的线。

7. 按Return > Return > Clipping。

8. 确保Clipping Type |I+jQ| |I|,|Q| 软键设为 |I|,|Q|，激活Clip |I| To 和Clip |Q| To 软键，可以配置矩形(独

立) I 和 Q 数据削波。

9. 按Clip |I| To > 80 > %。

10. 按Clip |Q| To > 40 > % > Apply to Waveform。I 数据和 Q 数据分别削掉 80% 和 40%。一旦波形应

用了削波，不能撤销操作。重复使用削波功能对波形具有累积效应。

11. 按Waveform Statistics > CCDF Plot，观察波形的曲线。注意在应用削波后峰值均值功率比相对

于以前的图下降了。
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使用波形定标

波形定标用来消除DAC超出额定范围错误。PSG提供了两种波形定标方法。可以执行运行时定标，

实时调节当前播放的波形的标度；也可以对装在易失性内存中没有播放的波形文件永久定标。本节介绍

了 DAC 超出额定范围错误是怎样发生的，及可以怎样使用波形定标有效消除这些错误。

定标功能只能用于双 ARB 模式。

DAC 超出额定范围错误是怎样发生的

PSG采用内插滤波器，把数字 I 和 Q 基带波形转换成模拟波形。内插器的时钟速率是基带时钟的四

倍。因此，内插器计算进入基带样点之间的样点，使其等于较快的时钟速率，平滑波形，提供更类似于

曲线的外观(参阅图 3-17)。

图 3-17 波形内插

DAC中的内插滤波器具有过冲。如果基带波形具有快速上升沿，内插器滤波器的过冲或频响成为内

插的基带波形的成分。这种响应会在上升沿峰值上导致脉动或振铃效应。如果这个脉动超过(或过冲)DAC

范围的上限，内插器会计算错误的样点，不能复制真正形式的脉动(参阅图3-18)。结果，PSG会报告DAC

超出额定范围错误。

内插样点

基带样点
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图 3-18 波形过冲

定标怎样消除 DAC 超出额定范围错误

定标降低或缩减基带波形的幅度，同时保持其基本形状和特点，如峰值均值功率比。如果快速上升

的基带波形定标程度足够高，可以为过冲提供充足的余量，那么内插器滤波器可以计算包括脉动效应的

样点，从而消除超出额定范围错误(参阅图 3-19)。

图 3-19 波形定标

超过额定范围的样点
不能正确内插

D
A

C
范

围

基带样点

D
A

C
范

围

基带样点

DAC 范围内的样点
正确内插
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尽管定标保持了波形的基本形状，但定标太大会破坏其完整性，因为位分辨率可能会非常低，以致

量化噪声会破坏波形。通过只把波形定标到足以去掉DAC超出额定范围错误，可以实现最大精度和最优

动态范围。最优定标随着波形内容不同而变化。

定标目前正在播放的波形(运行时定标)

这一程序可以对目前正在播放的波形实时调节定标。这类定标不会影响波形文件，特别适合消除

DAC 超出额定范围错误。

1. 按Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On，直到On，生成这

一程序中使用的定制任意波形。也可以使用以前存储或下载的波形。

2. 按Mode > Dual ARB > Select Waveform，确保显示屏上高亮度显示 AUTOGEN_WAVEFORM。

AUTOGEN_WAVEFORM 是为上一步中生成的波形分配的默认名称。

3. 按Select Waveform，选择波形，返回以前的软键菜单。

4. 按ARB Off On，直到 On，播放选择的波形。

5. 按ARB Setup > More (1 of 2) > Waveform Runtime Scaling，调节前面板旋钮或使用数字键，输入一

个新值。新的定标值立即应用到正在播放的波形中。运行时定标调节不是累积的，取值一直是相对于

波形文件原始幅度的值。

在易失性内存中定标波形文件

这一程序可以永久定标波形文件，然后可以把定标的波形段存储到非易失性内存中，以备未来使用。

定标是累积的、不可逆的。

1. 按Preset > Mode > Custom > Arb Waveform Generator > Digital Modulation Off On，直到On，生成这

一程序中使用的定制任意波形。也可以使用以前存储或下载的波形。

2. 按Mode > Dual ARB > Select Waveform，确保显示屏上高亮度显示 AUTOGEN_WAVEFORM。

AUTOGEN_WAVEFORM 是为上一步中生成的波形分配的默认名称。

3. 按Select Waveform，选择波形，返回以前的软键菜单。

4. 按ARB Setup > Waveform Utilities，确保显示屏上高亮度显示 AUTOGEN_WAVEFORM。

5. 按Scale Waveform Data > Scaling > 70 > % > Apply to Waveform，波形现在降到原始幅度的70%。一

旦对波形应用了这类定标，将不能撤销操作。重复定标应用对波形具有累积效应。
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在下面几节中，本章介绍了改善安捷伦 PSG 信号源的程序。

“使用 ALC”，第 132 页

“使用外部置平”，第 135 页

“创建和应用用户平坦度校正”，第 139 页

“调节参考频率振荡器带宽(选项 UNR)”，第 151 页

4   优化性能
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选择 ALC 带宽

对内部置平，信号源在 RF 输出前采用自动置平控制(ALC)电路。ALC 带宽有五个选项：自动, 100

Hz, 1 kHz, 10 kHz和 100 kHz。在自动模式下(预置选择)，信号源根据配置和设置自动选择ALC带宽(参

阅图 4-1)。

图 4-1 自动 ALC 带宽选择判定树

为选择 ALC 带宽

按Amplitude > ALC BW > 100 Hz, 1 kHz, 10 kHz 或 100 kHz。

使用特定选择替代信号源的自动ALC带宽选择。对幅度变化、高波峰因数或两者的波形，推荐的ALC

环路带宽是 100 Hz。限制 ALC 的环路带宽将防止ALC 对 802.11b、CDMA 和 OFDM 等制式中具有高峰

波因数的脉冲式波形的快速上升沿取样。有限带宽或窄带宽会加长ALC取样时间，更精确地表示信号的

RMS 值。

注 对任何 I/Q 调制信号，不要使用 10 kHz ALC带宽，因为ALC 积分时间太短。对 CW 连续波信

号，可以使用较高的 ALC 带宽。
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优化突发的 ARB 信号的电平精度

对突发的ARB信号，为获得最佳电平精度，要求使用标尺设置ALC Hold功能。使用标尺辅助工具，

把标尺路由设置成 ALC Hold。如需与标尺路由有关的更多信息，请参阅第 99 页“ALC 保持标尺功能”

一节。

ALC Hold 功能用来把ALC 值保持在突发关闭过程中最后测得的 RMS 幅度值。在突发打开过程中，

ALC激活，将测量和刷新设置ALC使用的RMS幅度电平。可以为每个波形段或波形序列，在波形标尺

文件中设定 RF Blank 和 ALC Hold 设置。

为实现最佳精度，在突发打开过程中ALC必须收敛到突发信号的RMS值，在突发关闭过程中ALC

必须处于保持模式。此外，必须以大约 10 ms 的定期间隔刷新 ALC。

通过在内部补偿RF电路，从而把输出功率保持在恒定电平，可以使用信号源的ALC把RF输出保持

在希望的电平。对周期波形，ALC 可以简便地调节 RF 功率电平，偏移由于温度、时间和负荷变化导致

的波形，但是，由于突发之间发生的关闭时间，突发 RF 带来了问题。通过把 RF 增益驱动到最大水平，

ALC将尝试和补偿突发关闭期间的低功率。在突发信号发生时，已经设置了信号源输出功率，实现最大

增益，内部 RF 电路将饱和，导致输出失真。

ALC 反馈环路

ALC反馈环路在突发关闭期间必须打开，以防止时域中信号过冲和 /或倾斜。打开的ALC环路将防

止ALC试着校正从高RF电平到低功率电平或无功率电平的突然变化。例如，如果对连续的突发脉冲应

用 ALC，ALC 将对突发脉冲开关占空比中的功率电平求积分，这可能会导致 ALC 读数错误，其要低于

打开期间突发信号的RMS值。为保证突发信号实现最佳的电平精度，应在关闭期间使用ALC保持或RF/

消隐功能。可以使用 Marker Utilities 菜单中的Marker Routing 软键，设置 ALC Hold 和 RF Blank 功能。

RF 消隐功能将改善信号的动态范围或开关比，因为消除了信号源的 LO (局部频率振荡器)馈通。详情请

参阅第 97 页“使用波形标尺”。

下图显示了标尺和突发ARB 信号之间的定时关系。该图显示了路由到ACL Hold的标尺 1和路由到

RF Blank的标尺 2。ALC Hold功能的标尺路由具有延迟，必须通过偏置标尺定时，来补偿延迟。详情请

参阅第 99 页“ALC 保持标尺功能”。
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注 在设置标尺点时，不要把标尺放在脉冲的上升沿或下降沿上。



135第 4 章

优化性能

使用外部置平

使用外部置平

通过在希望置平 RF 输出功率的点上连接外部传感器，可以从外部置平 PSG 信号源。这个传感器检

测RF输出功率变化，把补偿电压返回信号源的ALC输入。ALC电路根据从外部传感器收到的电压提高

或降低(置平)RF 输出功率，保证在检测点上获得恒定的功率。

PSG提供了两种外部置平，可以使用带有检测器和耦合器/功率分路器设置的外部置平，也可以使用

带有毫米波光源模块的外部置平。

使用检测器和耦合器/分路器进行置平

图 4-2是典型的外部置平设置图。到ALC电路的功率电平反馈来自外部负检测器，而不是内部信号

源检测器。这个反馈电压控制着 ALC 系统，在检测点上置平 RF 输出功率。

为使用检测器和耦合器 /分路器在 10 GHz的 RF 输出频率和 0 dBm的幅度上进行外部置平，请使用

本节中的说明。

要求的设备

Agilent 8474E 基本检测器

Agilent 87301D 定向耦合器

所需的电缆和适配器

连接设备

图 4-2 是设备设置图。

图 4-2 使用定向耦合器进行外部检测器置平

信号源

负检测器

ALC 输入

RF 输出 置平输出

定向耦合器
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配置信号源

1. 按Preset。

2. 按 Frequency > 10 > GHz。

3. 按Amplitude > 0 > dBm。

4. 按RF On/Off。

5. 按 Leveling Mode > Ext Detector。

使内部ALC检测器无效，把ALC输入路径切换到前面板ALC INPUT连接器上。显示屏AMPLITUDE

区域中激活 EXT 指示灯。

注 对配备选项 1E1 的信号源，注意显示 ATTN HOLD (衰减器保持)报警灯。在外部置平过程

中，信号源对所有外部置平点自动从 ALC 系统中解耦衰减器。在这种模式下，RF 输出幅

度调节限于 -20到 +25 dBm的 ALC电路调节范围内。详情请参阅第 138页“使用选项 1E1信号

发生器进行外部置平”。

6. 观察检测器端口上定向耦合器打印的耦合系数。一般来说，这一值为 -10 到 -20 dB。

在信号源中输入这一耦合系数的正 dB 值。

7. 按More (1 of 2) > Ext Detector Coupling Factor > 16 (或定向耦合器检测器端口上列出的值的正数表示

结果) > dB。现在定向耦合器输出上提供了置平的输出功率。

注 在外部置平模式下，信号源显示的 RF 输出幅度受到耦合系数值的影响，可以计算出实际

RF 输出幅度的近似值。为确定检测点上的实际 RF 输出幅度，测量外部检测器输出上的电压，

并参阅图 4-3，或使用功率计直接测量功率。
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确定置平的输出功率

图4-3说明了典型安捷伦二极管检测器的输入功率与输出电压特点。通过使用这张图，可以测量外部

检测器输出电压，确定置平的功率。然后增加耦合系数，确定置平的输出功率。功率调节范围约为 -20到

+25 dBm。

图 4-3 在 25°C 时典型的二极管检测器响应
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使用选项 1E1 信号源进行外部置平

配备选项 1E1的信号源在RF输出连接器前面包含一个步进衰减器。在外部置平过程中，在RF幅度

变化时，信号源自动保持当前衰减器设置(以避免在衰减器切换过程中可能发生的功率瞬变)。必须在衰减

量和最优ALC电平之间保持平衡，以实现要求的RF输出幅度。为实现最优的精度和最小噪声，ALC电

平应大于 -10 dBm。

例如，把 30 dB增益放大器的CW连续波输出置到 -10 dBm电平上，要求在置平时信号源输出约为 -

40 dBm。这要超过单纯 ALC 调制器的幅度极限，导致没有置平的 RF 输出。插入 45 dB 的衰减导致 +5

dBm 的 ALC 电平，很好地落在 ALC 调制器范围内。

注 在上面的实例中，55 dB是首选的衰减选择，导致 +15 dBm 的ALC电平。这为改变 RF输出幅

度的 AM 或其它功能提供了足够的动态范围。

为了使未调制载波在 -40 dBm 信号源 RF 输出上实现最优的 ALC 电平，应遵循下述步骤：

1. 按Amplitude > Set Atten > 45 > dB。

2. 按Set ALC Level > 5 > dBm。

把衰减器设成 45 dB，把 ALC 电平设成 +5 dBm，导致 -40 dBm 的 RF 输出幅度，如显示屏中 AM-

PLITUDE 区域所示。

为获得平坦度校正后的功率，请参阅第 139 页 " 创建和应用用户平坦度校正 "。

使用毫米波光源模块进行置平

毫米波信号源模块置平与外部检测器置平类似。到ALC电路的功率电平反馈信号源自毫米波信号源

模块，而不是内置信号源检测器。这一反馈信号通过信号源的后面板 SOURCE MODULE 接口连接器置

平毫米波信号源模块输出上的 RF 输出功率。如需说明和设置，请参阅第 237 页第 11 章“外围设备”。
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创建和应用用户平坦度校正

用户平坦度校正允许在任意频率或扫描模式下，数字调节多达 1601个频率点的RF输出幅度。通过

使用Agilent E4416A/17A或 E4418B/19B功率计(通过GPIB由信号源控制)校准测量系统，可以为发生功

率电平变化或损耗的频率创建功率电平校正表。可以使用顺序线性步进或任意间隔定义这些频率。

为对不同测试设置或不同频率范围实现不同的校正阵列，可以把各个用户平坦度校正表保存到信号

源的内存目录中，然后按需调用这些表格。

使用下面几节中的步骤，对信号源 RF 输出创建和应用用户平坦度校正。

之后，使用第 143 页“调用和应用用户平坦度校正阵列”中的步骤，从内存目录中调用用户平坦度

文件，然后把它应用到信号源的 RF 输出上。

创建用户平坦度校正阵列

本例中创建一个用户平坦度校正阵列。平坦度校正阵列包含 10 个频率校正对(指定频率的幅度校正

值)，范围为 1 - 10 GHz，间隔为 1 GHz。

Agilent E4416A/17A/18B/19B 功率计(通过 GPIB 由信号源控制)和 E4413A 功率传感器用来测量指定

校正频率上的RF输出幅度，把结果传送到信号源。信号源从功率计读取功率电平数据，计算校正值，把

校正对存储在用户平坦度校正阵列中。

如果您没有要求的安捷伦功率计，或如果功率计没有 GPIB 接口，可以手动输入校正值。

要求的设备

Agilent E4416A/17A/18B/19B 功率计

Agilent E4413A E 系列 CW 连续波功率传感器

GPIB 接口电缆

要求的适配器和电缆

注 如果设置中具有外部置平配置，图 4-4 中的设备设置假设已经遵守正确置平 RF 输出所需的步

骤。如果对外部置平有什么问题，请参阅第 135 页“使用外部置平”。
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配置功率计

1. 选择 SCPI 作为功率计的远程语言。

2. 清零和校准功率计的功率传感器。

3. 把相应的功率传感器校准系数相应地输入到功率计中。

4. 启动功率计的校准系数阵列。

注 如需特定功率计 / 传感器的操作信息，请参阅操作指南。

连接设备

设备连接如图 4-4 所示。

注 在创建用户平坦度校正阵列过程中，功率计通过 GPIB 伺服信号源。GPIB 接口上不允许任

何其它控制器。

图 4-4 用户平坦度校正设备设置

信号源
信号源模块

ALC 输入

 输入端口

电缆和其

它器件

校正平坦
度的输出
端口 功率传感器

功率计

被测器件

RF 输出

OUT IN

GPIB
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配置信号源

1. 按Preset。

2. 配置信号源，连接功率计。

a. 按Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, E4417A, E4418B,

或E4419B。

b. 按Meter Address >输入功率计的 GPIB 地址> Enter。

c. 对 E4417A 和 E4419B 型号，按 Meter Channel A B，选择功率计的活动通道。

d. 按Meter Timeout，调节如果与功率计通信尝试失败，仪器生成超时错误前的时间长度。

3. 按More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset 。打开用户平坦度

表格编辑器，预置校准阵列频率 / 校正列表。

4. 按Configure Step Array。打开一个菜单，输入用户平坦度步进阵列数据。

5. 按 Freq Start > 1 > GHz。

6. 按 Freq Stop > 10 > GHz。

7. 按 # of Points > 10 > Enter。

第 4 步、第 5 步和第 6 步在步进阵列中输入希望的平坦度校正频率。

8. 按Return > Load Cal Array From Step Array > Confirm Load From Step Data。使用步进阵列中定义的

频率设置填充用户平坦度校正阵列。

9. 按Amplitude > 0 > dBm。

10. 按RF On/Off。

激活 RF 输出，信号源上显示 RF ON 报警器。
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进行用户平坦度校正

注 如果没有使用 Agilent E4416A/17A/18B/19B 功率计，或如果功率计没有 GPIB 接口，可以手动

进行用户平坦度校正。如需说明，请参阅第 142 页“手动进行用户平坦度校正”。

1. 按More (1 of 2) > User Flatness > Do Cal。

创建用户平坦度幅度校正值表项。信号源进入用户平坦度校正程序，显示屏上显示进度条。

2. 按Done。

把幅度校正值加载到用户平坦度校正阵列中。

如果需要，按Configure Cal Array。

打开用户平坦度校正阵列，可以查看存储的幅度校正值。用户平坦度校正阵列标题显示User Flatness:

(UNSTORED)，表示当前用户平坦度校正阵列数据还没有保存到内存目录中。

手动执行用户平坦度校正

如果没有使用Agilent E4416A/17A/18B/19B功率计，或如果功率计没有GPIB接口，完成本节中的步

骤，然后继续用户平坦度校正教程。

1. 按More (1 of 2) > User Flatness > Configure Cal Array。

打开用户平坦度表格编辑器，把光标放在第一行的频率值(1 GHz)上。RF输出变成包含光标的表格行

的频率值，显示屏的 AMPLITUDE 区域显示 1.000 000 000 00。

2. 观察和记录从功率计中测得的值。

3. 从 0 dBm 中减去测得的值。

4. 把表格光标移到第一行中的校正值上。

5. 按Edit Item >输入第 3 步中的差值> dB。

信号源根据输入的校正值调节 RF 输出幅度。

6. 重复第 2 步到第 5 步，直到功率计读数为 0 dBm。

7. 使用下箭头键，把光标放在下一行的频率值上。RF输出变成包含光标的表格行的频率值，如显示屏

AMPLITUDE 区域所示。

8. 对用户平坦度表格中的每一项，重复第 2 步到第 7 步。
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把用户平坦度校正数据保存到内存目录中

这一过程允许把用户平坦度校正数据保存在信号源的内存目录中。在把多个用户平坦度校正文件保

存到内存目录中时，可以调用任何文件，把任何文件加载到校正阵列中，并应用到RF输出上，满足特定

的 RF 输出平坦度要求。

1. 按 Load/Store。

2. 按Store to File。

3. 使用输入字符和数字软键、数字键盘或旋钮，输入文件名 FLATCAL1。

4. 按Enter。

用户平坦度校正阵列文件 FLATCAL1 现在作为 UFLT 文件存储在内存目录中。

应用用户平坦度校正阵列

按Return > Return > Flatness Off On。

把平坦度校正阵列应用到RF输出上。信号源显示屏AMPLITUDE区域中的UF指示灯激活，校正阵

列中包含的频率校正数据应用到 RF 输出幅度上。

调用和应用用户平坦度校正阵列

在执行本节中的步骤以前，应先完成第 139 页“创建用户平坦度校正阵列”。

1. 按Preset。

2. 按Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) > Preset List >

Confirm Preset。

3. 按More (2 of 2) > Load/Store。

4. 保证高亮度显示文件 FLATCAL1。

5. 按 Load From Selected File > Confirm Load From File。

使用文件 FLATCAL1 中包含的数据填充用户平坦度校正阵列。用户平坦度校正阵列标题显示 User

Flatness: FLATCAL1。

6. 按Return > Flatness Off On。

应用 FLATCAL1 中包含的用户平坦度校正数据。



144 第 4章

优化性能

创建和应用用户平坦度校正

把信号源返回 GPIB 接听方模式

在用户平坦度校正过程中，功率计通过GPIB伺服信号源，GPIB接口上不允许任何其它控制器。信

号源以GPIB发话方模式操作，作为功率计的设备控制器。在这种工作模式下，它不能通过GPIB接收SCPI

命令。

如果信号源在进行用户平坦度校正后连接到远程控制器上，其GPIB控制器模式必须从GPIB发话方

模式变成 GPIB 接听方模式。

如果以前已经配置了 RF 载波，在把信号源返回 GPIB 接听方模式前，必须保存当前仪器状态。

1. 把仪器状态保存到仪器状态寄存器上。

如需说明，请参阅第 61 页“保存仪器状态”。

2. 按GPIB Listener Mode。

预置信号源，返回GPIB接听方模式。信号源现在可以接收连接到GPIB接口的远程控制器执行的远

程命令。

3. 从仪器状态寄存器中调用仪器状态。

说明请参阅第 61 页“保存仪器状态”。

使用毫米波信号源模块创建用户平坦度校正阵列

本例中创建用户平坦度校正阵列，在 E8257D 信号源驱动的 Agilent 83554A 毫米波信号源模块输出

上提供校正了平坦度的功率。

平坦度校正阵列包含 28 个频率校正对(指定频率的幅度校正值)，范围为 26.5 - 40 GHz，间隔为 500

MHz。这会在 83554A 毫米波信号源模块的输出上得到 28 个平均间隔、范围在 26.5 GHz 和 40 GHz之间

校正了平坦度的频率。

Agilent E4416A/17A/18B/19B 功率计(通过 GPIB 由信号源控制)和 R8486A 功率传感器用来测量指定

校正频率上的毫米波信号源模块的RF输出幅度，并把结果传送到信号源上。信号源从功率计读取功率电

平数据，计算校正值，把校正对存储在用户平坦度校正阵列中。

如果没有要求的安捷伦功率计，或如果功率计没有 GPIB 接口，可以手动输入校正值。
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要求的设备

 Agilent 83554A 毫米波信号源模块

Agilent E4416A/17A/18B/19B 功率计

Agilent R8486A 功率传感器

Agilent 8349B 微波放大器(没有配备选项 1EA 的信号源要求使用)

GPIB 接口电缆

要求的适配器和电缆

注 图4-5和图4-6中的设备设置假设已经遵守正确置平RF输出所需的步骤。如果对使用毫米波信

号源模块置平有什么问题，请参阅第 138 页“使用毫米波信号源模块置平”。

配置功率计

1. 选择 SCPI 作为功率计的远程语言。

2. 清零和校准功率计的功率传感器。

3. 把相应的功率传感器校准系数相应地输入到功率计中。

4. 启动功率计的校准系数阵列。

注 如需特定功率计 / 传感器的操作信息，请参阅操作指南。
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连接设备

小心 为防止损坏信号源，在把信号源模块接口电缆连接到后面板 SOURCE MODULE 接口连接

器之前关闭信号源的线路电源。

1. 关闭信号源的线路电源。

2. 连接设备。对标准信号源，使用图 4-5 中的设置。对配备选项 1EA 的信号源，使用图 4-6 中的设置。

注 在创建用户平坦度校正阵列过程中，功率计通过 GPIB 伺服信号源，GPIB 接口上不允许任

何其它控制器。

图 4-5 对配备选项 1EA 的信号源，使用毫米波信号源模块校正用户平坦度

信号源

模块
信号源

功率计

RF 输出

微波放大器

RF 输出

RF 输入

毫米波信号源模块

功率传感器

信号源模块接口

RF 输入

GPIB
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图 4-6 使用毫米波信号源模块和选项 1EA 信号源校正用户平坦度

注 在使用选项 1EA 信号源时，为保证在毫米波信号源模块 RF 输入上提供足够的 RF 幅度，通

过信号源 RF 输出和毫米波信号源模块 RF 输入之间连接的适配器和电缆的最大幅度损耗应

小于 1.5 dB。

配置信号源

1. 打开信号源线路电源。在加电时，信号源自动进行如下操作：

传感毫米波信号源模块

把信号源置平模式切换到外部 / 信号源模块

把毫米波信号源模块的频率和幅度设成信号源模块的预置值

显示毫米波信号源模块输出上提供的 RF 输出频率和幅度

信号源显示屏FREQUENCY区域的MMMOD指示灯和AMPLITUDE区域的MM指示灯表明毫米波

信号源模块激活。

注 对特定的频率 / 幅度范围，请参阅毫米波信号源模块技术数据。

信号源

模块
信号源

功率计

RF 输出

毫米波信号源模块

功率传感器

信号源模块接口

RF 输入

GPIB
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2. 配置信号源，连接功率计：

a. 按Amplitude > More (1 of 2) > User Flatness > More (1 of 2) > Power Meter > E4416A, E4417A,

E4418B, 或 E4419B。

b. 按Meter Address > 输入功率计的 GPIB 地址 > Enter。

c. 对 E4417A 和 E4419B 型号，按 Meter Channel A B，选择功率计的活动通道。

d. 按Meter Timeout，调节如果与功率计通信尝试失败，仪器生成超时错误前的时间长度。

3. 按More (2 of 2) > Configure Cal Array > More (1 of 2) > Preset List > Confirm Preset。打开用户平坦度

表格编辑器，预置校准阵列频率 / 校正列表。

4. 按Configure Step Array。打开一个菜单，输入用户平坦度步进阵列数据。

5. 按 Freq Start > 26.5 > GHz。

6. 按 Freq Stop > 40 > GHz。

7. 按 # of Points > 28 > Enter。

在步进阵列中输入希望的平坦度校正频率(范围为 26.5 GHz - 40 GHz，间隔为 500 MHz)。

8. 按Return > Load Cal Array From Step Array > Confirm Load From Step Data。使用步进阵列中定义的

频率设置填充用户平坦度校正阵列。

9. 按Amplitude > 0 > dBm。

10. 按RF On/Off。

激活 RF 输出，信号源上显示 RF ON 报警器。

进行用户平坦度校正

注 如果没有使用 Agilent E4416A/17A/18B/19B 功率计，或如果功率计没有 GPIB 接口，可以手动

进行用户平坦度校正。如需说明，请参阅下面的“手动进行用户平坦度校正”。

1. 按More (1 of 2) > User Flatness > Do Cal。

创建用户平坦度幅度校正值表项。信号源进入用户平坦度校正程序，显示屏上显示进度条。
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2. 根据提示，按Done。

把幅度校正值加载到用户平坦度校正阵列中。

如果需要，按 Configure Cal Array。

打开用户平坦度校正阵列，可以查看存储的幅度校正值。用户平坦度校正阵列标题显示User Flatness:

(UNSTORED)，表示当前用户平坦度校正阵列数据还没有保存到内存目录中。

手动执行用户平坦度校正

如果没有使用Agilent E4416A/17A/18B/19B功率计，或如果功率计没有GPIB接口，完成本节中的步

骤，然后继续用户平坦度校正教程。

1. 按More (1 of 2) > User Flatness > Configure Cal Array。

打开用户平坦度表格编辑器，把光标放在第一行的频率值(26.5 GHz)上。RF 输出变成包含光标的表

格行的频率值，显示屏的 AMPLITUDE 区域显示 26.500 000 000 00。

2. 观察和记录从功率计中测得的值。

3. 从 0 dBm 中减去测得的值。

4. 把表格光标移到第一行中的校正值上。

5. 按Edit Item >输入第 3 步中的差值> dB。

信号源根据输入的校正值调节 RF 输出幅度。

6. 重复第 2 步到第 5 步，直到功率计读数为 0 dBm。

7. 使用下箭头键，把光标放在下一行的频率值上。RF输出变成包含光标的表格行的频率值，如显示屏

AMPLITUDE 区域所示。

8. 对用户平坦度表格中的每一项，重复第 2 步到第 7 步。
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把用户平坦度校正数据保存到内存目录中

这一过程允许把用户平坦度校正数据保存在信号源的内存目录中。在把多个用户平坦度校正文件保

存到内存目录中时，可以调用任何文件，把任何文件加载到校正阵列中，并应用到RF输出上，满足特定

的 RF 输出平坦度要求。

1. 按 Load/Store。

2. 按Store to File。

3. 使用输入字符和数字软键和数字键盘，输入文件名 FLATCAL2。

4. 按Enter。

用户平坦度校正阵列文件 FLATCAL2 现在作为 UFLT 文件存储在内存目录中。

应用用户平坦度校正阵列

1. 按Return > Return > Flatness Off On。

把平坦度校正阵列应用到 RF 输出上。信号源显示屏 AMPLITUDE 区域中的 UF 指示灯激活，校

正阵列中包含的频率校正数据应用到 RF 输出幅度上。

调用和应用用户平坦度校正阵列

在执行本节中的步骤以前，应先完成第 144 页“使用毫米波信号源模块创建用户平坦度校正阵列”。

1. 按Preset。

2. 按Amplitude > More (1 of 2) > User Flatness > Configure Cal Array > More (1 of 2) >Preset List >

Confirm Preset。

3. 按More (2 of 2) > Load/Store。

4. 保证高亮度显示文件 FLATCAL2。

5. 按 Load From Selected File > Confirm Load From File。

使用文件 FLATCAL2 中包含的数据填充用户平坦度校正阵列。用户平坦度校正阵列标题显示 User

Flatness: FLATCAL2。

6. 按Return > Flatness Off On。

使用 FLATCAL2 中包含的数据激活平坦度校正。
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调节参考频率振荡器带宽(选项 UNR)

可以使用内部或外部 10 MHz频率参考的固定步进，调节配备选项 UNR(改善了闭合相噪< 1 kHz)的

信号源中的参考频率振荡器带宽(有时称为环路带宽)。参考频率振荡器带宽可以设成 25, 55, 125, 300 或

650 Hz；没有配备选项 UNR 的型号具有大约 15 Hz 的固定参考频率振荡器带宽。

在频率偏置低于大约 1 kHz 时，稳定性和相噪取决于内部或外部频率参考。在频率偏置高于 1 kHz

时，稳定性和相噪取决于合成器硬件。

为在特定应用中优化信号源的整体相噪性能，应根据外部或内部参考频率的稳定性和相噪的置信度

及各种载频偏置的合成器硬件来进行这一调节。

选择参考频率振荡器带宽

在使用内部时基参考时：

1. 按Utility > Instrument Adjustments > Reference Oscillator Adjustment > Internal Ref Bandwidth。

2. 选择希望的带宽。

在使用外部时基参考时：

1. 按Utility > Instrument Adjustments > Reference Oscillator Adjustment > External Ref Bandwidth。

2. 选择希望的带宽。

恢复出厂默认设置：

内部时基: 125 Hz

外部时基: 25 Hz

按Utility > Instrument Adjustments > Reference Oscillator Adjustment > Restore Factory Defaults。
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在下面几节中，本章将介绍Agilent E8257D PSG 模拟信号源和 E8267D PSG 矢量信号源中的标准连

续波形功能和选装的模拟调制功能。

“模拟调制波形”，第 154 页

“配置 AM (选项 UNT)”，第 155 页

“配置 FM (选项 UNT)”，第 156 页

“配置 FM (选项 UNT)”，第 157 页

“配置脉冲调制(选项 UNU/UNW)”，第 158 页

“配置 LF 输出(选项 UNT)”，第 159 页

5   模拟调制



154 第 5章

模拟调制

模拟调制波形

模拟调制波形

提供的标准内部波形包括：

正弦 正弦波，可以调节幅度和频率

双正弦 双正弦波，可以单独调节频率及为第二个音调(仅函数发生器提供)

设置峰值幅度百分比

扫描正弦 扫描正弦波，可以调节开始频率和停止频率、扫描速率和扫描触发设置

(仅函数发生器提供)

三角形 三角形波，可以调节幅度和频率

锯齿 锯齿波，可以调节幅度和频率

方形 方波，可以调幅度和频率

噪声 噪声，可以调节幅度，以峰到峰值形式生成(RMS 值约是显示值的 80%)

在配备选项UNT时，信号源可以使用幅度调制、频率调制或相位调制技术调制RF载波。选项UNT

还提供了低频输出功能。

在配备选项 UNU 时，信号源可以使用标准脉冲调制技术调制 RF 载波(150 ns 最小脉宽)。

在配备选项 UNW 时，信号源可以使用窄脉冲调制技术调制 RF 载波(20 ns 最小脉宽)。
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配置AM (选项 UNT)

在本例中，您将学习怎样生成调幅的 RF 载波。

设置载频

1. 按Preset。

2. 按 Frequency > 1340 > kHz。

设置 RF 输出幅度

按Amplitude > 0 > dBm。

设置 AM 深度和速率

1. 按AM 硬键。

2. 按AM Depth > 90 > %。

3. 按AM Rate > 10 > kHz。

信号源现在配置成以1340 kHz输出一个0 dBm的调幅载波，AM深度设为90%，AM速率设为10 kHz。

波形形状是正弦波。注意正弦是AM Waveform 软键的默认选择，按(More 1 of 2)可以查看这一选择。

启动幅度调制

根据下述步骤，输出调幅信号。

1. 按AM Off On 软键直到 On。

2. 按前面板 RF On Off 键。

现在显示AM和RF ON报警器，表明已经启动幅度调制，现在正在从RF OUTPUT连接器传输信号。
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配置 FM (选项 UNT)

在本例中，您将学习怎样创建调频的 RF 载波。

设置 RF 输出频率

1. 按Preset。

2. 按 Frequency > 1 > GHz。

设置 RF 输出幅度

按Amplitude > 0 > dBm。

设置 FM 偏差和速率

1. 按 FM/øM 硬键。

2. 按 FM Dev > 75 > kHz。

3. 按 FM Rate > 10 > kHz。

信号源现在配置成以 1 GHz 输出 0 dBm 调频载波，偏差为 75 kHz，速率为 10 kHz。波形形状是正

弦波。(注意正弦是 FM Waveform 软键的默认值。按 More (1 of 2)查看软键。)

激活 FM

1. 按 FM Off On 直到 On。

2. 按RF On/Off。

FM 和 RF ON 报警器现在显示，表明已经启动频率调制，现在正从 RF OUTPUT 连接器传送信号。

DC 偏置和外部 FM

对外部FM信号应用DC偏置将移动高于或低于载频的FM信号的频率，具体取决于DC电平的极性。

频率位移数量与DC电平幅度直接相关。+1.0 V或更高的DC偏置对外部FM频率位移的量等于最大偏差

设置。例如，如果信号源CW连续波频率是 1 GHz，最大偏差设置设为 100 kHz，采用 +1.0 V DC电平作

为调制源的外部 DC 耦合信号将把 FM 信号居中在 1 GHz + 100 kHz 上。保持相同的设置，设置及把 DC

电平变成 +0.5 V，将把 FM 信号居中在 1 GHz + 50 kHz 上。
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配置Φ M (选项 UNT)

在本例中，您将学习怎样创建调相的 RF 载波

设置 RF 输出频率

1. 按Preset。

2. 按 Frequency > 3 > GHz。

设置 RF 输出幅度

按Amplitude > 0 > dBm。

设置Φ M 偏差和速率

1. 按 FM/øM 硬键。

2. 按 FM/øM 软键。

3. 按 øM Dev > .25 > pi rad。

4. 按 øM Rate > 10 > kHz。

信号源现在配置成以 3 GHz 输出 0 dBm 调相的载波，弧度偏差为 0.25 p，速率为 10 kHz。波形形状

为正弦波。(注意正弦是 øM Waveform 软键的默认值。按More (1 of 2)查看软键。)

为实现ΦM

1. 按 øM Off On。

2. 按RF On/Off。

现在显示Φ M 和 RF ON 报警器，表明已经启动相位调制，正在从 RF OUTPUT 连接器传送信号。
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配置脉冲调制(选项 UNU/UNW)

在本例中，您将学习怎样使用外部触发器创建选通的脉冲调制RF 载波。

设置 RF 输出频率

1. 按Preset。

2. 按 Frequency > 2 > GHz。

设置 RF 输出幅度

按Amplitude > 0 > dBm。

设置脉冲周期、宽度和触发

1. 按Pulse > Pulse Period > 100 > usec。

2. 按Pulse > Pulse Width > 24 > usec。

3. 按Pulse > Pulse Source > Int Gated。

4. 把 TTL 信号连接到信号源后面板上的 Trigger In 连接器上，为配置触发信号极性，

按Utility > Instrument Adjustments > Signal Polarity Setup > Trigger In Polarity。

信号源现在配置成以 2 GHz输出 0 dBm的脉冲调制载波，脉冲周期为 100微秒，脉宽为 24微秒。脉

冲来源设为内部选通。(注意 Internal Free Run 是 Pulse Source 软键的默认值。)

激活脉冲调制

通过下述步骤，输出脉冲调制信号。

1. 按Pulse Off On，直到 On。

2. 按RF On/Off。

现在显示 Pulse 和 RF ON 报警灯，表明已经启动脉冲调制，现在正在从 RF OUTPUT 连接器传送信

号。TTL 触发信号状态将控制脉冲调制输出。
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配置 LF输出(选项UNT)

通过配备选项 UNT，信号源有了低频(LF)输出(见第 12 页)。LF 输出来源可以在 Internal 1 Monitor,

Internal 2 Monitor, Function Generator 1 或 Function Generator 2 之间切换。

在使用 Internal 1 Monitor 或 Internal 2 Monitor 作为 LF 输出源时，LF 输出从调制 RF 输出使用的内

部信号源提供信号的复制品。这个信号的具体调制参数通过 AM、FM 或 FM 菜单配置。

在使用Generator 1 或 Function Generator 2 作为 LF 输出源时，内部调制源的函数发生器部分直接

驱动LF输出。频率和波形从LF输出菜单配置，而不是通过AM、FM或FM菜单配置。可以从下述选择

中选择波形形状：

正弦 正弦波，可以调节幅度和频率

双正弦 双正弦波，可以单独调节频率及为第二个音调(仅函数发生器提供)

设置峰值幅度百分比

扫描正弦 扫描正弦波，可以调节开始频率和停止频率、扫描速率和扫描触发设置

(仅函数发生器提供)

三角形 三角形波，可以调节幅度和频率

锯齿 锯齿波，可以调节幅度和频率

方形 方波，可以调幅度和频率

噪声 噪声，可以调节幅度，以峰到峰值形式生成(RMS 值约是显示值的 80%)

DC 直流，可以调节幅度

注 LF Out Off On软键控制着LF输出的工作状态。但是，在LF输出源选择是 Internal Monitor时，

可以通过三种方式控制输出。可以使用调制源(AM, FM 或 FM)开 / 关键、LF 输出开 / 关键或

Mod On/Off 软键。

RF On/Off 硬键不适用于 LF OUTPUT 连接器。
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使用内部调制源配置 LF 输出

在本例中，内部 FM 调制是 LF 输出源。

注 内部调制(Internal Monitor)是默认的 LF 输出源。

把内部调制配置成 LF 输出源

1. 按Preset。

2. 按 FM/øM 硬键。

3. 按 FM Dev > 75 > kHz。

4. 按 FM Rate > 10 > kHz。

5. 按 FM Off On。

已经设置 FM 信号，速率为 10 kHz，偏差为 75 kHz。FM 报警器激活，表明已经启动频率调制。

配置低频输出

1. 按 LF Out 硬键。

2. 按 LF Out Amplitude > 3 > Vp。

3. 按 LF Out Off On。

已经为使用 Internal 1 Monitor 源选择(默认来源)调频的 3 V 正弦波(默认波形)配置 LF 输出信号。



161第 5 章

模拟调制

配置 LF 输出(选项 UNT)

使用函数发生器来源配置 LF 输出

在本例中，函数发生器是 LF 输出源。

把函数发生器配置成 LF 输出源

1. 按Preset。

2. 按 LF Out 硬键。

3. 按 LF Out Source > Function Generator 1。

配置波形

1. 按 LF Out Waveform > Swept-Sine。

2. 按 LF Out Start Freq > 100 > Hz。

3. 按 LF Out Stop Freq > 1 > kHz。

4. 按Return > Return。

返回顶级 LF Output 菜单。

配置低频输出

1. 按 LF Out Amplitude > 3 > Vp。

把 LF 输出幅度设为 3 Vp。

2. 按 LF Out Off On。

LF输出现在使用函数发生器1传送信号，函数发生器1提供了一个3 Vp扫描正弦波形。波形扫描范

围为 100 Hz - 1 kHz。
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在下面几节中，本章将介绍定制任意波形发生器模式，只有配备选项 601 或 602 的 E8267D PSG 矢

量信号源才提供了这种模式。

“概述”，第 164 页

“处理预先定义的设置(模式)”，第 165 页

“处理滤波器”，第 169 页

“处理码速率”，第 177 页

“处理调制类型”，第 180 页

“配置硬件”，第 188 页

另请参阅：“基本数字操作”，第 77 页

6   定制任意波形发生器
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概述

概述

定制任意波形发生器模式可以生成单个调制的载波或多个调制的载波。在能够输出前，必须计算和

生成每个调制的载波波形；这个信号生成发生在内部基带发生器(选项601或602)上。一旦已经创建了波

形，可以存储和调用波形，重复播放测试信号。

为开始使用定制任意波形发生器模式，选择是创建单个调制的载波波形还是多个调制的载波波形：

如果想创建单个调制的载波波形，先从预先定义的模式集合(设置)中选择数字调制设置。一旦选择了

预先定义的模式，可以修改调制类型、使用的滤波器、码速率和触发类型；在默认状态下，数据码型

是随机的。然后可以存储和重用修改后的设置。

如果想创建多个调制的载波波形，先从预先定义的模式集合(设置)中选择多载波设置。一旦选择了预

先定义的模式，可以修改要创建的载波数量、每个载波之间的频率间隔、每个载波之间的相位偏置是

固定的还是随机的以及触发类型；在默认状态下，数据码型是随机的，滤波器在默认状态下设为 40

MHz，选择的正在使用的调制类型自动指定码速率。
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外理预先定义的设置(模式)

外理预先定义的设置(模式)

在选择预先定义的模式时，自动指定设置成分的默认值(包括滤波器、码速率和调制类型)。

选择定制 ARB 设置或定制数字调制状态

1. 预置信号源: 按Preset。

2. 按Mode > Custom > Arb Waveform Generator > Setup Select。

3. 选择：

其中一个预先定义的调制设置:NADC, PDC, PHS, GSM, DECT, EDGE, APCO 25 w/C4FM, APCO 25

w/CQPSK, CDPD, PWT, 或 TETRA。

选择预先定义的设置，其中通过已经选择的预先定义的调制设置(模式)定义滤波、码速率和调制类

型，返回顶级定制调制菜单；不包括突发或通道编码。

或

Custom Digital Mod State

选择DMOD文件目录中存储的定制设置(如需了解怎样创建定制数字调制设置，请参阅第166页)。
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处理用户定义的设置(模式)-仅定制 Arb

修改单载波 NADC 设置

在这一程序中，您将学习怎样从单载波NADC数字调制开始，把它修改为具有定制调制类型、码整

编和滤波的定制波形。

1. 按Preset。

2. 按Mode > Custom > ARB Waveform Generator > Setup Select > NADC。

3. 按Digital Mod Define > Modulation Type > PSK > QPSK and OQPSK > QPSK。

4. 按Symbol Rate > 56 > ksps。

5. 按 Filter > Select > Nyquist。

6. 按Return > Return > Digital Modulation Off On。

生成具有定制单载波 NADC 数字调制状态的波形。显示画面变成 Dig Mod Setup: NADC (Modified)。

在生成波形的过程中，出现DIGMOD报警器和 I/Q 报警器，定制单载波数字调制状态存储在易失性

内存中。

7. 把 RF 输出频率设为 835 MHz。

8. 把输出幅度设为 0 dBm。

9. 按RF On/Off。

现在在 RF OUTPUT 连接器上提供了用户定义的 NADC 信号。

10. 按Return > Return。

返回顶级数字调制菜单，其中第一个软键是Digital Modulation Off On。

11. 按Digital Mo.d Define > Store Custom Dig Mod State > Store To File。

如果 DMOD 文件目录中已有一个文件名占用活动输入区域，按：Edit Keys > Clear Text。

12. 使用 alpha 键和数字键盘输入一个文件名(例如：NADCQPSK)。

13. 按Enter。

用户定义的单载波数字调制状态现在应该存储在非易失性内存中。RF输出幅度、频率和工作状态设

置不作为用户定义的数字调制状态文件的一部分存储。
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处理用户定义的设置(模式)-仅定制 Arb

定制多载波设置

在这一程序中，您将学习怎样通过创建定制的 3 载波EDGE 数字调制状态，来定制预先定义的多载

波数字调制设置。

1. 按Preset。

2. 按Mode > Custom > Arb Waveform Generator > Multicarrier Off On。

3. 按Multicarrier Define > Initialize Table > Carrier Setup > EDGE > Done。

4. 高亮度显示第 2 行中载波的 Freq Offset 值(500.000 kHz)，按Edit Item > -625 > kHz。

5. 高亮度显示第 2 行中载波的 Power 值(0.00 dB)，按 Edit Item > -10 > dB。

得到一个定制的 2 载波 EDGE 波形，载波频率偏置为 -625 kHz，功率电平为 -10.00 dBm。

6. 按Return > Digital Modulation Off On。

生成具有定制多载波EDGE状态的波形。显示画面变成Dig Mod Setup: Multicarrier (Modified)。在生

成波形的过程中，出现DIGMOD报警灯和 I/Q报警灯，新的定制多载波 EDGE状态存储在易失性内

存中。

7. 把 RF 输出频率设为 890.01 MHz。

8. 把输出幅度设为 -10 dBm。

9. 按RF On/Off。

RF OUTPUT 连接器上提供了定制的多载波 EDGE 波形，它不包括突发或通道编码。

10. 按Mode > Custom > Arb Waveform Generator，其中第一个软键是 Digital Modulation Off On。

11. 按Multicarrier Off On > Multicarrier Define > More (1 of 2) > Load/ Store > Store To File。

如果 DMOD 文件目录中已有一个文件名占用活动输入区域，按：Edit Keys > Clear Text。

12. 使用 alpha 键和数字键盘输入一个文件名(例如：EDGEM1)，按Enter。

用户定义的多载波数字调制状态现在应该存储在非易失性内存中。

注 RF输出幅度、频率和工作状态设置(如RF On/Off)不作为用户定义的数字调制状态文件的一部

分存储。如需更多信息，请参阅第 59 页“使用数据存储功能”。
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调用用户定义的定制数字调制状态

在这一程序中，您将学习怎样从内存目录(DMOD文件目录)中选择(调用)以前存储的定制数字调制

状态。

1. 按Preset。

2. 按Mode > Custom > ARB Waveform Generator > Setup Select。

3. 按More (1 of 2) > Custom Digital Mod State。

4. 按Select File，从 DMOD 文件目录中选择定制调制状态。

现在应从非易失性内存中调用用户定义的定制数字调制状态。由于RF输出幅度、频率和工作状态设

置(如RF On/Off)不作为用户定义的数字调制状态文件的一部分存储，因此它们还必须单独设置或调

用。如需更多信息，请参阅第 59 页“使用数据存储功能”。
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处理滤波器

本节介绍了怎样使用预先定义的 FIR 滤波器(第 170 页)和用户定义的 FIR 滤波器(第 171 页)。

注 本节中的程序只适用于在定制任意波形发生器或定制实时 I/Q基带模式下创建的滤波器；它们

不能用于下载的文件，如 Matlab 中创建的文件。

Filter菜单选择能够对生成的信号应用滤波器，定义有限脉冲响应(FIR)滤波器，改变根内奎斯特或内

奎斯特滤波Alpha，改变高斯滤波BbT，或把所有滤波参数恢复到默认状态。在定制实时 I/Q模式下，还

可以为误码矢量幅度(EVM)或邻道功率(ACP)优化 FIR 滤波器。

预先定义的滤波器(Filter > Select)

Root Nyquist是根升余弦预调制FIR滤波器。在希望把一半滤波放在发射机中，把另一半放在接收机

中时，可以使用根内奎斯特滤波器。理想的根升余弦滤波器频响由低频上的正态增益、中间的升余弦

函数平方根和高频上的总衰减组成。中间频率的宽度通过Filter Alpha的滚降系数定义(0 < 滤波 < 1)。

Nyquist 是一种升余弦预调制 FIR 滤波器。可以使用内奎斯特滤波器，在不丢失信息的情况下，降低

信号要求的带宽。理想的升余弦滤波器频响由低频上的正态增益、中间的升余弦函数和高频上的总衰

减组成。中间频率的宽度通过滤波 Alpha 的滚降系数定义(0 < 滤波 < 1)。

Gaussian 是一种高斯预调制 FIR 滤波器。

User FIR使您能够从FIR滤波器目录中选择滤波器；如果其它预先定义的FIR不能满足需求，可以使

用这一选择。如需更多信息，请参阅下面的定义用户 FIR。

Rectangle 是一种矩形预调制 FIR 滤波器。

APCO 25 C4FM 是一种 APCO 25 规定的 C4FM 滤波器；这是一种内奎斯特滤波器，alpha 等于 0.200，

与整形滤波器结合在一起。

滤波器参数

Define User FIR (定义用户 FIR)用于预先定义的 FIR 滤波器不能满足需求时。可以定义 FIR 系数，设

置应用到定制 FIR 滤波器的超量取样比率(每个码滤波系数数量)。
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Filter Alpha(Filter Alpha)可以对内奎斯特滤波器或根内奎斯特滤波器调节滤波 Alpha。如果使用高斯

滤波器，您将看到 Filter BbT，在选择任何其它滤波器时，这个软键会变成灰色。

(仅适用于定制实时 I/Q基带) Optimize FIR for EVM ACP使您能够优化内奎斯特滤波器或根内奎斯特

滤波器，使误差矢量幅度(EVM)达到最小，或使邻道功率(ACP)达到最小；在选择任何其它滤波器时，

这个软键会变成灰色。

Restore Default Filters (恢复默认滤波器)用选定格式的默认 FIR 滤波器代替当前 FIR 滤波器。

使用预先定义的 FIR 滤波器

选择预先定义的 FIR 滤波器

1. 预置仪器：按 Preset。

2. 按 Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Select
或

Mode > Custom > Real Time I/Q Baseband > Filter > Select >。

3. 选择希望的滤波器。如果在第一个列表中没有想要的滤波器，按More (1 of 2)。

调节预先定义的根内奎斯特滤波器或内奎斯特滤波器的滤波 Alpha

1. 预置仪器：按 Preset。

2. 按 Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Filter Alpha
或

Mode > Custom > Real Time I/Q Baseband > Filter > Filter Alpha

3. 输入新的滤波 Alpha 值，按 Enter。

调节预先定义的高斯滤波器的带宽位时间(BbT)乘积

1. 按 Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Select > Gaussian
或

Mode > Custom > Real Time I/Q Baseband > Filter > Select > Gaussian

2. 按 Filter BbT。

3. 输入新的带宽位时间(BbT)乘积滤波参数，按Enter。

针对 EVM 或 ACP 优化内奎斯特滤波器或根内奎斯特 FIR 滤波器(仅适用于定制实时 I/Q 基带)

1. 预置仪器：按 Preset。

2. 按 Mode > Custom > Real Time I/Q Baseband > Filter > Optimize FIR For EVM or ACP。
现在优化了 FIR滤波器，以实现最小误差矢量幅度(EVM)或实现最小邻道功率(ACP)。这一功能只适

用于内奎斯特滤波器和根内奎斯特滤波器。在选择任何其它滤波器时，这个软键会变成灰色。
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恢复默认的 FIR 滤波参数

1. 预置仪器：按 Preset。

2. 按Mode > Custom > ARB Waveform Generator > Digital Mod Define > Filter > Restore Default Filter。

用选定调制格式的默认滤波器代替当前 FIR 滤波器。

使用用户定义的 FIR 滤波器

通过定义FIR系数，或通过定义自定义FIR滤波器应用的超量取样比率(每个码的滤波系数数量)，可

以创建和修改 FIR 滤波器。

使用 FIR 值编辑器修改为高斯滤波器预先定义的 FIR 系数

可以定义 1 - 32个 FIR系数，其中码和超量取样比率的最大组合为 1024个系数。尽管 FIR值编辑器

支持的最大滤波器长度是 1024个系数，但 PSG硬件在实时生成波形时仅限于 64个码，在生成任意波形

时仅限于 512 个码(码数等于系数数量除以超量取样比率)。

如果对实时生成波形输入的码数超过64个，对任意波形生成模式输入的码数超过 512个，那么PSG

不能使用滤波器；它将清除滤波器(扔掉系数)，直到满足要求的条件，然后使用滤波器，但脉冲响应中可

能会丢失精细的分辨率。

可以使用 FIR 值编辑器简便地修改信号源内存中存储的 FIR 滤波器。在本例中，将对 FIR 值编辑器

加载来自默认FIR滤波器的系数值(或者如果已经定义一个值，则使用内存目录中存储的用户定义的FIR

文件)，修改系数值，把新文件存储到内存目录中。

1. 按Preset。

2. 按Mode > Custom > Arb Waveform Generator > Digital Mod Define > Filter 或

 Mode > Custom > Real Time I/Q Baseband > Filter。

3. 按Define User FIR > More (1 of 2) > Load Default FIR > Gaussian。

4. 按 Filter BbT > 0.300 > Enter。

5. 按 Filter Symbols > 8 > Enter。

6. 按Generate。

注 仪器自动选择调制过程中的实际超量取样比率。取值范围在 4 - 16 之间，具体取决于码速率、

调制类型每个码的位数以及码数。

7. 按Display Impulse Response。下面的图表显示了当前 FIR 系数的脉冲响应。



172 第 6章

定制任意波形发生器

处理滤波器

8. 按Return。

9. 高亮度显示系数 15。

10. 按 0 > Enter。

11. 按Display Impulse Response。

这个示意图可以提供有用的诊断工具(在本例中，它表明系数值设置不正确，导致高斯响应不正确)。

12. 按Return。

13. 高亮度显示系数 15。

14. 按 1 > Enter。

15. 按 Load/Store > Store To File。

16. 把文件命名为 NEWFIR2，按Enter。

FIR 值编辑器的内容存储到内存目录的文件中，更新 FIR 文件目录，以显示新文件。
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使用 FIR 值编辑器创建用户定义的 FIR 滤波器

在这一程序中，您将使用 FIR 值编辑器创建和存储 8 个码的窗口 sinc 函数滤波器，其超量取样比率

为 4。超量取样比率(OSR)是每个码的滤波系数数量。

可以定义 1 - 32 个 FIR 系数，其中码和超量取样比率的最大组合是 1024 个系数。

FIR 值编辑器支持的最大滤波器长度是 1024 个系数，但 PSG 硬件对生成任意波形仅限于 512 个码，

对生成实时波形仅限于 64 个码。码数等于系数数量除以超量取样比率。如果输入的码数超过最大码数，

那么 PSG不能使用滤波器；它将清除滤波器(扔掉系数)，直到满足要求的条件，然后使用滤波器，但脉

冲响应中可能会丢失精细的分辨率。

1. 按Preset。

2. 按Mode > Custom > Arb Waveform Generator > Digital Mod Define > Filter

或

Mode > Custom > Real Time I/Q Baseband > Filter

3. 按Define User FIR > More (1 of 2)。

4. 按Delete All Rows > Confirm Delete Of All Rows > More (2 of 2)。

启动 FIR 值编辑器，清除现有值表格。

5. 按Edit Item。系数 0 的 Value 字段应高亮度显示。
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6. 使用数字键盘，输入下表中的第一个值(-0.000076)，按Enter。在按数字键时，数字显示在活动输入

区域内。(在出错时，可以使用退格键删除) 继续输入表中的系数值，直到输入全部 16 个值。

7. 按Mirror Table。

在窗口 sinc 函数滤波器中，系数的后半部分与前半部分相同，但顺序相反。信号源提供了镜像表

格功能，以相反的顺序自动复制现有的系数值；系数16-31自动生成，其中第一个系数(16号)高亮度

显示，如下图所示。

系数 取值

0 -0.000076

1 -0.001747

2 -0.005144

3 -0.004424

4 0.007745

5 0.029610

系数 取值

6 0.043940

7 0.025852

8 -0.035667

9 -0.116753

10 -0.157348

11 -0.088484

系数 取值

12 0.123414

13 0.442748

14 0.767329

15 0.972149
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8. 在本例中，希望的 SOR 是 4，这是默认值，没有必要进行任何操作。

超量取样比率(OSR)是每个码的滤波系数数量。可以接受的取值范围为 1 - 32；FIR 值编辑器允许的

码和超量取样比率的最大组合是1024。但要记住，仪器硬件对生成实时波形仅限于64个码，对生成

任意波形仅限于 512 个码。码数等于系数数量除以超量取样比率。

9. 按More (1 of 2) > Display FFT (快速傅立叶变换)。

图表显示当前 FIR 系数集的快速傅立叶变换。信号源能够以图形方式在时间和频率维度中显示滤

波器。

10. 按Return > Display Impulse Response。

图表显示当前 FIR 系数集的脉冲响应。

11. 按Return > Load/Store > Store To File。

FIR 文件目录与提供的内存数量一起出现。

12. 如果已经有一个文件名占用活动输入区域，按：Edit Keys > Clear Text。

13. 使用字符数字菜单和数字键盘，输入 NEWFIR1 作为文件名。
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14. 按Enter。

NEWFIR1文件是列出的第一个文件名。(如果以前已经存储其它FIR文件，在NEWFIR1下面会列出其

它文件名。) 文件类型是FIR，文件大小是260个字节。另外还会显示已经使用的内存数量。可以保存

的文件数量取决于文件大小及已经使用的内存数量。
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Symbol Rate (码速率)菜单可以设置 I/Q 码输入到 I/Q 调制器中的速率。还可以在这个菜单中恢复默

认的传输码速率。

码速率(显示为 Sym Rate)是使用调制(显示为 Mod Type)与滤波器和滤波(显示为 Filter)一起传送的每

秒码数量。

码速率直接影响着占用的信号带宽。

码速率是位速率除以每个码可以传输的位数，也称为波特率。

位速率是系统码流的频率。内部基带发生器(选项602)自动以相应的速率传送选择的数据码型，以支持

码速率设置(位速率 = 码 / 秒 x 每个码的位数)。

占用信号带宽 = 码速率 x (1 + 滤波Alpha)；因此占用信号带宽取决于使用的内奎斯特滤波器或根内奎

斯特滤波器的滤波 alpha。(如需改变滤波 alpha，请参阅第 170 页程序“调节预先定义的根内奎斯特滤

波器或内奎斯特滤波器的滤波 Alpha)

设置码速率

1. 按 Preset。

2. 按Mode > Custom > ARB Waveform Generator > Digital Mod Define > Symbol Rate

或

Mode > Custom > Real Time I/Q Baseband > Symbol Rate

3. 输入新的码速率，按Msps, ksps, 或 sps。

恢复默认码速率(仅定制实时 I/Q)

按Mode > Custom > Real Time I/Q Baseband > Symbol Rate > Restore Default Symbol Rate。

用选定调制格式的默认码速率代替当前码速率。
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处理调制类型

Modulation Type (调制类型)菜单可以定义在 Mod On Off 硬键为 on 时应用到载波信号的调制类型。

在Custom Off On 软键为 on 时：

对定制 Arb，BBG (基带发生器)根据随机数据码型和已经选择的调制类型，创建 I/Q 波形样本。

对定制实时 I/Q，实时定制 I/Q码构建器根据已经选择的数据码型和调制类型创建 I/Q码 (如需了解怎

样选择数据码型，请参阅第 193 页“处理数据码型”)。

在定制实时 I/Q 中，还可以：

创建可以立即使用或保存到内存目录中的用户定义的调制类型(参阅第 181 页)。

把所有调制参数恢复到默认状态。

选择预先定义的调制类型

1. 按 Preset。

2. 按Mode > Custom > ARB Waveform Generator > Digital Mod Define > Modulation Type > Select

或

Mode > Custom > Real Time I/Q Baseband > Modulation Type > Select

3. 从提供的调制类型中选择一种调制类型。、

注 如果选择QPSK and OQPSK，必须从显示的菜单中完成特定选择。
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使用用户定义的调制类型(仅实时 I/Q)

使用 I/Q值编辑器创建 128QAM I/Q调制类型用户文件

在 I/Q调制方案中，码出现在 I/Q层的默认位置。通过使用 I/Q值编辑器，可以改变一个或多个码的

位置，定义自己的码图。使用下面的程序，创建和存储 128 码 QAM 调制。

注 尽管这一程序为实现128QAM调制格式提供了一种快捷方式，但它没有全面利用 I/Q调制器的

动态范围优势。这是因为您是从256QAM星座开始的，而且删除了不想要的点。构成128QAM

星座的其余点比专门映射每个点相距得更近。此外，在这种方法中，用户不能定义与每个码点

有关的码型，而在 128QAM 星座中，如果一次定义一个点，则可以定义码型。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) >

Load Default I/Q Map > QAM > 256QAM。

把默认的 256QAM I/Q 调制加载到 I/Q 值编辑器中。

3. 按More (2 of 2) > Display I/Q Map。

在下面的步骤中，将删除这个 I/Q 星座的特定部分，把它变成拥有 128 种 I/Q 状态的 128QAM。
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Goto Row... 按Delete Row 软键...

0110 0000 (96) 16 次

1001 0000 (144) 16 次

1100 0000 (192) 16 次

0001 0000 (16) 4 次

0001 0100 (20) 4 次

0001 1000 (24) 8 次

0011 0000 (48) 4 次

0011 0100 (52) 4 次

0011 1000 (56) 4 次

0101 1000 (88) 8 次

0111 0000 (112) 4 次

0111 0100 (116) 4 次

0111 1000 (120) 8 次

4. 按Return > Goto Row > 0011 0000 > Enter；这是第 48 行。

5. 按Delete Row 软键 16 次。

使用下表重复这一步进码型。

6. 按Display I/Q Map，查看已经创建新的星座。在本例中，I/Q 状

态图有 128 个码。

7. 按Return。在 I/Q 值表的内容还没有存储时，显示画面上出现

I/Q Values (UNSTORED)。

8. 按More (1 of 2) > Load/Store > Store To File。

如果 IQ文件目录中已有一个文件名占用活动输入区域，按下面

的键：Editing Keys > Clear Text

9. 使用 alpha 键和数字键盘输入一个文件名(例如：128QAM)。

10. 按Enter。

用户定义的 I/Q 状态图现在应该存储在 IQ 文件目录中。



183第 6 章

定制任意波形发生器

处理调制类型

使用 I/Q值编辑器创建 QPSK I/Q调制类型用户文件

在 I/Q调制方案中，码出现在 I/Q层的默认位置。通过使用 I/Q值编辑器，可以改变一个或多个码的

位置，定义自己的码图。使用下面的程序，创建和存储 4 码 QPSK 调制。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) >

Delete All Rows > Confirm Delete All Rows。

加载默认的 4QAM I/Q 调制，清除 I/Q 值编辑器。

3. 输入下表中列明的 I 值和 Q 值：

a. 按 0.5 > Enter。

b. 按 1 > Enter。

c. 输入其余的 I 值和 Q 值。

在 I值更新时，高亮度显示会移动到第一个Q项目上(提供默认值0)，在第一行下面出现一个空白的

数据行。在Q值更新时，高亮度显示会移动到下一个 I值。在按数字键时，数字显示在活动输入区域。如

果出错，可以使用删格键删除后重新输入。

另外注意，在 Distinct Values 列表中出现的第一项是 0.000000，0.500000 和 1.000000 作为不同值列

出。

4. 按More (2 of 2) > Display I/Q Map。

在 I/Q 值表中，从当前值中显示 I/Q 状态图。

本例中的 I/Q状态图有四个码。I/Q状态图使用下面四个唯一的值：0.5, 1.0, -0.5和 -1.0，创建4个码。

一张图有多少个码并不取决于取值数量，而是取决于这些取值的组合方式。

5. 按Return。

在 I/Q 值表内容没有存储时，显示屏上会出现 I/Q Values (UNSTORED)。

码 数据 I值 Q 值

0 0000 0.500000 1.000000

1 0001 -0.500000 1.000000

2 0010 0.500000 -1.000000

3 0011 -0.500000 -1.000000
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6. 按More (1 of 2) > Load/Store > Store To File。

如果 IQ 文件目录中已有一个文件名占用活动输入区域，按下面的键：Editing Keys > Clear Text

7. 使用 alpha 键和数字键盘输入一个文件名(例如：NEW4QAM)。

8. 按Enter。用户定义的 I/Q 状态图现在应该存储在 IQ 文件目录中，即使在信号源电源关闭后仍可

以调用。

修改预先定义的 I/Q 调制类型(I/Q 码)，模拟幅度误差和相位误差

使用下面的程序处理码位置，模拟幅度和相位误码。在本例中，您将编辑 4QAM星座，把一个码移

得距原点更近。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) >

Load Default I/Q Map > QAM > 4QAM。

把默认的 4QAM I/Q 调制加载到 I/Q 值编辑器中。

3. 按More (2 of 2)。

4. 在 I/Q 值编辑器中，移动到 Data 00000000，按Edit Item。

5. 按.235702 > Enter，然后按.235702 > Enter。

在第一次按 Enter 时，I 值会更新，高亮度显示会移动到第一个 Q 项目上。在第二次按时，Q 值会更

新，高亮度显示会移动到后面的 I 项目上。

6. 按Display I/Q Map。注：已经移动一个码，如图所示。
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使用频率值编辑器创建 FSK 调制类型用户文件

使用这一程序设置数据 00, 01, 10 和 11 的频率偏差，配置用户定义的 FSK 调制。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User FSK > More (1 of 2) >

Delete All Rows > Confirm Delete All Rows。

进入频率值编辑器，清除以前的值。

3. 按 600 > Hz。

4. 按 1.8 > kHz。

5. 按 -600 > Hz。

6. 按 -1.8 > kHz。

每次输入一个值时，Data 一栏会递增到下一个二进制数字，最多总计 16 个数据值(0000 - 1111)。将

为定制的 4 级 FSK 文件创建没有存储的频率偏差值文件。

7. 按 Load/Store > Store To File。

如果 FSK 文件目录中已有一个文件名占用活动输入区域，按下面的键：

Edit Keys > Clear Text

8. 使用 alpha 键和数字键盘输入一个文件名(例如：NEWFSK)。

9. 按Enter。

用户定义的 FSK 调制现在应存储在 FSK 文件目录中。
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使用频率值编辑器修改预先定义的 FSK调制类型用户文件

通过使用频率值编辑器，可以定义、修改和存储用户定义的频移键控调制。频率值编辑器适用于定

制实时 I/Q基带模式，但不适用于在定制任意波形发生器模式下生成的波形。可以使用本例，学习怎样在

默认的 FSK 调制中增加错误。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User FSK > More (1 of 2) >

Load Default FSK。

3. 按 Freq Dev > 1.8 > kHz。

4. 按 4-Lvl FSK。

设置频率偏差，打开频率值编辑器，显示 4 级 FSK 默认值。高亮度显示数据 0000 的频率值。

5. 按 -1.81 > kHz。

6. 按 -590 > Hz。

7. 按 1.805 > kHz。

8. 按 610 > Hz。

在修改频率偏差值时，光标移动到下一个数据行上。为定制的 4 级 FSK 文件创建没有存储的频率偏

差值文件。

9. 按 Load/Store > Store To File。

如果 FSK 文件目录中已有一个文件名占用活动输入区域，按下面的键：

Edit Keys > Clear Text

10. 使用 alpha 键和数字键盘输入一个文件名(例如：NEWFSK)。

11. 按Enter。

用户定义的 FSK 调制现在应存储在 FSK 文件目录中。
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宽带 IQ (选项 015)

配备选项 015的信号源使用外部 I/Q调制源，如双通道任意波形发生器，在RF上生成高达 2 GHz的

调制带宽。为启动宽带 I/Q 输入：

1. 按前面板 I/Q 硬键。

2. 按 I/Q Off。

3. 按 I/Q Path Wide (Ext Rear Inputs)。

4. 按 I/Q On。

把外部 I/Q 调制源连接到信号源的 Wideband I 和 Wideband Q 后面板输入上。输入的电压电平是 +/-

1 Vdc。宽带 IQ (选项 015)适用于 3.2 GHz 以上的 RF。详情请参阅选项 015 的技术数据表。

可以采用信号源的内部任意波形发生器(ARB)作为基带信号源，同时在RF上使用宽带输入。PSG后

面板上提供了内部 ARB I 和 Q 信号。使用下述步骤，把内部 ARB 设成基带信号源，启动宽带输入。

1. 使用希望的信号设置内部基带发生器。

2. 按Mux 硬键。

3. 按 I/Q Out。

4. 按BBG1。

5. 按前面板 I/Q 软键。

6. 按 I/Q Off。

7. 按 I/Q Path Wide (Ext Rear Inputs)。

8. 按 I/Q On。
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配置硬件

“设置 ARB 参考”，参阅第 189 页

设置延迟正极外部单触发

通过使用下面的程序，您将学习怎样使用外部函数发生器，对定制多载波波形应用延迟单触发。

1. 把 Agilent 33120A 函数发生器或同等设备连接到信号源 PATT TRIGGER IN 端口上，如图 6-1

所示。

图 6-1

2. 在信号源，按 Preset。

3. 按Mode > Custom > Arb Waveform Generator。

4. 按Multicarrier Off On，直到 On 高亮度显示。

5. 按 Trigger > Single。

6. 按 Trigger > Trigger Setup >Trigger Source > Ext。

7. 按Ext Polarity Neg Pos，直到 Pos 高亮度显示。

8. 按Ext Delay Off On，直到 On 高亮度显示。

9. 按Ext Delay Time > 100 > msec。

定制任意波形发生器已经配置成在检测到 PATT TRIG IN 后面板连接器上的 TTL 状态从低变成高时

播放单个多波载波波形 100 毫秒。

10. 把函数发生器波形设成 0.1 Hz 方形，输入电平为 0 - 5V。
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11. 在信号源，按 Mode > Custom > Arb Waveform Generator > Digital Modulation Off On，

直到 On 高亮度显示。

生成一个定制多载波状态的波形，显示画面变成 Dig Mod Setup: Multicarrier。

在生成波形的过程中，DIGMOD报警器和 I/Q报警器激活，新的定制多载波状态存储在易失性ARB

内存中。波形应调制 RF 载波。

12. 按RF On/Off。

在收到 PATT TRIG IN 上的TTL状态从低变成高、外部单触发定制多载波波形 100 ms后，信号发生

器的 RF OUTPUT 连接器上应提供外部单触发定制多载波波形。

设置 ARB 参考

外部或内部参考设置

1. 按Custom > Arb Waveform Generator > More (1 of 2)。

2. 按ARB Reference Ext Int，选择外部参考或内部参考作为波形取样时钟参考。

如果选择Ext，必须输入参考频率(250 kHz - 100 MHz)，把参考信号应用到后面板BASEBAND GEN

REF IN。

如果选择 Int，那么任意波形(ARB)频率参考使用内部时钟。

设置外部频率

只有在ARB Reference Ext Int 软键已经设为 Ext (外部)时，才能使用外部 Arb 参考频率。

1. 按Custom > Arb Waveform Generator > More (1 of 2)。

2. 按Reference Freq，输入希望的频率(250 kHz - 100 MHz)，按MHz, kHz, 或Hz。
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在下面几节中，本章将介绍定制实时 I/Q基带模式，只有配备选项601或 602的E8267D PSG矢量信

号源才提供了这种模式：

“概述”，第 192 页

“处理预先定义的设置(模式)”，第 192 页

“处理数据码型”，第 193 页

“处理突发形状”，第 199 页

“配置硬件”，第 204 页

“处理相位极性”，第 206 页

“处理差分数据编码”，第 207 页

另请参阅：“基本数字操作”，第 77 页

7   定制实时 I/Q 基带
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概述

概述

定制实时 I/Q 基带可以产生单载波，但它可以进行实时数据调制，允许实时控制影响信号的所有参

数。通过应用各种数据码型、滤波、码速率、调制类型和突发形状，可以改变产生的单载波信号。

为开始使用定制实时 I/Q 基带模式，先从预先定义的模式(设置)中进行选择，或通过选择数据码型、

滤波器、码速率、调制类型、突发形状、配置硬件、相位极性及差分数据编码开关来指定设置。

处理预先定义的设置(模式)

在选择预先定义的模式时，将自动指定设置成分的默认值(包括滤波器、码速率和调制类型)。

选择预先定义的实时调制设置

下面的步骤将选择预先定义的模式，其中滤波、码速率和调制类型由采用 C4FM 数字调制标准的

APCO 25 指定，并返回顶层定制调制菜单。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband。

3. 按More (1 of 3) > More (2 of 3) > Predefined Mode > APCO 25 w/C4FM。

4. 按More (3 of 3)。

反选预先定义的实时调制设置

反选上面已经选择的任何预先定义的模式，返回顶层定制调制菜单：

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband。

3. 按More (1 of 3) > More (2 of 3) > Predefined Mode > None。

4. 按More (3 of 3)。
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处理数据码型

本节提供下面的相关信息：

“使用预先定义的数据码型”，第 194 页

“使用用户定义的数据码型”，第 195 页

“使用外部提供的数据码型”，第 198 页

Data (数据)菜单可以选择预先定义的和用户定义的数据码型。数据码型用来传送连续的未成帧的数

据流。在Custom Off On软键启动(on)时，实时定制 I/Q码构建器根据已经选择的数据码型和调制类型创

建 I/Q 码。选择调制类型的详情请参阅第 180 页“处理调制类型”。

提供的数据码型如下：

PN sequence (PN 序列)允许进入一个菜单(PN9, PN11, PN15, PN20, PN23)，在内部生成伪随机序列的

数据(伪随机噪声序列)；伪随机噪声序列是一个周期二进制序列，在某种意义上来说，它近似于 Ber-

noulli“掷硬币”的流程，具有等概率的结果。

FIX4 0000 允许定义一个 4 位重复序列数据码型，使其成为激活的功能。选择的 4 位码型将进行必要

的重复，提供连续的数据流。

Other Patterns (其它码型)允许进入一个选项菜单(4 1's & 4 0's, 8 1's & 8 0's, 16 1's & 16 0's, 32 1's & 32 0's,

或 64 1's & 64 0's)，用户可以从中选择数据码型。每个码型都包含数量相等的 1 和 0。选择的码型将

进行必要的重复，提供连续的数据流。

User File (用户文件)允许进入一个选项菜单，可以从中创建一个文件，并把这个文件存储到 Catalog

of Bit Files (位文件目录)中，从位文件目录中选择和使用文件，或从位文件目录中选择、编辑、然后

重新保存文件。

Ext 可以通过 DATA端口把数据码型实时输送到 I/Q 码构建器中。
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使用预先定义的数据码型

选择预先定义的 PN 序列数据码型

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Data > PN Sequence。

3. 按下面其中一个键：PN9, PN11, PN15, PN20, PN23。

选择预先定义的固定 4 位数据码型

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Data > FIX4。

3. 按 1010 > Enter > Return。

选择预先定义的包含数量相等的 1 和 0 的数据码型

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Data > Other Patterns。

3. 按下面其中一个键：

4 1's & 4 0's, 8 1's & 8 0's, 16 1's & 16 0's, 32 1's & 32 0's, 或 64 1's & 64 0's。
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使用用户定义的数据码型

可以使用信号源的位文件编辑器创建和修改用户文件(用户定义的数据码型文件)；也可以在远程计算

机上创建后，移植到信号源直接使用；还可以使用位文件编辑器修改这些远程创建的数据码型文件。如

需在远程计算机上创建用户定义的用户数据文件的相关信息，请参阅编程指南。

这些程序演示了怎样使用位文件编辑器创建、编辑和存储定制实时I/Q基带发生器调制内部使用的用

户定义的数据码型文件。在本例中，我们在定制数字通信内部定义了一个用户文件。

使用位文件编辑器创建数据码型用户文件

这一程序使用位文件编辑器，创建一个数据码型用户文件，并把得到的文件存储在内存目录中(参阅

第 59 页介绍)。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Data > User File > Create File。

打开位文件编辑器，其中包含三个栏，如下图所示。

注 在新建文件时，默认名称是 UNTITLED 或 UNTITLED1，依此类推。

这可以防止覆盖以前的文件。

偏置
(十六进制) 位数据

光标位置指示符
(十六进制) 十六进制数据 文件名称指标符
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3. 使用数字键盘 (不是软键)，输入所示的 32 位值。

位数据以 1 位格式输入到位文件编辑器中。Hex Data (十六进制数据)一栏显示了二进制数据的当前

十六进制值，Position indicator (位置指示符)显示了光标位置(十六进制)。

输入这些位值

光标位置

十六进制数据

4. 按More (1 of 2) > Rename > Editing Keys > Clear Text。

5. 使用 alpha 键和数字键盘输入文件名(例如 USER1)。

6. 按Enter。

用户文件应重命名，并以名称 USER1 存储到内存目录中。

从位文件目录中选择数据码型用户文件

在这一程序中，您将学习怎样从位文件目录中选择一个数据码型文件。如果您还没有创建和存储一

个用户定义的数据文件，应先完成上一节中的步骤，请参阅第 195 页“使用位文件编辑器创建数据码型

用户文件”。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Data > User File。

3. 高亮度显示要选择的文件(例如：USER1)。

4. 按Edit File。

位文件编辑器应打开选择的文件(例如：USER1)。
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修改现有的数据码型用户文件

在本例中，您将学习怎样浏览到某个位位置、并改变其取值，来修改现有的数据码型用户文件。然

后，您将学习怎样颠倒现有数据码型用户文件的位值。

如果您还没有创建、存储和调用数据码型用户文件，应先完成前面几节中的步骤，请参阅第 195 页

“使用位文件编辑器创建数据码型用户文件”和第 196 页“从位文件目录中选择数据码型用户文件”。

浏览现有的数据码型用户文件的位值

1. 按Goto > 4 > C > Enter。

把光标移到表格中 4C 位的位置，如下图所示。

光标移动到新的位置 位置指示符变化



198 第 7章

定制实时 I/Q 基带

处理数据码型

颠倒现有数据码型用户文件的位置

1. 在键盘上按 1011。

颠倒位于 4C 到 4F 的位值。注意这一行中的十六进制数据现在变成了 76DB6DB6，如下图所示。

在现有的数据码型用户文件增加误码

本例演示了怎样在现有的数据码型用户文件增加误码。如果您还没有创建和存储一个用户定义的数

据文件，应先完成上一节中的步骤，请参阅第 195 页“使用位文件编辑器创建数据码型用户文件”。

1. 按Apply Bit Errors。

2. 按Bit Errors > 5 > Enter。

3. 按Apply Bit Errors。

注意两个Bit Errors 软键都会改变取值，因为它们是相互关联的。

使用外部提供的数据码型

这一程序通过 DATA、DATA CLOCK 和 SYMBOL SYNC 连接器提供了实时数据码型。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Data > Ext。

3. 把实时数据连接到 DATA 输入上。

4. 把数据时钟触发信号连接到 DATA CLOCK 输入上。

5. 把码同步触发器连接到 SYMBOL SYNC 输入上。

4C到 4F 位颠倒 十六进制数据变化
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处理突发形状

“配置突发上升和下降参数”，第 200 页

“使用用户定义的突发形状曲线”，第 201 页

Burst Shape (突发形状)菜单可以修改上升时间和下降时间、上升和下降时延及突发形状 (正弦或定

义的用户文件)。此外，可以定义突发形状，通过上升形状编辑器预览突发形状，或把所有突发形状参数

恢复到原始默认状态。

Rise time (上升时间) 突发从最小-70 dB (0)提高到全部功率 (1)的时间周期，用位指定。

Fall time (下降时间) 突发从全部功率 (1)下降到最小-70 dB (0)的时间周期，用位指定。

Rise delay (上升时延) 突发上升开始延迟的时间周期，用位指定。上升延迟可以为正，

也可以为负。输入零之外的时延将把全部功率点移动到早于或迟

于第一个有用码的开始处。

Fall delay (下降时延) 突发下降开始延迟的时间周期，用位指定。下降延迟可以为正，

也可以为负。输入零之外的时延将把全部功率点移动到早于或迟

于第一个有用码的结束处。

User-defined burst shape 最多 256个用户输入的值，定义指定上升时间或下降时间中的曲

(用户定义的突发形状) 线形状。这些值可以在0 (无功率)和1 (全部功率)之间变化，并线

性缩放。一旦指定，这些值将进行必要的二次取样，以创建穿过

所有样点的立方样条。

每种格式的默认突发形状根据选择的格式标准实现。但是，您可以修改突发形状的下述方面：

用户定义的值

功
率 上升

时延
上升
时间

下降
时延

下降
时间

时间

用户定义的值

1

0



200 第 7章

定制实时 I/Q 基带

处理突发形状

下述因素影响着突发形状的最大上升时间和下降时间值：

码速率

调制类型

在上升时延和下降时延等于 0时，突发形状会试图把最大突发形状功率与第一个有效码的开始处及

最后一个有效码的结束处同步。

如果在启动突发时发现误差矢量幅度(EVM)或邻道功率(ACP)提高，您可以调节突发形状，协助诊断

问题。

配置突发上升和下降参数

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Burst Shape。

3. 按Rise Time > 5 > bits。

4. 按Rise Delay > 1 > bits。

5. 按 Fall Time > 5 > bits。

6. 按 Fall Delay > 1 > bits。

配置实时 I/Q基带数字调制格式的突发形状。如需创建和使用用户定义的突发形状曲线的相关说明，

请参阅第 201 页“创建和存储用户定义的突发形状曲线”。
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使用用户定义的突发形状曲线

可以使用上升形状和下降形状编辑器，调节上升时间曲线和下降时间曲线的形状。每个编辑器都可

以输入最多 256个时间等距的值，定义一个曲线形状。然后对这些值二次取样，创建穿过所有样点的立

方样条。

上升曲线和下降曲线编辑器适用于定制实时I/Q基带发生器波形，而不适用于双任意波形发生器生成

的波形。

还可以在外部设计突发形状文件，然后把数据下载到信号源中。如需更多信息，请参阅编程指南。

创建和存储用户定义的突发形状曲线

在下面的程序中，您将学习怎样输入上升形状样点值，把它们镜像为下降形状值，创建对称的突发

曲线。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Burst Shape。

3. 按Define User Burst Shape > More (1 of 2) > Delete All Rows > Confirm Delete Of All Rows。

4. 输入与下表中的样点值类似的值：

a. 高亮度显示样点 1 的取值(1.000000)。

b. 按.4 > Enter。

c. 按.6 > Enter。

d. 从上表中对样点 3 到样点 9 输入其余值。

e. 按 More (2 of 2) > Edit Fall Shape > Load Mirror Image of Rise Shape >

Confirm Load Mirror Image of Rise Shape。

把下降形状值变成上升形状值的镜像。

上升形状编辑器

样点 取值 样点 取值

0 0.000000 5 0.900000

1 0.400000 6 0.950000

2 0.600000 7 0.980000

3 0.750000 8 0.990000

4 0.830000 9 1.000000
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图 7-1

5. 按More (1 of 2) > Display Burst Shape。

显示波形上升和下降特点的图形表示。

图 7-2

注 如需把突发形状返回默认条件，按

Return > Return > Confirm Exit From Table Without Saving > Restore Default Burst Shape。

6. 按Return > Load/Store > Store To File。

如果形状文件目录中已有一个文件名占用活动输入区域，按下面的键：Editing Keys > Clear Text。
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7. 使用 alpha 键和数字键盘输入一个文件名(例如：NEWBURST)。

8. 按Enter。

当前上升形状和下降形状编辑器的内容存储到形状文件目录中。现在可以使用这个突发形状定制调

制，或作为新突发形状设计的依据。

从内存目录中选择和调用用户定义的突发形状

一旦用户定义的突发形状文件存储在内存目录中，可以调用这个文件，与实时I/Q基带生成的数字调

制一起使用。

本例要求内存中已经存储了一个用户定义的突发形状文件。如果还没有创建和存储用户定义的突发

形状文件，应先完成前面几节中的步骤。

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Burst Shape > Burst Shape Type > User File。

3. 高亮度显示希望的突发形状文件(例如：NEWBURST)。

4. 按Select File。

选择的突发形状文件现在应用到当前实时 I/Q 基带数字调制状态中。

5. 按Return > Custom Off On。

使用前面创建的用户定义的突发形状生成定制调制。在波形生成期间，CUSTOM 报警器和 I/Q 报警

器激活。波形现在调制 RF 载波。

6. 按RF On/Off。

信号源的 RF OUTPUT 连接器上应提供具有用户定义的突发形状的当前实时 I/Q 基带数字调制

格式。
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配置硬件

“设置 BBG 参考”，第 204 页

“设置外部 DATA CLOCK 作为正常输入或码输入接收输入”，第 205 页

“把 BBG DATA CLOCK 设成 External 或 Internal”，第 205 页

“调节 I/Q 标度”，第 205 页

设置 BBG 参考频率

设置外部参考频率或内部参考频率

1. 按Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware。

Configure Hardware (配置硬件)会显示一个菜单，您可以使用这个菜单把 BBG 参考频率设成外部参

考频率或内部参考频率。

2. 按BBG Ref Ext Int，选择外部或内部作为数据发生器的位时钟参考。

如果选择了外部，对后面板 BASEBAND GEN REF IN 连接器应用参考频率。

设置外部频率

只有在BBG Ref Ext Int 软键已经设成 Ext (外部)时，才能使用 BBG 参考外部频率。

1. 按Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware。

Configure Hardware (配置硬件)会显示一个菜单，您可以使用这个菜单设置外部 BBG 参考频率。

2. 按Ext BBG Ref Freq。

3. 使用数字键盘，输入希望的频率，然后按MHz, kHz, 或Hz。
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设置外部 DATA CLOCK 作为正常输入或码输入接收输入

1. 按Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware。

Configure Hardware (配置硬件)可以进入一个菜单，您可以使用这个菜单，把外部 DATA CLOCK 设

置成作为正常输入或码输入接收输入。

2. 按Ext Data Clock，选择 Normal (正常)或 Symbol (码)，这一设置对内部时钟模式没有影响。

在设为 Normal 时，DATA CLOCK 输入连接器要求一个位时钟。

在设为 Symbol 时，必须为 SYMBOL SYNC 输入连接器提供一个单次或连续码同步信号。

把 BBG DATA CLOCK 设成 External或 Internal

1. 按Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware。

Configure Hardware (配置硬件)可以进入一个菜单，您可以使用这个菜单，把BBG DATA CLOCK设

为从外部或内部接收输入。

2. 按BBG Data Clock Ext Int，选择外部或内部输入。

在设为 Ext (外部)时，DATA CLOCK 连接器用来提供 BBG 数据时钟。

在设为 Int (内部)时，使用内部数据时钟。

调节 I/Q 标度

调节 I/Q标度(I/Q输出的幅度)将把 I数据和Q数据乘以选择的 I/Q标度系数，可以用来改善邻道功率

(ACP)。标度值越低，ACP 越好。这一设置对 MSK 或 FSK 调制没有影响。

1. 按Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Configure Hardware。

Configure Hardware (配置硬件)可以进入一个菜单，您可以使用这个菜单，调节 I/Q 标度。

2. 按 I/Q Scaling，输入希望的 I/Q 标度电平，按 %。
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处理相位极性

把相位极性设为正常或反相

1. 按Mode > Custom > Real Time I/Q Baseband > More (1 of 3) > Phase Polarity Normal Invert。

Phase Polarity Normal Invert可以使选择保持为Normal (这样相位极性功能不会改变 I信号和Q信号之

间的相位关系)，也可以设为 Invert，反转内部 Q 信号，反转相位调制矢量的旋转方向。

在选择Invert时，同相成分会在得到的调制中滞后正交相位成分90°。某些无线电标准要求反转的相

位极性，其适用于较低的边带混合应用。反转选择还适用于 I输出信号、I-bar输出信号、Q输出信号

和 Q-bar 输出信号。
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处理差分数据编码

Diff Data Encode Off On 菜单可以拨动信号源差分数据编码的操作状态。

在设为 Off 时，数据位在调制前不编码。

在设为 On 时，数据位在调制前编码。差分编码采用独有的 OR 功能，生成调制位。如果数据位与前

一个位不同，调制位的取值是 1；如果数据位与前一个位相同，其取值为 0。

本节介绍了下述信息：

“了解差分编码”

“使用差分编码”，第 212 页

了解差分编码

差分编码是一种数字编码技术，其中二进制值使用信号变化表示，而不是使用某种信号状态表示。通

过使用差分编码，在调制过程中，可以通过差分状态映射中定义的码表偏置对任何用户定义的I/Q或FSK

调制中的二进制数据编码。

例如，我们考察一下信号源默认的4QAM I/Q调制。在基于默认4QAM模板的用户定义的调制中，I/

Q 值编辑器包含的数据表示四个码(00, 01, 10, 和 11)，其使用两个不同的值(1.000000 和 -1.000000)映射

到 I/Q层中。通过分配与每个数据值相关的码表偏置值，可以在调制过程中以差分方式对这四个码编码。

第 208 页上的图 7-3 显示了 I/Q 值编辑器中的 4QAM 调制。
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图 7-3

注 可以使用下述公式表示每个码的位数。由于这个公式是一个天棚函数，如果x取值中包含一个

分数，x 将舍入到下一个整数。

其中：x = 每个码的位数，y = 差分状态数。

下图是 4QAM 调制 I/Q 状态映射图。

第 1 个码
数据 = 00000000
不同的值: +1, +1

第 2 个码
数据 = 00000001
不同的值: -1, +1

第 3 个码
数据 = 00000010
不同的值: -1, -1

第 4 个码
数据 = 00000011
不同的值: +1, -1

x =   Log
2
(y)√
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差分数据编码

在实时 I/Q 基带信号调制波形中，数据(1's 和 0's)被编码，调制到载频中，然后传送到接收机上。与

差分编码相比，差分数据编码在 I/Q映射前改变数据流。差分数据编码通过使用码表偏置值，在调制点上

处理 I/Q 映射，来对原始数据编码，而差分数据编码则采用位值之间的转换来对原始数据编码。

差分数据编码通过创建辅助的编码数据流改变原始数字化数据，这条数据流使用原始数据流从 1到

0 或从 0 到 1 的数字状态变化定义。然后将调制和传送这条差分编码的数据流。

在差分数据编码中，原始数据位的数字状态变化(从 1到 0或从 0到 1)在编码的数据流中生成一个 1。

在不同位之间的数字状态没有变化，换句话说，取值为 1 的位后面跟着另一个取值为 1 的位，或取值为

0的位后面跟着另一个取值为0的位，这会在编码的数据中生成一个0。例如，对包含01010011001010的

数据流进行差分编码会得到 1111010101111。

差分数据编码可以用下述公式描述：

transmittedbit (i) = databit (I-1) + databit (i)

为逐位表示编码流程，参见下面的示意图：

差分编码的工作方式

差分编码在码表中采用偏置，对用户定义的调制方案编码。差分状态映射图编辑器用来引入码表偏

置值，其根据相关数据值导致 I/Q状态映射转换。在调制数据值时，通过根据码表偏置值定义的方向和距

离转换通过 I/Q 状态映射图，存储在差分状态映射图中的偏置值用来对数据编码。

原始(未编码)数据

变化

没有变化

差分编码的数据
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输入+1值导致1状态向前转换通过 I/Q状态映射图。例如，考虑一下下面的数据 /码表偏置值。这些

码表偏置得到下面所示的一个转换。

注 下面的 I/Q状态映射示意图显示了采用特定码表偏置值的所有可能转换。实际状态间转换取决

于调制开始的状态。

实例 数据 偏置值

1 00000000 +1

2 00000001 -1

3 00000010 +2

4 00000011 0

实例 1
转换 1 状态向前

实例 2
转换 1状态向后

实例 3
转换 2 状态向前

实例 4
没有转换
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在增加到用户定义的默认4QAM I/Q映射图时，从第一个码(数据00)开始，数据流(2位码) 0011100001

的差分编码转换出现在前面的示意图中。

可以看到，第 1个码和第 4个码具有相同的数据值(00)，产生相同的状态转换(向前 1状态)。在差分

编码中，码值没有规定位置，而是规定了通过 I/Q 状态映射图转换的方向和距离。

如需配置差分编码的说明，请参阅第 207 页“了解差分编码”。
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使用差分编码

差分编码是一种数字编码技术，它通过信号转换、而不是某种信号状态来表示二进制值。它适用于

定制实时 I/Q 基带模式，不适用于任意波形发生器模式生成的波形。

信号源的差分状态映射图编辑器可以修改与用户定义的 I/Q和用户定义的 FSK调制有关的差分状态

映射图。在这一程序中，您将创建用户定义的 I/Q调制，然后对用户定义的调制配置、激活和应用差分编

码。如需更多信息，请参阅第 207 页“了解差分编码”。

本节包括下述信息：

“配置用户定义的 I/Q 调制”

“使用差分状态映射图编辑器”，第 213 页

“编辑差分状态映射图”，第 213 页

配置用户定义的 I/Q 调制

1. 按Preset。

2. 按Mode > Custom > Real Time I/Q Baseband > Modulation Type > Define User I/Q > More (1 of 2) >

Load Default I/Q Map > QAM > 4QAM。

加载默认的 4QAM I/Q 调制，并在 I/Q 值编辑器显示。默认的 4QAM I/Q 调制包含的数据表示四个

码 (00, 01, 10, 和11)，其使用两个不同的值(1.000000和 -1.000000)映射到 I/Q层中。通过分配与每个数据

值相关的码表偏置值，可以在调制过程中传送这四个码。
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使用差分状态映射图编辑器

按Configure Differential Encoding。

打开差分状态映射图编辑器。这时可以看到第1个码的数据(00000000)及光标准备接收偏置值。现在

准备为用户定义的默认的 4QAM I/Q 调制创建定制的差分编码。

编辑差分状态映射图

1. 按 1 > Enter。

通过增加码表偏置 1，对第一个码编码。在调制数据值 0 时，码向前旋转 1 个值通过状态映射图。

2. 按 +/- > 1 > Enter。

通过增加码表偏置 -1，对第二个码编码。在调制数据值 1，码向回旋转 1 个值通过状态映射图。

注 这时，调制每个码有一个位。对前两个数据值(00000000和 00000001)，只有最后的位(分别是0

和 1)才有效。

3. 按 2 > Enter。

通过增加码表偏置 2，对第二个码编码。在调制数据值 10 时，向前旋转 2 个值通过状态映射图。

数据 码表偏置值输入区域
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4. 按 0 > Enter。

通过增加码表偏置 0，对第四个码编码。在调制数据值 11 时，码不会旋转通过状态映射图。

注 这时，调制每个码有两个位。对数据值 00000000, 00000001, 00000010, 00000011，

码值分别是 00, 01, 10, 和 11。

5. 按Return > Differential Encoding Off On。

对用户定义的调制应用定制差分编码。

注 注意在信号源显示屏上，在 Differential State Map (差分状态映射图)旁边出现 (UNSTORED)。

差分状态映射图与用户定义的为其创建的调制有关。

为保存定制差分状态映射图，必须存储为其设计的用户定义的调制。否则，在从 I/O或FSK编

辑器中退出时，按Confirm Exit From Table Without Saving 软键，会清除码表偏置数据。
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在下面几节中，本章将介绍定制任意波形发生器模式，只有配备选项 601 或 602 的 E8267D PSG 矢

量信号源才提供了这种模式。

“概述”，第 216 页

“创建、查看和优化多音波形”，第 217 页

另请参阅：“基本数字操作”，第 77 页

8   多音波形发生器
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概述

多音模式可以构建带有最多 64个 CW 连续波信号的波形。通过使用多音设置表编辑器，可以定义、

修改和存储播放的波形。多音波形通过内部 I/Q 基带发生器生成。

多音波形发生器一般用来测试多通道器件的互调失真特点，如混频器或放大器。在具有多个输入频

率的非线性器件在其它频率导致不想要的输出，或干扰相邻通道时，会发生互调失真(IMD)。多音波形发

生器提供了具有用户指定音调数的波形，可以使用频谱分析仪测量其 IMD产物，在测量被测器件生成的

IMD 时作为参考标准使用。

多音波形使用内部 I/Q基带发生器创建，存储在ARB内存中，以备播放。尽管多音模式生成了优质

波形，但仍会发生少量的 IMD、载波馈通和馈通相关 IMD。在生成偶数的音调时，可以观察载波馈通，

因为在中心载频上没有任何音调屏蔽馈通。为使偶数多音信号的载波馈通达到最小，必需手动调节I和Q

偏置，同时使用频谱分析仪观察中心载频。

对要求64个以上的音调或没有 IMD和载波馈通的测量，可以使用安捷伦Signal Studio软件选项 408

创建最多 1024 个无失真的多音信号。

注 如需与多音波形特点和 PSG 矢量信号源多音格式有关的更多信息，从我们的网站上下载应

用指南 1410，网址：http://www.agilent.com，在 Test & Measurement 中搜索 "AN 1410"。
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创建、查看和优化多音波形

本节介绍了怎样设置、生成和优化多音波形，同时使用频谱分析仪观察波形。尽管可以使用具有足

够频率范围的任意频谱分析仪查看生成的多音信号，但本演示中使用的是安捷伦PSA高性能频谱分析仪。

在生成信号前，先把频谱分析仪连接到信号源，如图 8-1 所示。

图 8-1 频谱分析仪设置

创建定制多音波形

通过使用多音设置表格编辑器，可以定义、修改和存储用户定义的多音波形。多音波形通过双任意

波形发生器生成。

1. 预置信号源。

2. 把信号源的 RF 输出频率设为 20 GHz。

3. 把信号源的 RF 输出幅度设为 0 dBm。

4. 按Mode > Multitone > Initialize Table > Number of Tones > 9 > Enter。

5. 按 Freq Spacing > 1 > MHz。

6. 按 Initialize Phase Fixed Random 直到 Random。

7. 按Done。

8. 按Multitone Off On 直到 On。

9. 打开 RF 输出。
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应在信号源RF OUTPUT连接器上提供多音信号。图8-2说明了在完成所有步骤后信号源显示屏的显

示画面。注意对信号源显示屏状态区域中显示的信号，会显示 M-TONE, I/Q, RF ON, 和 MOD ON 报警

器。多音波形存储在易失性 ARB 内存中。

波形具有 9 个音调，其间相距 1 MHz，初始相位值是随机的。中心音调放在载频上，另外 8 个音调

间隔以 1 MHz 从中心音调递增。如果创建偶数个音调，载频中心将位于两个中间音调之间。

图 8-2

查看多音波形

这一程序介绍了怎样配置频谱分析仪，查看多音波形及其 IMD产物。实际按键根据使用的频谱分析

仪型号而有所不同。

1. 预置频谱分析仪。

2. 把载频设为 20 GHz。

3. 把频率跨度设为 20 MHz。

4. 使用 4 dBm 参考设置 10 dB 标度的幅度。

5. 调节分辨率带宽，以充分降低本底噪声，揭示 IMD 产物。我们的实例中使用 9.1 kHz 设置。

6. 打开峰值检波器。
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7. 把衰减设为 14 dB，所以没有过速驱动频谱分析仪上的输入混频器。

现在应该看到一个波形，它具有9个音调，中心载频是20 GHz，其显示画面与图 8-3所示画面类似。

另外您还将看到最高音调和最低音调上面和下面 1 MHz 的 IMD 产物。

图 8-3

编辑多音设置表

这一程序基于以前的程序。

1. 按 Initialize Table > Number of Tones > 10 > Enter。

2. 按Done。

3. 对第 2 行中的音调，高亮度显示 State 一栏中的值(On)。

4. 按 Toggle State。

5. 对第 4 行中的音调，高亮度显示 Power 一栏中的值(0 dB)。

多音通道

互调失真
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6. 按 Edit Item > -10 > dB。

7. 对第 4 行中的音调，高亮度显示 Phase 一栏中的值(0)。

8. 按 Edit Item > 123 > deg。

9. 按 Apply Multitone。

注 在多音生成器工作时(Multitone Off On 设为 On)，当用户改变设置时，必须按 Apply Multitone

软键应用变化之后，才能生成更新的波形。在应用变化时，基带信号源会使用新的设置创

建多音波形，并替换 ARB 内存中已有的波形。

现在已经把音调数量变成10，禁止音调2，并改变了音调4的功率和相位。图 8-4显示了在完成了所

有步骤后，信号源上的多音设置表画面的显示结果。频谱分析仪显示的波形与第221页图8-5所示的波形

类似。注意偶数多音波形在中心载频上具有少量的载波馈通。

图 8-4
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图 8-5

使载波馈通达到最小

这一程序介绍了怎样使载波馈通达到最小，及测量音调及其互调失真产物之间的功率差。只有偶数

的多音波形中才能观察载波馈通。

这一程序基于以前的程序。

1. 在频谱分析仪上，为大约 100-200 ms的扫描速率设置分辨率带宽，在调节时可以动态查看载波馈通

峰值。

2. 在信号源上，按 I/Q > I/Q Adjustments > I/Q Adjustments Off On 直到 On。

3. 按 I Offset，旋转旋钮，同时使用频谱分析仪观察载波馈通。在正确方向上改变 I 偏置将降低馈通电

平。把电平调节得尽可能低。

音调 10

互调失真

载波馈通

载波馈通失真

音调 1
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4. 按Q Offset，拧旋转旋钮，进一步降低载波馈通电平。

5. 重复第 3 步和第 4 步，直到到达最低的载波馈通电平。

6. 在频谱分析仪上，把分辨率带宽返回到以前的设置。

7. 启动波形平均功能。

8. 创建一个标尺，把它放在其中一个末尾音调的峰值上。

9. 创建一个增量标尺，把它放在相邻互调产物上，其距标记的音调的间隔应该是 10 MHz。

10. 测量音调及其失真产物之间的功率差。

现在应该看到类似于图 8-6 所示的显示画面。现在可以使用优化的多音信号，测量被测器件生成的

IMD 产物。

注意载波馈通随时间和温度变化。因此，您需要定期重新调节 I 和 Q 偏置，以一直优化信号。

图 8-6

音调 10

互调失真

最小化的

载波馈通

载波馈通失真

音调 1
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确定峰值均值比特点

这一程序介绍了怎样通过绘制互补累积分布函数(CCDF)图，设置多音波形中音调的相位，确定峰值

均值比特点。

1. 按Mode > Multitone > Initialize Table > Number of Tones > 64 > Enter。

2. 按 Freq Spacing > 20 > kHz。

3. 按 Initialize Phase Fixed Random 直到 Fixed。

4. 按Done。

5. 按Apply Multitone。

6. 按More (1 of 2) > ARB Setup > Waveform Utilities > Waveform Statistics > Plot CCDF。

现在应该看到一个类似于图8-7所示的显示画面。CCDF图显示了所有相位设为零的波形的峰值均值

比特点。

图 8-7 设定固定相位的 CCDF 图

7. 按Mode Setup > Initialize Table。

8. 按 Initialize Phase Fixed Random 直到 Random。

9. 按Random Seed Fixed Random 直到 Random。

峰值功率
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10. 按Done。

11. 按Apply Multitone。

12. 按More (1 of 2) > Waveform Statistics > Plot CCDF。

现在应看到与图8-8所示画面类似的显示画面。CCDF图显示了具有随机生成的相位和随机籽的波形

的峰值均值比特点。

随机相位设置模拟多音波形的典型随机特点。注意随机分布的相位导致峰值均值比要比固定相位低得

多。随机相位的音调数量提高，将降低发生最大峰值功率的概率。

图 8-8 设置随机相位的 CCDF 图

峰值功率
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在下面几节中，本章介绍了双音模式，只有配备选项 601 或 602 的 E8267D PSG 矢量信号源中才提

供了这种模式。

“概述”，第 226 页

“创建、查看和修改双音波形”，第 227 页

另请参阅：“任意(ARB)波形文件标题”，第 80 页

9   双音波形发生器
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概述

概述

双音模式构建的波形具有两个等功率的CW连续波信号或音调。默认波形有两个音调，其跨中心载

频的间隔是对称的，并具有用户定义的幅度、载频和频率隔离设置。用户还可以相对于载频左对齐或右

对齐音调。

双音波形发生器是为测试非线性器件的互调失真特点而设计的，如混频器或放大器。在具有多个输

入频率的非线性器件干扰相邻通道或在其它频率上导致不想要的输出时，会发生互调失真(IMD)。双音波

形发生器提供了一个信号，可以使用频谱分析仪测量其IMD产物，在测量被测器件生成的 IMD时作为参

考标准使用。

双音波形使用内部 I/Q基带发生器创建，存储在ARB内存中，以备播放。尽管双音模式生成了优质

波形，但仍会发生少量的 IMD。除 IMD外，在音调之间的间隔位于载频频率中心时，可能会有少量的载

波馈通和馈通相关 IMD。为使双音信号的载波馈通达到最小，必需手动调节 I和 Q偏置，同时使用频谱

分析仪观察中心载频。对要求没有 IMD 和载波馈通的测量，可以使用安捷伦 Signal Studio软件选项 408

创建无失真的双音信号。

注 如需与双音波形特点和 PSG 矢量信号源双音格式有关的更多信息，从我们的网站上下载

应用指南 1410，网址：http://www.agilent.com，在 Test & Measurement 中搜索 "AN 1410"。
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创建、查看和修改双音波形

本节介绍了怎样设置、生成和优化双音波形，同时使用频谱分析仪观察波形。尽管可以使用具有足

够频率范围的任意频谱分析仪查看生成的双音信号，但本演示中使用的是安捷伦PSA高性能频谱分析仪。

在生成信号前，先把频谱分析仪连接到信号源，如图 9-1 所示。

图 9-1 频谱分析仪设置

创建双音波形

这一程序介绍了怎样创建基本居中的双音波形。

1. 预置信号源。

2. 把信号源的 RF 输出频率设为 20 GHz。

3. 把信号源的 RF 输出幅度设为 0 dBm。

4. 按Mode > Two Tone > Freq Separation > 10 > MHz。

5. 按 Two Tone Off On 直到 On。

6. 打开 RF 输出。

应在信号源RF OUTPUT连接器上提供双音信号。第228页图9-2说明了在完成所有步骤后信号源显

示屏的显示画面。注意对信号源显示屏状态区域中显示的信号，会显示 T-TONE, I/Q, RF ON, 和 MOD

ON 报警器。

波形具有 9 个音调，其间相距 1 MHz，初始相位值是随机的。中心音调放在载频上，另外 8 个音调

间隔以 1 MHz 从中心音调递增。如果创建偶数个音调，载频中心将位于两个中间音调之间。
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图 9-2

查看双音波形

这一程序介绍了怎样配置频谱分析仪，查看双音波形及其 IMD产物。实际按键根据使用的频谱分析

仪型号而有所不同。

1. 预置频谱分析仪。

2. 把载频设为 20 GHz。

3. 把频率跨度设为 60 MHz。

4. 使用 4 dBm 参考设置 10 dB 标度的幅度。

5. 调节分辨率带宽，以充分降低本底噪声，揭示 IMD 产物。我们的实例中使用 9.1 kHz 设置。

6. 打开峰值检波器。

7. 把衰减设为 14 dB，所以没有过速驱动频谱分析仪上的输入混频器。

现在应该看到一个双音波形，中心载频是 20 GHz，其显示画面与第 229页图 9-3 所示画面类似。另

外您还将看到生成的音调上面和下面 10 MHz间隔上的 IMD产物，载频上的载波馈通在中心频率达到峰

值，载波馈通失真产物位于中心载频上面和下面 10 MHz 间隔上。
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图 9-3

双音通道

互调失真
载波馈通

 失真载波馈通
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使载波馈通达到最小

这一程序介绍了怎样使载波馈通达到最小，及测量音调及其互调失真产物之间的功率差。只有居中

的双音波形中才能观察载波馈通。

这一程序基于以前的程序。

1. 在频谱分析仪上，为大约 100-200 ms 的扫描速率设置分辨率带宽，在调节时可以动态查看载波馈通

峰值。

2. 在信号源上，按 I/Q > I/Q Adjustments > I/Q Adjustments Off On 直到 On。

3. 按 I Offset，旋转旋钮，同时使用频谱分析仪观察载波馈通。在正确方向上改变 I 偏置将降低馈通电

平。把电平调节得尽可能低。

4. 按Q Offset，拧旋转旋钮，进一步降低载波馈通电平。

5. 重复第 3 步和第 4 步，直到到达最低的载波馈通电平。

6. 在频谱分析仪上，把分辨率带宽返回到以前的设置。

7. 启动波形平均功能。

8. 创建一个标尺，把它放在其中一个末尾音调的峰值上。

9. 创建一个增量标尺，把它放在相邻互调产物上，其距标记的音调的间隔应该是 10 MHz。

10. 测量音调及其失真产物之间的功率差。

现在应该看到类似于第231页图9-4所示画面的显示画面。现在可以使用优化的双音信号，测量被测

器件生成的 IMD 产物。

注意载波馈通随时间和温度变化。因此，您需要定期重新调节 I 和 Q 偏置，以一直优化信号。
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图 9-4

主标尺

最小化的
载波馈通

增量标尺
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改变双音波形的对齐方式

这一程序介绍了怎样相对于中心载频把双音波形左对齐或右对齐。由于其中一个音调的频率与载频

相同，因此这种对齐方式消除了载波馈通。但是，左对齐或右对齐导致的映像频率干扰可能会导致双音

信号略微失真。这一程序基于以前的程序。

1. 在信号源上，按Mode Setup > Alignment Left Cent Right，直到 Left。

2. 按Apply Settings，再生波形。

注 在双音生成器工作时(Two Tone Off On设为On)，当用户改变设置时，必须按Apply Settings软

键应用变化之后，才能生成更新的波形。在应用变化时，基带信号源会使用新的设置创建

双音波形，并替换 ARB 内存中已有的波形。

3. 在频谱分析仪上，暂时关闭波形平均功能，以更快地刷新视图。

现在应该看到左对齐的双音波形，其显示结果与图 9-5 类似。

图 9-5

双音通道
与载频

对齐的
上方音调

互调失真

载频
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在下面几节中，本章介绍了怎样使用AWGN波形发生器，其只能用于配备选项601或602及选项403

的 E8267D 矢量 PSG 中。

“任意波形发生器 AWGN”，第 234 页

“实时 I/Q 基带 AWGN”，第 235 页

如需使用双ARB播放器在波形中增加实时AWGN，请参阅第95页“在双ARB波形中增加实时噪声”。

10   AWGN 波形发生器
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配置 AWGN 发生器

AWGN (附加白高斯噪声)生成器适用于任意波形发生器模式和实时 I/Q基带模式。AWGN发生器可

以配置用户定义的噪声带宽、噪声波形长度和噪声籽参数。

带宽 - 可以在 50 kHz - 15 MHz 范围内设置噪声带宽。

波形长度 - 波形长度是噪声波形的样点长度。波形长度越长，提供的噪声波形统计正确性越高。

噪声籽 - 噪声籽选择可以是随机的，也可以是固定的。噪声籽决定着噪声波形数据是可以重复的(使

用固定选择)还是随机的(使用随机选择)。

在 AWGN 发生器激活时，信号源前面板上会显示标为 AWGN 的报警器。

任意波形发生器 AWGN

1. 按Preset。

2. 按Mode > More (1 of 2) > AWGN > Arb Waveform Generator AWGN。

3. 按Bandwidth > 1.25 > MHz。

4. 按Waveform Length > 131072。

5. 按Noise Seed Fixed Random，直到 Random 高亮度显示。

配置 RF 输出

1. 把 RF 输出频率设为 500 MHz。

2. 把输出幅度设为 -10 dBm。

3. 按RF On/Off。

使用 1.25 MHz 的带宽和 131072 位的波形长度设置随机籽 AWGN 波形。

信号源的 RF OUTPUT 连接器上现在提供了 AWGN 波形。

生成波形

按AWGN Off On，直到 On 高亮度显示。

使用前面程序中定义的参数生成AWGN波形。在波形生成过程中，AWGN报警器和I/Q报警器激活，

AWGN 波形存储在易失性 ARB 内存中。波形现在调制 RF 载波。
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实时 I/Q 基带 AWGN

1. 按Preset。

2. 按Mode > More (1 of 2) > AWGN > Real Time I/Q Baseband AWGN。

3. 按Bandwidth > 10 > MHz。

配置 RF输出

1. 把 RF 输出频率设为 500 MHz。

2. 把输出幅度设为 -10 dBm。

3. 按RF On/Off。

信号源的 RF OUTPUT 连接器上现在提供了 AWGN 波形。

生成波形

按AWGN Off On，直到 On 高亮度显示。

使用前面程序中定义的参数生成AWGN波形。在波形生成过程中，AWGN报警器和I/Q报警器激活，

AWGN 波形存储在易失性 ARB 内存中。波形现在调制 RF 载波。
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本章提供了与PSG信号源使用的外设有关的信息。下面几节中介绍了N5102A Baseband Studio数字

信号接口模块和扩展频率信号源模块的操作和功能。

N5102A 数字信号接口模块

“时钟定时”，第 238 页

“连接时钟源和被测器件”，第 250 页

“数据类型”，第 252 页

“以输出模式操作 N5102A 模块”，第 253 页

“以输入模式操作 N5102A 模块”，第 262 页

毫米波信号源模块

“使用安捷伦毫米波信号源模块”，第 272 页

“使用其它信号源模块，第 275 页

11   外围设备
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N5102A 数字信号接口模块

时钟定时

本节介绍了怎样为数字数据提供时钟输入。我们为不同的端口配置(串口、并口或并行隔行扫描数据

传输)提供了时钟定时信息和示意图。信号源用户界面(UI)上提供了所有接口模块的设置。

时钟和取样速率

样点是一组位，其中使用 Word Size 软键设置样点的大小。时钟是告诉样点的位什么时候有效的信

号(在非转换状态下)。时钟和取样速率在第一级菜单和数据设置软键菜单中显示。时钟速率和取样速率通

常相同。在选择串行模式时，或在每个样点有多个时钟时，时钟速率和取样速率会有所不同。

图 11-1 并口配置的数据设置菜单

N5102A 模块时钟速率使用 Clock Rate 软键设置，范围在 1 kHz - 400 MHz 之间。取样速率自动计

算，范围在 1 kHz - 100 MHz 之间。根据逻辑类型、数据参数和时钟配置，这些可能会更小。

详情请参阅 PSG 用户指南

有效性最差的位 有效性最强的位 时钟和取样速率
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最大时钟速率

N5102A模块的最大时钟速率取决于逻辑和信号类型。表 11-1和表 11-2说明了各种逻辑和信号类型

的保证速率和最大时钟速率。注意，使用 IF信号输出模式下的LVDS是使保证速率和最大速率相同的唯

一逻辑类型。

表 11-1 保证并行输出水平的时钟速率和最大时钟速率

逻辑类型
保证水平的时钟速率 最大时钟速率(典型值)

IQ 信号类型 IF 信号类型 1 IQ 信号类型 IF信号类型

LVTTL 和 CMOS 100 MHz 100 MHz 150 MHz 150 MHz

LVDS 200 MHz 400 MHz 400 MHz 400 MHz

1. IF 信号类型不适用于串口配置。

表 11-2 保证并行输入水平的时钟速率和最大时钟速率

逻辑类型 保证水平的时钟速率 最大时钟速率(典型值)

LVTTL 和 CMOS 100 MHz 100 MHz

LVDS 100 MHz 400 MHz

在超过保证的电平时钟速率时，额定电平会下降，但仍可以使用。

串口配置的时钟速率

对串口配置，时钟速率下限取决于字长度(字长度和样点长度是同义词)，最大时钟速率极限在 150

MHz 上对 LVTTL 和 CMOS 逻辑类型保持不变，在 400 MHz 上对 LVDS 逻辑类型保持不变。

取样速率则相反。1 kHz的样点(字)速率下限值保持不变，取样速率的上限则随着字长度变化。例如，

LVTTL 或 CMOS 逻辑类型的 5 位样点在串行模式下会产生下述值：

5 kHz - 150 MHz 的时钟速率

1 kHz - 30 MHz 的取样速率
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串行时钟速率请参阅表 11-3 和表 11-4。

表 11-3 输出串行时钟速率

逻辑类型 最小速率 最大速率

LVDS 1 x (字长度) kHz 400 MHz

LVTTL 和 CMOS 1 x (字长度) kHz 150 MHz

表 11-4 输入串行时钟速率

逻辑类型 数据类型 最小速率 最大速率

LVDS 样点 1 x (字长度) kHz 400

FIR 前取样 1 x (字长度) kHz 以小者为准: 501 x (字长度) MHz

或 400 MHz

LVTTL 和 CMOS 无 1 x (字长度) kHz 150 MHz

1. 在数据速率为 FIR 前取样时，最大取样速率取决于选择的滤波器。如需更多信息，请参阅第 252 页“输入模式”。

并口配置和并行隔行扫描端口配置的时钟速率

并口配置和并行隔行扫描端口配置对时钟速率和取样速率有其它限制因素：

逻辑类型

每个样点选择的时钟数量

IQ 或 IF 数字信号类型

每个样点的时钟数量(时钟数 /样点)是时钟速率与取样速率之比。对 IQ信号类型，在取值大于 1时，

取样速率会下降，下降幅度为每个样点的时钟数量值。对 IF信号或输入信号，每个样点的时钟数量一直

设为 1。对输出模式并口和并行隔行扫描端口配置的时钟速率，请参阅表 11-5。
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表 11-5 输出并行和并行隔行扫描时钟速率

逻辑类型 信号类型 最小速率 最大速率

LVDS IQ 1 x (时钟数 /样点) kHz 以小者为准: 100 x (时钟数 / 样点) MHz

或 400 MHz

IF 4 kHz 400 MHz

其它 IQ 1 x (时钟数 /样点) kHz 以小者为准: 100 x (时钟数 / 样点) MHz

或 150 MHz

IF 4 kHz 150 MHz

对输入模式，最大时钟速率受到下述因素限制：

样点长度

数据类型

为 FIR 前取样选择的滤波器

对输入模式并口和并行隔行扫描端口配置的时钟速率，请参阅表 11-6。

表 11-6 输入并行和并行隔行扫描时钟速率

逻辑类型 信号类型 最小速率 最大速率

无 样点 1 kHz 100 MHz

FIR 前取样 1 kHz 501 MHz

1. 在数据速率是 FIR前取样时，最大取样速率取决于选择的滤波器。如需更多信息，请参阅第252 页“输入模式”。

时钟来源

N5102A 模块的时钟信号通过下述选择以三种方式之一提供：

Internal (内部):在接口模块内部生成(要求外部参考时钟)

External (外部):在外部通过 Ext Clock In 连接器生成

Device (器件):在外部通过 Device Interface 连接器生成
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时钟源使用信号源上的 N5102A 模块选择，如图 11-2 所示。

图 11-2 时钟源选择

选择内部时钟源：设置应用

的参考信号的频率

在选择时钟源时，必须使用Clock Rate 软键，让 N5102A 模块知道时钟信号的频率。在内部时钟源

模式下，使用这个软键设置内部时钟速率。对被测器件时钟源和外部时钟源，这个软键必须反映应用的

时钟信号的频率。

在时钟源是 Internal时，必须对 Freq Ref 连接器应用频率参考。必需使用Reference Frequency软键

指定应用的这个信号的频率，除非当前设置与应用的信号相符。

选择的时钟源在 Clock Out 和 Device Interface 连接器上提供了接口模块输出时钟信号。

公共频率参考

数字信号接口模块的时钟输入灵活性允许设置被测器件的任意时钟速率。一般来说，PSG内部的时

钟速率将不同于接口模块的时钟速率，因此接口模块要进行速率转换。这一转换的重要方面是获得精确

的时钟速率信息，避免丢失数据。模块依赖相对时钟精度，而不是绝对精度，必须对测试设置中涉及的

所有时钟速率使用单一频率参考保证相对时钟精度。这可以通过各种方式实现(参见第243页图11-3的五

个图)，但不管要用哪种实现方式，信号源内部的时钟频率参考必须与被测器件相同。

选择外部时钟源和器件时钟

源：设置成与应用的时钟信

号的时钟速率相匹配
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PSG 频率参考连接

在频率参考连接到 PSG 上时，它被应用到两个后面板连接器中的一个连接器上：

10 MHz IN

BASEBAND GEN REF IN

BASEBAND GEN REF IN 连接器接收 1 - 100 MHz 范围内的频率参考。如果外部时钟源或被测器件

时钟源不能提供或接收频率参考，那么可以把该时钟信号应用到这个连接器上，并作为频率参考使用。

在外部时钟信号或频率参考连接到 BASEBAND GEN REF IN 连接器上时，必须在当前信号源调制

格式中输入其频率。如需与BASEBAND GEN REF IN连接器有关的信息，请参阅第25页“5. BASEBAND

GEN REF IN”。如需与输入应用的时钟信号或频率参考有关的信息，请参阅 PSG 主要参考资料。

图 11-3 N5102A 模块时钟信号的频率参考设置图

注：只使用两个信号源频率参考输入中的一个输入。

内部生成的时钟

数据
数据

时钟N5102A 模块

10 MHz 频率参考

被测器件(DUT)提供的时钟

N5102A 模块
数据

数据

时钟

10 MHz 频率参考

N5102A 模块
数据

数据

时钟

10 MHz 频率参考

1-100 MHz 频率参考

ESG/PSG DUT
10 Mhz OUT

Freq Ref

10 Mhz OUT

10 Mhz IN

ESG/PSG

ESG/PSG

DUT

DUT

BB GEN REF IN
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并行数据的时钟定时

某些元器件在一个取样周期中要求多个时钟。(取样周期由I样点和Q样点组成)。对并行数据传输，可

以选择每个样点一个时钟、两个时钟或四个时钟。对每个样点一个以上的时钟，I样点和Q样点保持不变，

以适应额外的时钟周期。这会降低相对于时钟速率的取样速率，下降幅度是选择的每个样点时钟数量。例

如，在选择4时，取样速率下降4倍(取样速率与时钟速率之比)。图11-4是每种每个样点时钟数选择的时

钟定时。对输入模式，每个样点的时钟数一直设为 1。

外部生成的时钟

注：只使用两个信号源频率参考输入中的一个输入。

N5102A 模块
数据

数据

时钟

10 MHz 频率参考

N5102A 模块
数据

数据

时钟

10 MHz 频率参考

1-100 MHz 频率参考

10 Mhz OUT

10 Mhz IN

ESG/PSG

ESG/PSG

DUT

DUT

BB GEN REF IN

外部时钟

Ext Clk In

外部时钟
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图 11-4 并口配置的时钟取样定时

每个样点

1 个时钟

时钟

I样点

每个字 4位

Q 样点

每个字 4位

时钟速率和取样速率相同

1 个取样周期
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每个样点

2个时钟

时钟

I样点

每个字 4位

Q 样点

每个字 4 位

取样速率下降两倍

2个取样周期

每个样点

4个时钟

时钟

I样点

每个字 4位

Q 样点

每个字 4 位

取样速率下降四倍

4个取样周期
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并行隔行扫描数据的时钟定时

N5102A 模块可以隔行扫描数字 I 样点和 Q 样点，隔行扫描有两种选择：

IQ，其中先发送 I 样点

QI，其中先发送 Q 样点

在选择并行隔行扫描时，所有样点都在 I数据线上传输。与非隔行扫描的样点相比，这可以在一半数

量的数据线上，在取样期间传输相同数量的样点。(取样周期由 I样点和Q样点组成) 每个样点的时钟数量

这一参数仍适用于并行隔行扫描传输，会相对于时钟速率降低取样速率。选择的每个样点的时钟数量就

是降低的比率。图11-5说明了对并行 IQ隔行扫描端口配置的每种每个样点时钟数量选择，其中采用4位

的字长度及相对于 I样点和Q样点的时钟定时。对并行QI隔行扫描端口配置，只需颠倒 I和Q样点位置。

对输入模式，每个样点的时钟数量一直设为 1。

图 11-5 并行 IQ 隔行扫描端口配置的时钟定时

每个样点 1 个时钟

I 样点在一个时钟转换上传输，Q 样点在另一个转换上传输；

取样速率和时钟速率相同。

1个取样周期

1 个时钟

时钟

I 样点

每个字 4位

Q 样点

每个字 4位
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每个样点 2个时钟

在一个时钟周期中传输 I样点，在第二个时钟周期中传输Q样

点；取样速率降低了两倍。

1个取样周期

2个时钟

时钟

I样点

每个字 4位

Q 样点

每个字 4位

每个样点 4个时钟

在前两个时钟周期中传输 I样点，在后两个时钟周期中传输Q

样点；取样速率降低了四倍。

1个取样周期

4 个时钟

时钟

I 样点

每个字 4 位

Q 样点

每个字 4 位
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串行数据的时钟定时

图11-6是串行端口配置的时钟定时。注意串行传输中包括标明每个样点开始的帧脉冲，时钟则描绘

了每个位的开始点。对串行传输，时钟速率和位速率是相同的，但取样速率根据使用Word Size 软键输

入的每个字的位数变化。每个字的位数与每个样点的位数相同。

图 11-6 串行端口配置的时钟定时

相位和偏移调节的时钟定时

N5102A 模块可以相对于数据调节时钟的相位和偏移，并可以用来使时钟与数据的有效部分保持一

致。对 10 - 200 MHz的时钟速率，相位分辨率是 90度 (0, 90, 180, 和 270度可选)，对低于 10 MHz的时钟

速率和大于 200 MHz 的时钟速率，相位分辨率是 180 度 (0 和 180 度可选)。

偏移用纳秒表示，最大范围为± 5 ns，使用最大± 127 的离散步进。偏移范围和离散步进数量都可

以变化，其与时钟速率有关。在时钟速率提高时，偏移范围会下降；在时钟速率下降时，偏移范围会提

高。在大约 99 MHz 的时钟速率上，达到最大偏移范围，并一直保持到 25 MHz 的时钟速率。对低于 25

MHz 的时钟速率，不能进行偏移调节。

离散步进使用下面的公式计算：

在较低频率上，到达最大偏移范围要求的离散步进数量会下降。例如，在50 MHz的时钟速率时，127

个步进将超过± 5 ns 的最大偏移范围，因此离散步进的实际数量将小于 127。

图11-7是相位和偏移调节实例，说明了原始时钟及在每次调节后相对于数据的位置。注意偏移调节

增加了相位设置值。

1 个样点

帧标尺

时钟

数据位

每个字4位
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图 11-7 时钟相位和偏移调节

连接时钟源和被测器件

如第243页图11-3所示，可以通过多种方式为系统器件提供公共频率参考(PSG, N5102A模块和被测

器件)。图 11-8 是一个设置实例，其中信号源提供公共频率参考，N5102A 模块为被测器件提供时钟。

如需与被测器件接口连接有关的更多信息，请参阅 N5102A 数字信号接口模块安装指南。

小心 接口模块上的 Device Interface 连接器使用高速数字数据通信。应使用 ESD 注意事项，在进行

连接时消除可能造成的损坏。

注 在把固化软件下载到 PSG 时，必须断开数字总线电缆和数字模块。

90度相位调节

时钟偏移调节

调节了相位和

偏移的时钟

调节了相位的时钟

时钟

数据
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图 11-8 采用 PSG 10 MHz 频率参考的设置实例

1. 参阅第 243 页图 11-3 中的五个设置图，根据时钟源连接频率参考电缆。

2. 如果使用外部时钟源，把外部时钟信号连接到接口模块的 Ext Clock In 连接器上。

3. 选择带有适应本应用的输出连接器的接续电路板。如需与接续电路板有关的信息，请参阅N5102A数

字信号接口模块安装指南。

注 如果被测器件使用Device Interface连接器插头，参阅图11-8连接被测器件接口，把被测器件连

接到N5102A模块上。然后参阅第 253页“以输出模式操作N5102A模块”或第 262页“以输入

模式操作 N5102A 模块”。

4. 参阅图 11-8。把接续电路板连接到 N5102A 模块的 Device Interface 连接器上。

5. 把被测器件连接到接续电路板上。如需与接续电路板连接有关的信息，请参阅N5102A数字信号接口

模块安装指南。

信号源 10 MHz 输出

公共频率参考电缆

频率参考连接器

接续电路板

被测器件

被测器件接口连接 用户提供的带状电缆连接被测器件和接

续电路板。被测器件时钟输入位于带状

电缆中
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数据类型

下面的方框图表明在 PSG 信号生成过程中，在哪里为输入模式注入数据，或在哪里分接输出模式。

输出模式

在使用ARB格式时，数据类型一直是Samples (样点)，不对数据样点应用滤波。样点以ARB取样时

钟速率发送到数字模块。

对实时格式，选择 Samples (样点)作为数据类型将以 50 MHz - 100 MHz 之间的速率把滤波后的样点

发送到数字模块。在选择 FIR前样点后，将以与当前格式取样速率相等的速率把没有滤波的样点发送到

数字模块上。

输入模式

在数据类型是 Samples (样点)时，通过数字模块的数据样点被注入到绕过滤波流程的点上。

如果选择FIR前样点，将在滤波流程前注入数据样点。最大速率取决于选择的滤波器。参阅表11-7。

输出模式

FIR 前样点 样点

输入模式

I/Q 调制器FIR滤波数据发生器
I,Q

DACs

PSG

FIR 前样点 样点

LO

RF
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使用 Filter 软键进入一个菜单，设置希望的滤波参数。

以输出模式操作 N5102A 模块

本节介绍了怎样使用前面板按键，在输出模式下设置N5102A选项003模块的参数。每个程序都包含

一个示意图，说明了执行的接口模块功能的软键菜单结构。

设置信号源基带数据

数字信号接口模块从基带信号源接收数据，输出相对于选定逻辑类型的数字 IQ或数字IF信号。由于

PSG 提供基带数据，因此操作接口模块时的第一个程序是使用其中一种实时格式或 ARB 调制格式配置

PSG，或使用双ARB播放器播放存储的文件。如需与设置实时波形或ARB波形关的信息，或如需了解怎

样使用双 ARB 播放器，请参阅本指南中相应的章节。

1. 预置信号源。

2. 选择调制格式(TDMA、定制、等等)，设置希望的参数。

3. 启动调制格式。

进入 N5102A模块用户界面

按Aux Fctn > N5102A Interface。

进入用户界面(第一级软键菜单如图 11-9所示)，这个界面用来配置数字信号接口模块。注意PSG显

示屏中的图形说明了一个设置，其中N5102A 模块生成自己的内部时钟信号。这个图形会变化，以反映

当前时钟源选择。

滤波器 最大速率

Gaussian
Nyquist
Root Nyquist
矩形

边沿 50 MHz
UN3/4 GSM Gaussian
IS-95

IS 95 w/EQ
IS-95 Mod 25 MHz
IS-95 Mod w/EQ

APCO 25 C4FM 12.5 MHz

表 11-7 选定滤波器的最大取样速率
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图 11-9 第一级软键菜单

选择逻辑类型和端口配置

图 11-10 逻辑和端口配置软键菜单

直线为灰色，直到N5102A 模块接口启动
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1. 参阅图 11-10，按 Logic Type 软键。

从这个菜单中，选择一个逻辑类型。

小心 改变逻辑类型会提高或降低到达被测器件的信号电压电平。为避免损坏被测器件和/或N5102A

模块，要保证它们都能够处理电压变化。

2. 选择被测器件要求的逻辑类型。

在逻辑类型变化时会显示小心信息，同时会出现软键选择请求确认。

3. 参阅图 11-10，按 Port Configuration 软键。

在这个菜单中，选择串行、并行或并行隔行扫描数据传输。

注 在数据和时钟设置软键菜单内部，只有相对于当前配置的软键才会激活。灰色的软键不能用于

当前设置。参阅帮助文本，确定哪些参数导致软键不可用。为获得帮助信息，先按Help硬键，

然后按不可用的软键。

4. 选择被测器件的端口配置。

选择输出方向

按Data Setup > Direction Input Output 直到 Output，然后按Return。

注 如果选项 003是安装的唯一选项，那么方向软键将不能使用，模式一直是输出。在同时安装选

项 003 (输出模式)和选项 004 (输入模式)时，默认方向是输出。

选择数据参数

这一程序引导您通过数据设置菜单。我们一般没有提到名称非常明了的软键，如Word Size软键。如

需所有软键有关的更多信息，请参阅 PSG 主要参考资料。

1. 参阅图 11-11，按 Data Setup 软键。
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图 11-11 数据设置菜单的位置

这个软键菜单可以进入各种参数，这些参数控制着被测器件收到的数据。显示屏的状态区域显示I和

Q使用的数据线数量以及时钟相对于数据的位置。在端口配置是并行或并行隔行扫描时，表明的数据线

数等于字(样点)长度。在端口配置是串行时，显示屏将显示只使用了一个 I和Q数据线，另外还有表明样

点开始的帧标尺。图 11-12 说明了数据设置菜单结构。

进入数据设置菜单
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图 11-12 并口配置的数据设置软键菜单

2. 如果使用实时调制格式，按 Data Type 软键。(在启动 ARB 调制格式时，这个软键不活动。)

在这个菜单中，选择来自信号源的实时基带数据是滤波的(Samples)还是没有滤波的(Pre-FIR

Samples)。选择取决于测试需求。Samples选项根据活动的调制格式的通信标准提供FIR滤波的基带

样点。这是预置选项，也是最常用的选项。但是，如果被测器件已经具有 FIR 滤波器，那么应使用

Pre-FIR Samples 选项，避免双重滤波。

3. 选择适合测试的数据类型。

4. 按Numeric Format 软键。

从这个菜单中，选择怎样表示二进制值。选择二进制补码可以同时支持正和负数据值。在元器件不能

处理负值时，使用 Offset Binary 选项。

ARB 格式不激活

对16位的字长度不激活

对串口配置不激活

 帧极性对串口配置激活
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5. 选择测试要求的数字格式。

6. 按More (1 of 2)软键。

从这个软键菜单中，选择位顺序，I 和 Q 互换，选择传输的数据的极性，进入提供数据否定、定标、

增益、偏置和 IQ 旋转调节的菜单。

7. 按Data Negation 软键。

否定与改变 I和Q极性不同。在应用到样点中时，否定会改变受影响的样点，其方式是用二进制补码

表达样点，把它乘以 -1，然后把样点转换回到选择的数字格式。这可以用于 I 样点、Q 样点或两者。

是否选择使用否定取决于被测器件及需要以什么方式接收数据。

8. 按Gain, Offset & Scaling 软键。

对下述功能使用这个菜单中的软键：

使用 Scaling 软键，降低 I 和 Q 的样点值

使用 I Gain 和 Q Gain 软键，单独提高或降低 I 和 Q 的样点值

使用 I Offset 和 Q Offset 软键，补偿或增加 DC 偏置

使用 Rotation 软键，在 IQ 层上旋转数据

9. 进行任何要求的定标、增益、偏置或旋转调节，以正确测试器件。

10. 按Return > Return，返回第一级软键菜单。

配置时钟信号

1. 参阅图 11-13。按Clock Setup 软键。

图 11-13 时钟设置菜单的位置

进入时钟设置菜单
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从这个软键菜单中，设置所有时钟参数，在N5102A 模块和 PSG之间同步时钟。还可以改变时钟信

号相位，以便在数据的有效部分发生时钟。图 11-14 显示了时钟设置菜单。

图 11-14 并口配置的时钟设置软键菜单

显示屏顶部的图形显示了在Clock Out和Device Interface连接器上提供输出时钟信号的当前时钟源。

本程序后面讨论了反映时钟源选项的图形变化。下面的图形显示了时钟相对于数据的位置。显示的时钟

信号将变化，以反映：

选择的每个样点时钟数量

时钟相位选择

时钟偏移调节

时钟极性选择

如果被测器件或外部时钟与频率不匹配，那么 PSG 上将出现下面一条错误信息：

805 Digital module output FIFO overflow error; There are more samples being produced

than can be consumed at the current clock rate. Verify that the digital module clock

is set up properly.

对串口配置和 IF 信号类型不活动

对 25 MHz 以下的时钟速率不活动

仅对内部时钟源选项活动

对小于 10 MHz 的时钟速率和 200 MHz

以上的时钟速率不活动
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在数字模块中的输出 FIFO上溢时，将报告这一错误。如果外部时钟或参考设

置不正确，或如果内部 VCO 没有锁定，也会生成这一错误。

806 Digital module output FIFO underflow error; There are not enough samples being

produced for the current clock rate. Verify that the digital module clock is set up

properly.

在数字模块中的输出 FIFO下溢时，将报告这一错误。如果外部时钟或参考设

置不正确，或如果内部 VCO 没有锁定，也会生成这一错误。

2. 如果端口配置是并行或并行隔行扫描，使用 IQ 信号类型，那么按Clocks Per Sample 软键。注意可

以选择每个样点多个时钟。某些DAC要求能够为每个样点提供多次时钟；每个样点的时钟值大于 1

会使取样速率降低，降低幅度是选择的每个样点时钟数。取样速率在第一级菜单和Data Setup软键

菜单上查看。

3. 选择适合测试的每个样点时钟数。

4. 按Clock Source 软键。

从这个菜单中，选择时钟信号源。在每次选择时，信号源时钟设置菜单中的时钟路由显示会变

化，以反映当前时钟源。这将通过图形变化表示。

5. 选择时钟源。

如果选择外部时钟源或被测器件时钟源

按Clock Rate 软键，输入外部应用的时钟信号的时钟速率。

注 每次在改变时钟速率设置时，可能需要调节时钟相位和时钟偏移。请参阅第 249页“相位和偏

移调节的时钟定时”。

对External 选项，信号由外部时钟源提供，应用到 Ext Clock In 连接器。对Device 选项，时钟信号

通过 Device Interface 连接器提供，通常由被测器件提供。
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如果选择内部时钟源

如果使用外部频率参考，N5102A模块生成自己的内部时钟信号。参考频率信号必须应用到数字模块

中的 Freq Ref 连接器上。

a. 按Reference Frequency 软键，输入外部应用的频率参考的频率。

b. 按Clock Rate 软键，输入相应的时钟速率。

表 11-8 提供了与每个时钟源选择有关的设置和连接快速信息。

表 11-8 时钟源设置和连接器

时钟源 软键 N5102A 模块连接

参考频率 时钟速率 1 频率参考 外部时钟输入 被测器件接口

外部 * *

被测器件 * *

内部 2 * * *

1. 对内部时钟源选项，这会设置内部时钟速率。对外部时钟源和被测器件时钟源选项，这会告诉接口模块应用的时钟信号的速率。

2. 对 Ext Clock In 连接器应没有应用时钟信号。

6. 按Clock Phase 软键。

从出现的菜单中，可以以 90度增量调节时钟相对于数据的相位。这些选项提供了粗调功能，可以在

数据的有效部分定位时钟。选择 180 度与选择负时钟极性相同。

在时钟速率设成低于 10 MHz 或高于 200 MHz 时，不能使用 90 度选项和 270 度选项。在时钟速率设

成低于 10 MHz 或高于 200 MHz 时，如果选择 90 度或 270 度，相位将分别变成 0 度或 180 度。

注 在改变时钟速率设置时，可能需要调节时钟相位和时钟偏移。请参阅第 249页“相位和偏移调

节的时钟定时”。

7. 输入要求的相位调节。

8. 按Return 软键，返回时钟设置菜单。

9. 按Clock Skew 软键。

可以相对于当前相位位置微调时钟。偏移是使用时间增量所作的相位调节。在较高的时钟速率上，这

可以实现更高的偏移调节能力。对低于 25 MHz 的时钟速率，这个软键不能使用。
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偏移具有离散值，范围取决于时钟速率。如需与偏移设置有关的更多信息，请参阅第249页“相位和

偏移调节的时钟定时”。

10. 进入偏移调节，使用数据的有效部分最好地定位时钟位置。

11. 按Clock Polarity Neg Pos 软键直到 Neg。

把时钟信号位移 180 度，这样数据在负时钟转换过程中开始。其影响与选择 180 度相位调节相同。

12. 进行被测器件要求的时钟极性选择。

13. 按Return 硬键，返回第一级软键菜单。

第一级软键菜单图形中也会反映时钟源选择。例如，如果被测器件是新的时钟源，图形将显示频率参

考现在连接到 DUT 上，DUT 具有到达 N5102A 模块的输入时钟线路。

生成数字数据

按N5102A Off On 软键直到 On。

数字数据现在通过 N5102A 模块传送到被测器件上。绿色状态灯应该闪亮，表明数据线激活。如果

状态灯恒亮(不闪烁)，则表明所有数据线没有活动。状态灯会变亮，并在 N5102A 模块第一次启动后

(N5102A Off On 直到 On)一直亮起(闪亮或长亮)。状态亮将一直亮起，直到模块从电源上断开。

只有在调制格式活动时，才能启动接口模块。如果在模块启动时关闭调制格式，模块将关闭，系统

将报告错误。

注 如果改变基带数据参数，建议先禁用数字输出(按N5102A Off On 软键直到 Off)，以避免使被

测器件和 N5102A 模块受到参数变化过程中可能发生的信号变化的影响。

以输入模式操作 N5102A 模块

本节介绍了怎样在输入方向使用信号源用户界面设置N5102A选项004模块的参数。每个程序都包含

一个示意图，说明了执行的接口模块功能的软键菜单结构。

参阅第 250 页“连接时钟源和被测器件”，配置测试设置。
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进入 N5102A模块用户界面

按Aux Fctn > N5102A Interface。

进入用户界面(第一级软键菜单如图11-15所示)，这个界面用来配置数字信号接口模块。注意PSG显

示屏中的图形说明了一个设置，其中N5102A 模块生成自己的内部时钟信号。这个图形会变化，以反映

当前时钟源选择。

图 11-15 第一级软键菜单

设置输入方向

如果同时安装了选项 003 (输出模式)和选项 004 (输入模式)，必须选择输入方向。

按Data Setup > Direction Input Output 直到 Input，然后按Return。

注 如果只安装了选项 004，方向软键将不能使用，模式一直是输入。

到 DUT 的内部时钟

直线为灰色，直到 N5102A 模块接口启动



264 第 11章

外围设备

N5102A 数字信号接口模块

选择逻辑类型和端口配置

图 11-16 逻辑和端口配置软键菜单

1. 参阅图 11-16，按 Logic Type 软键。

从这个菜单中，选择一个逻辑类型。

小心 改变逻辑类型会提高或降低到达被测器件的信号电压电平。为避免损坏被测器件和/或N5102A

模块，要保证它们都能够处理电压变化。

2. 选择被测器件要求的逻辑类型。

在逻辑类型变化时会显示小心信息，同时会出现软键选择请求确认。

3. 参阅图 11-16，按Port Configuration 软键。

在这个菜单中，选择串行、并行或并行隔行扫描数据传输。

注 在数据和时钟设置软键菜单内部，只有相对于当前配置的软键才会激活。灰色的软键不能用于

当前设置。参阅帮助文本，确定哪些参数导致软键不可用。为获得帮助信息，按Help硬键，然

后按不可用的软键。
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4. 选择被测器件的端口配置。

配置时钟信号

1. 按Clock Setup 软键，如图 11-17 所示。

图 11-17 时钟设置菜单的位置

从这个软键菜单中，设置所有时钟参数，在N5102A模块和PSG之间同步时钟。还可以改变时钟信号

相位，以便在数据的有效部分发生时钟。图 11-18 显示了时钟设置菜单。

如果被测器件或外部时钟与频率不匹配，那么 PSG 上将出现下面一条错误信息：

803 Digital module input FIFO overflow error; There are more samples being produced

than can be consumed at the current clock rate. Verify that the digital module clock

is set up properly.

在数字模块时钟设置没有与样点进入数字模块的速率同步时，将报告这一错误。

在时钟设置菜单下检验输入时钟速率是否与指定的时钟速率相匹配。

804 Digital module input FIFO underflow error; There are not enough samples being

produced for the current clock rate. Verify that the digital module clock is set up

properly.

进入时钟设置菜单



266 第 11章

外围设备

N5102A 数字信号接口模块

在数字模块时钟设置没有与样点进入数字模块的速率同步时，将报告这一错误。

在时钟设置菜单下检验输入时钟速率是否与指定的时钟速率相匹配。

图 11-18 并口配置的时钟设置软键菜单

显示屏顶部的图形显示了在Clock Out和Device Interface连接器上提供输出时钟信号的当前时钟源。

本程序后面讨论了反映时钟源选项的图形变化。下面的图形显示了时钟相对于数据的位置。显示的时钟

信号将变化，以反映：

时钟相位选择

时钟偏移调节

时钟极性选择

2. 按Clock Source 软键。

从这个菜单中，选择时钟信号源。在每次选择时，信号源时钟设置菜单中的时钟路由显示会变

化，以反映当前时钟源。这将通过图形变化表示。

对输入模式不活动

对25 MHz以下的时钟速率不活动

仅对内部时钟源选项活动

对小于 10 MHz 的时钟速率和 200 MHz

以上的时钟速率不活动
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3. 选择时钟源。

如果选择外部时钟源或被测器件时钟源

按Clock Rate 软键，输入外部应用的时钟信号的时钟速率。

注 每次在改变时钟速率设置时，可能需要调节时钟相位和时钟偏移。请参阅第 249 页“相位和偏

移调节的时钟定时”。

对External 选项，信号由外部时钟源提供，应用到 Ext Clock In 连接器。对Device 选项，时钟信号

通过 Device Interface 连接器提供，通常由被测器件提供。

如果选择内部时钟源

如果使用外部频率参考，N5102A模块生成自己的内部时钟信号。参考频率信号必须应用到数字模块

中的 Freq Ref 连接器上。

a. 按Reference Frequency 软键，输入外部应用的频率参考的频率。

b. 按Clock Rate 软键，输入相应的时钟速率。

表 11-9 提供了与每个时钟源选择有关的设置和连接快速信息。

表 11-9 时钟源设置和连接器

时钟源 软键 N5102A 模块连接

参考频率 时钟速率 1 频率参考 外部时钟输入 被测器件接口

外部 * *

被测器件 * *

内部 2 * * *

1. 对内部时钟源选项，这会设置内部时钟速率。对外部时钟源和被测器件时钟源选项，这会告诉接口模块应用的时钟信号的速率。

2. 在使用 Internal时，对 Ext Clock In 连接器应没有应用时钟信号。

4. 按Clock Phase 软键。

从出现的菜单中，可以以 90度增量调节时钟相对于数据的相位。这些选项提供了粗调功能，可以在

数据的有效部分定位时钟。选择 180 度与选择负时钟极性相同。
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在时钟速率设成低于 10 MHz或高于 200 MHz时，不能使用 90度选项和 270度选项。在时钟速率设

成低于 10 MHz 或高于 200 MHz 时，如果选择 90 度或 270 度，相位将分别变成 0 度或 180 度。

注 在改变时钟速率设置时，可能需要调节时钟相位和时钟偏移。请参阅第 249页“相位和偏移调

节的时钟定时”。

5. 输入要求的相位调节。

6. 按Return 软键，返回时钟设置菜单。

7. 按Clock Skew 软键。

可以相对于当前相位位置微调时钟。偏移是使用时间增量所作的相位调节。在较高的时钟速率上，这

可以实现更高的偏移调节能力。对低于 25 MHz 的时钟速率，这个软键不能使用。

偏移具有离散值，范围取决于时钟速率。如需与偏移设置有关的更多信息，请参阅第249页“相位和

偏移调节的时钟定时”。

8. 进入偏移调节，使用数据的有效部分最好地定位时钟位置。

9. 按Clock Polarity Neg Pos 软键直到 Neg。

把时钟信号位移 180 度，这样数据在负时钟转换过程中开始。其影响与选择 180 度相位调节相同。

10. 进行被测器件要求的时钟极性选择。

11. 按Return 硬键，返回第一级软键菜单。

第一级软键菜单图形中也会反映时钟源选择。例如，如果被测器件是新的时钟源，图形将显示频率参

考现在连接到 DUT 上，DUT 具有到达 N5102A 模块的输入时钟线路。

选择数据参数

这一程序引导您通过数据设置菜单。我们一般没有提到名称非常明了的软键，如Word Size软键。如

需所有软键有关的更多信息，请参阅 PSG 主要参考资料。

1. 参阅图 11-19，按Data Setup 软键。
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图 11-19 数据设置菜单的位置

进入数据设置菜单

这个软键菜单可以进入各种参数，这些参数控制着被测器件收到的数据。显示屏的状态区域显示I和

Q 使用的数据线数量以及时钟相对于数据的位置。图 11-20 说明了数据设置菜单结构。
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图 11-20 并口配置的数据设置软键菜单

2. 按Data Type 软键。

在这个菜单中，选择数据类型是滤波的(Samples)还是没有滤波的(Pre-FIR Samples)。选择取决于测

试需求和待测设备。但是，如果正在被测试的器件已经具有FIR滤波器，那么应使用Pre-FIR Samples

选项，避免双重滤波。请参考阅第 252 页“数据类型”。

3. 选择适合测试的数据类型。

4. 按Numeric Format 软键。

从这个菜单中，选择怎样表示二进制值。选择二进制补码可以同时支持正和负数据值。在元器件不能

处理负值时，使用 Offset Binary 选项。

5. 选择测试要求的数字格式。

6. 按More (1 of 2)软键。

对串口配置不活动

帧极性对串口配置激活

只有在N5102A数字模

块启动时才能使用 只在数据类型是FIR前

样点时才能使用
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从这个软键菜单中，选择位顺序，I和Q互换，选择数据的极性，进入提供数据否定、定标和滤波参

数的菜单。

7. 按Data Negation 软键。

否定与改变 I和Q极性不同。在应用到样点中时，否定会改变受影响的样点，其方式是用二进制补码

表达样点，把它乘以 -1，然后把样点转换回到选择的数字格式。这可以用于 I样点、Q 样点或两者。

是否选择使用否定取决于被测器件。

8. 为访问 I/Q 定标和滤波参数，按Return > N5102A Off On 直到 On。这将在 PSG 基带发生器中调用实

时定制格式。在选择 FIR 前样点作为数据类型时，设置滤波参数时需要进行这一操作。

9. 按Baseband Setup 软键。

使用这个软键菜单调节 I/Q标度，访问滤波参数。如果选择的数据类型是样点，那么 Filter软键会变

成灰色(不活动)。

数字数据

如果N5102A 数字模块没有启动，按Return > Return > N5102A Off On直到 On。

数字数据现在通过N5102A 模块传送到被测器件上。绿色状态灯应该闪亮，表明数据线激活。如果

状态灯恒亮(不闪烁)，则表明所有数据线没有活动。状态灯会变亮，并在 N5102A 模块第一次启动后

(N5102A Off On 直到 On)一直亮起(闪亮或长亮)。状态亮将一直亮起，直到模块从电源上断开。

只有在调制格式活动时，才能启动接口模块。如果在模块启动时关闭调制格式，模块将关闭，系统

将报告错误。

注 如果改变基带数据参数，建议先禁用数字输出(按N5102A Off On软键直到Off)，以避免使被测

器件和 N5102A 模块受到参数变化过程中可能发生的信号变化的影响。
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毫米波信号源模块

可以使用Agilent 8355x系列毫米波信号源模块或任何其它外部信号源模块，扩展信号源的RF频率。

输出频率范围取决于毫米波信号源模块的频率范围。本节介绍了下述程序：

使用安捷伦毫米波信号源模块

使用其它信号源模块

使用安捷伦毫米波信号源模块

Agilent 8355x 系列毫米波信号源模块连接到信号源的后面板 SOURCE MODULE INTERFACE 连接

器上，可以在仪器之间直接通信，并可以用来对信号源模块进行自动置平控制。如果您想使用没有自动

置平或复用器选择功能的 8355x 系列信号源模块，请参阅第 275 页“使用其它信号源模块”。

下面列出了扩展信号源的频率范围要求的设备：

Agilent 8355x 系列毫米波信号源模块

Agilent 8349B 微波放大器(只有没有配备选项 1EA 的 E8257D PSG 才要求)

要求的 RF 输出电缆和适配器

注 连接到E8267D PSG或配备选项1EA的E8257D PSG上的电缆和适配器的最大插入损耗应小于

1.5 dB，以保证外部信号源模块提供最大功率。

设置外部信号源模块

小心 为防止损坏信号源，在把信号源模块接口电缆连接到后面板 SOURCE MODULE INTER

FACE 连接器前，应关闭到信号源的线路电源。

1. 关闭信号源的线路电源。

2. 如下图所示连接设备。

没有选项 1EA 的 E8257D PSG 使用图 11-21 中的设置。

配有选项 1EA 的 E8257D PSG 或 E8267D PSG 采用图 11-22 中的设置
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图 11-21 没有选项 1EA 的 E8257D PSG 的设置图

信号源
模块

信号源

RF 输出

适配器
(如果要求)

RF 输入

微波放大器

RF 输出

毫米波信号源模块

RF 输入

置平的输出信号源模块接口
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图 11-22 配备选项 1EA 的 E8267D PSG 和 E8257D PSG 的设置图

配置信号源

1. 打开信号源的线路电源。

注 具体的频率和幅度范围请参阅毫米波信号源模块技术数据。

2. 按 Frequency > (3 of 3) > Source Module，把Agilent 8355x Source Module Off On 软键拨到 On。

信号源将：

识别安捷伦毫米波信号源模块

把置平模式切换到外部 / 信号源模块(功率在毫米波信号源模块输出上置平)

把毫米波信号源模块的频率和幅度设为信号源模块的预置值

信号源

模块 信号源

RF 输出

适配器
(如果要求) 毫米波信号源模块

置平的输出信号源模块接口
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在启动时，显示毫米波信号源模块输出上提供的 RF 输出频率和幅度值

在通过前面板Agilent 8355x Source Module Off On软键启动8355x系列毫米波信号源时，信号源显示

屏 FREQUENCY 区域将出现 MMOD 指示灯，AMPLITUDE 区域将出现 MM 指示灯。

3. 如果显示 RF OFF 报警器，按RF On/Off。

毫米波信号源模块输出上应提供置平后的功率。为获得校正了平坦度的功率，请参阅第139页“创建

和应用用户平坦度校正”。

使用其它信号源模块

使用下面的程序，利用任何外部信号源模块扩展 PSG 的频率范围，或使用没有自动置平功能的

Agilent 8355x 系列毫米波信号源模块。下面列明了扩展信号源的频率范围要求的设备：

外部毫米波信号源模块

Agilent 8349B 或其它微波放大器(只有没有选项 1EA 的 E8257D PSG 才要求)

要求的 RF 输出电缆和适配器

设置外部信号源模块

1. 关闭信号源的线路电源。

2. 如下图所示连接设备。

没有选项 1EA 的 E8257D PSG 采用图 11-23 中的设置。

配备选项 1EA 的 E8257D PSG 或 E8267D PSG 采用图 11-24 中的设置。
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图 11-23 没有选项 1EA 的 E8257D PSG 的设置图

图 11-24 E8267D PSG 和配备选项 1EA的 E8257D PSG 的设置图

信号源

RF 输出

适配器
(如果要求)

RF 输入

微波放大器

RF 输出

毫米波信号源模块

RF 输入

置平的输出

信号源

RF 输出

适配器
(如果要求)

毫米波信号源模块

RF 输入

置平的输出
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配置信号源

下面的程序配置 PSG，以用于 WR (波导矩形)频率范围在 90-140 GHz 之间的任何外部信号源模块。

可以修改频率范围，以与信号源模块相匹配。

1. 打开信号源线路电源。

注 信号源模块输出上的自动置平不适用于 OEM 信号源模块选项。

2. 按 Frequency > (3 of 3) > Source Module。把Agilent 8355x Source Module Off On 软键拨到 Off。

3. 把OEM Source Off On 软键拨到 On。

4. 按OEM Source Module Config > Standard WR Freq Bands > WR8 90-140GHz。

Standard WR Freq Bands菜单中的选项是适用于最常见的外部信号源模块频率范围的预先定义的频率

范围和倍数，其目的是方便设置。如果在预先定义的设置列表中没有列出信号源模块的频率范围，那

么可以使用Min Band Freq, Max Band Freq, 和 Freq Multiplier 软键，手动设置范围和 PSG 频率显示

倍数。如需与这些手动设置有关的更多信息，请参阅 PSG 主要参考资料。

5. 如果 RF OFF 报警器显示，按 RF On/Off。

为获得校正了平坦度的功率，请参阅第 139 页“创建和应用用户平坦度校正”。



278 第 11章

外围设备

毫米波信号源模块



279

本章介绍了诊断安捷伦PSG信号源问题的基本信息。如果在本章中没有找到解决问题的办法，请参

阅服务指南。

注 如果信号源显示错误，应按Utility > Error Info 阅读错误信息。

“RF 输出功率问题”，第 280 页

“RF 输出上没有调制”，第 284 页

“扫描问题”，第 285 页

“数据存储问题，第 287 页

“不能打开帮助模式”，第 288 页

“信号源锁住”，第 289 页

“错误信息”，第 291 页

“联系安捷伦销售和服务办事处”，第 294 页

“把信号源退回安捷伦”，第 295 页

12   问题诊断
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RF 输出功率问题

RF 输出功率问题

在显示屏上检查 RF ON/OFF 报警器，如果出现 RF OFF，按RF On/Off，把 RF 输出拨到 On。

在播放波形文件时没有 RF 输出功率

预置信号源，然后重新播放波形文件。

如果没有为波形指定标题文件，那么信号源使用没有指定设置的默认标题文件。如果播放的波形文

件没有指定信号源设置(设置没有保存到文件标题中，参阅第 82页)，信号源将使用以前播放的文件的标

题文件设置。如果以前的标题文件的标尺路由到RF消隐，那么RF输出功率将被隐去。预置信号源，把

RF 消隐标尺功能恢复到默认状态(off)。如需更多信息，请参阅 PSG 主要参考资料“标尺”部分。

注 如果使用默认的标尺文件，那么要确保Pulse/RF Blank软键设为None。以前的文件标题可能已

经把标尺设成Pulse/RF Blank。

RF 输出功率太低

1. 在显示屏的 AMPLITUDE 区域查找 OFFS 或 REF 指示灯。

OFFS告诉您已经设置了幅度偏置。幅度偏置会改变显示屏AMPLITUDE区域显示的值，但不会影响

输出功率。显示的幅度等于信号源硬件的当前功率输出加上偏置值。

为消除偏置，按下面的键：

Amplitude > More (1 of 2) > Ampl Offset > 0 > dB

REF告诉您幅度参考已经激活。在这个模式打开时，显示的幅度值并不是输出功率电平，而是信号发

生器的当前功率输出减去 Ampl Ref Set 软键设置的参考值。

退出参考模式的步骤如下：

a. 按Amplitude > More (1 of 2)。

b. 按 Ampl Ref Off On，直到 Off 高亮度显示。

然后可以把输出功率复位到希望的水平。

2. 如果使用的是带有外部混频器的信号源，请参阅第 281 页“在使用混频器时信号丢失”。
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3. 如果使用的是带有频谱分析仪的信号源，请参阅第 282 页“在使用频谱分析仪时信号丢失”。

电源已经关闭

如果电源没有工作，那么它要求维修或更换，电源中没用用户可以更换的保险丝。说明请参阅服务

指南。

在使用混频器时信号丢失

如果在使用混频器进行低幅度耦合操作中信号源上的信号丢失，可以通过增加衰减，提高信号源的

RF 输出幅度，来解决问题。

图 12-1 说明了一个假设配置，其中信号源为混频器提供了低幅度信号。

图 12-1 回程功率对 ALC 的影响

内部置平的信号源 RF 输出(和 ALC 电平)是 -8 dBm。混频器通过 +10 dBm 的局部频率振荡器驱动，

LO 到 RF 的隔离度为 15 dB。得到 -5 dBm 的 LO 馈通进入信号源的 RF OUTPUT 连接器，到达内部检测

器。

根据频率，大部分LO馈通能量可能会进入检测器。由于检测器对总输入功率响应，而不管频率是多

少，因此多出的这部分能量会导致ALC降低信号源的RF输出。在本例中，经过检测器的回程功率实际

上要大于 ALC 电平，其可能会导致 RF 输出上的信号丢失。

信号源输出控制

RF 电平控制

ALC 电平 =-8 dBm

检测器测量

-8 dBm ALC

电平

检测器测量

-5 dBm回程

功率

RF 输出 =-8 dBm
混频器

LO馈通=-5 dBm LO 电平 =+10 dBm

LO

IF
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第282页的图12-2说明了类似的配置，但增加了一个10 dB衰减器，这个衰减器连接在信号源RF输

出与混频器之间。信号源的 ALC 电平提高到 +2 dBm，并通过 10 dB 衰减器传输，在混频器输入上实现

要求的 -8 dBm 幅度。

图 12-2 回程功率解决方案

与原始配置相比，ALC电平高出了10 dB，而衰减器则把LO馈通(和信号源的RF输出)降低了10 dB。

在使用衰减的配置时，检测器遇到 +2 dBm 想要的信号，而不是 -15 dBm 不想要的 LO 馈通。想要的能

量和不想要的能量之间相差 17 dB，导致信号源 RF 输出电平最大位移 0.1 dB。

在使用频谱分析仪时信号丢失

在信号源与没有预选取功能的频谱分析仪一起使用时，回程功率效应可能会导致信号源 RF 输出问

题。

某些频谱分析仪在某些频率上在RF输入端口上拥有高达+5 dBm的LO馈通。如果LO馈通和RF载

波之间的频率差低于ALC带宽，那么LO的回程功率可能会导致对信号源的RF输出调幅。不想要的AM

比率等于频谱分析仪 LO 馈通和信号源 RF 载波之间的频率差。

通过使用下面两种没有置平的工作模式之一：ALC 关闭或功率搜索，可以解决回程功率问题。

信号源输出控制

RF 电平控制

ALC 电平

=-8 dBm

检测器测量

-2 dBm

ALC电平

检测器测量

-5 dBm回程

功率

RF 输出

=-8 dBm
混频器

LO馈通=-5 dBm LO 电平 =+10 dBm

LO

IF

10 dB

ATTEN
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设置 ALC关闭模式

ALC 关闭模式在信号源的 RF 输出前使自动置平电路无效。在这种模式下，要求使用功率计，测量

信号源的输出，协助在检测点上实现要求的输出功率。

使用下面的步骤，把信号源设成 ALC 关闭模式：

1. 预置信号源：按 Preset。

2. 设置希望的频率：按 Frequency，输入希望的频率。

3. 设置希望的幅度：按 Amplitude，输入希望的幅度。

4. 关闭 RF：把RF On/Off 设成 Off。

5. 关闭信号源自动置平控制(ALC): 按Amplitude > ALC Off On 直到 Off。

6. 监视功率计测得的 RF 输出幅度。

7. 按Amplitude，调节信号源的 RF 输出，直到功率计测得希望的功率。

设置功率搜索模式

功率搜索模式执行功率搜索程序，临时激活ALC，校准当前RF输出的功率信息，然后断开ALC电

路。如需与功率搜索功能有关的更多信息，请参阅 PSG 主要参考资料。

使用下面的步骤，把信号源设成手动固定功率搜索模式：

1. 预置信号源：按 Preset。

2. 设置希望的频率：按 Frequency，输入希望的频率。

3. 设置希望的幅度：按 Amplitude，输入希望的幅度。

4. 关闭信号源自动置平控制(ALC): 按Amplitude > ALC Off On 直到 Off。

5. 启动 RF：把RF On/Off 设成 On。

6. 按Do Power Search。

执行手动固定功率搜索程序，这是默认模式。

功率搜索模式有三种：手动、自动和跨度。

在Power Search 设为 Manual (手动)时，按Do Power Search，对当前 RF 频率和幅度执行功率搜索

校准程序。在这种模式下，如果 RF 频率和幅度发生变化，需要再按Do Power Search。

在Power Search 设为 Auto (自动)时，在改变 RF 输出的频率或幅度时会执行校准程序。

在Power Search设为 Span (跨度)时，按Do Power Search，一次性地在选定的频率范围上执行功率

搜索校准程序。然后存储功率搜索校正值，并在选定频率范围内调谐信号源时使用功率搜索校正值。
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RF 输出上没有调制

检查显示屏上的 MOD ON/OFF报警器。如果显示的是 MOD OFF，按Mod On/Off，把调制拨到 on。

尽管可以设置和启动各种调制，但只有在把Mod On/Off设为On时，才能调制RF载波。在8267D上，

为进行数字调制，一要把 I/Q Off On 设为 On。
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扫描问题

扫描似乎停止了

当前扫描状态在进度条中用带阴影的矩形表示，可以观察进度条，确定扫描是否正在进行。如果扫

描似乎已经停止，进行下述检查：

通过顺序按下面任何键，确定是否已经启动扫描？

Sweep/List > Sweep > Freq

Sweep/List > Sweep > Ampl

Sweep/List > Sweep > Freq & Ampl

扫描是否处于连续扫描模式？如果扫描处于单次扫描模式，确定在前一个扫描完成后至少已经按

Single Sweep 软键一次。试着把模式设成连续扫描模式，确定是不是漏掉的单次扫描堵住了扫描。

信号源是否收到适当的扫描触发？试着把Sweep Trigger软键设成 Free Run，确定是不是漏掉的扫描

触发堵住了扫描。

信号源是否收到适当的点触发？试着把Point Trigger软键设成Free Run，确定是不是漏掉的点触发堵

住了扫描。

驻留时间是否适当？试着把驻留时间设成一秒，确定驻留时间是不是设得太慢了或太快了，以致看不

到驻留时间。

步进扫描或列表扫描中是否至少有两个点？

不能关闭扫描模式

按Sweep/List > Sweep > Off。

在扫描模式菜单中，可以选择把扫描设成各种扫描类型，或关闭扫描。

❑

❑

❑

❑

❑

❑
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列表扫描驻留时间值不正确

如果信号源在每个扫描列点上没有驻留正确的时间，根据下面的步骤操作：

1. 按Sweep/List > Configure List Sweep。

显示扫描列表值。

2. 检查扫描列表驻留时间值的精度。

3. 如果不正确，编辑驻留时间值。

注 RF OUTPUT连接器上的有效驻留时间是为驻留设置的时间值与处理时间、切换时间和稳定时

间之和。驻留时间之外增加的这些时间一般长几毫秒。但是，TRIG OUT连接器上提供的TTL/

CMOS 输出只在实际驻留时间过程中才表明为高。如果列表驻留时间值正确，继续下一步。

4. 观察Dwell Type List Step 软键是否设成了 Step。

在选择 Step 时，信号源将使用为步进扫描设置的驻留时间扫描列表点，而不是使用扫描列表驻

留时间值。

为查看步进扫描驻留时间，根据下面的步骤操作：

a. 按Configure Step Sweep。

b. 观察Step Dwell 软键设置的值。

调用的寄存器中列表扫描信息丢失

列表扫描信息并没有作为仪器状态的一部分存储在仪器状态寄存器中。信号源只能使用当前列表扫

描。列表扫描数据可以存储在仪器目录中。相关说明请参阅第 60 页“把文件存储到内存目录中”。
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数据存储问题

以前存储仪器状态的寄存器是空的

在没有连接信号源的线路电源时，保存 / 调用寄存器使用后备电池操作。电池可能需要更换。

为检验电池是否失效：

1. 关闭信号源的线路电源。

2. 从线路电源上拔下信号源。

3. 插上信号源。

4. 打开信号源电源。

5. 观察显示屏上的错误信息。

如果错误信息队列中存储了 -311 或 -700，则表明信号源电池已经失效。

6. 电池更换说明请参阅服务指南。

已经保存了仪器状态，但寄存器是空的或包含错误状态

如果选择的寄存器编号大于 99，信号源会自动选择寄存器 99，保存仪器状态。

如果您原定使用的寄存器编号是空的或包含错误的仪器状态，调用寄存器 99：

按Recall > 99 > Enter。

丢失的仪器状态可能保存在这里。
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不能打开帮助模式

不能打开帮助模式

1. 按Utility > Instrument Info/Help Mode

2. 按Help Mode Single Cont，直到 Single 高亮度显示。

信号源有两种帮助模式：单次模式和连续模式。

在单次模式下按Help时(出厂预设状态)，将为您按的下一个键提供帮助文本。按另一个键将退出帮

助模式，激活该键的功能。

在连续模式下按Help时，将为您按的下一个键提供帮助文本，该键的功能也将激活(Preset除外)。您

将一直保持帮助模式，直到再次按Help 或变成单次模式。
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信号源锁住

如果信号源锁住，进行下述检查：

确保信号源没有处于远程模式(在远程模式下，显示屏上会出现R报警器)。为退出远程模式，解开前

面板键盘，按 Local。

确保信号源没有处于本地锁定状态。本地锁定会禁止前面板操作。如需与本地锁定有关的更多信息，

请参阅编程指南。

检查信号源显示屏上的进度条，它表明正在进行操作。

按Preset。

关闭信号源电源，重新开机。

故障自动防护恢复顺序

只有在上述建议不能解决问题时，才使用故障自动防护恢复顺序。

小心 这一流程会复位信号源，但它也会破坏下述类型的数据：

所有用户文件(仪器状态和数据文件)

DCFM/DC øM 校准数据

余辉状态

注 在故障自动防护顺序过程中，不要试图执行任何其它前面板操作或远程操作。

为运行故障自动防护顺序，遵守下面的步骤：

1. 重新开机，同时按下 Preset 键。

2. 一直按住Preset 键，直到显示下述信息：

WARNING You are entering the diagnostics menu which can cause unpredictable instrument

behavior. Are you sure you want to continue?

小心 认真阅读整个信息！它可能列明了与本程序有关的其它危险。
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3. 放开 Preset 键。

4. 为继续执行这一顺序，按Continue (为在不丢失文件的情况中断操作，按Abort)。

5. 在这一顺序完成时，进行下面的操作：

a. 重新开机。

重新开机将恢复所有以前安装的选项。由于校准文件从 EEPROM 中恢复，应看到多条错误信息。

b. 进行 DCFM/DC øM 校准。

参阅主要参考资料中的DCFM/DC øM Cal 软键说明。

c. 安捷伦科技公司关注启动这一程序所必需的环境。请使用 http://www.agilent.com/find/assist列明的

电话号码与我们联系。我们愿意帮助您消除任何重复发生的情况。
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错误信息

如果错误发生在信号源中，其将同时报告给前面板显示屏错误队列和SCPI (远程接口)错误队列。这

两个队列分开查看和管理；如需与 SCPI 错误队列有关的信息，请参阅编程指南。

注 在前面板错误队列中有没有查看的信息时，信号源显示屏上会出现 ERR 报警器。

特点 前面板显示错误队列

容量(错误数量) 30

溢出处理 循环 (旋转)。

在新错误进入时，丢掉最老的错误。

查看项目 按: Utility > Error Info > View Next (或 Previous) Error Page

清除队列 Press: Utility > Error Info > Clear Error Queue(s)

没有解决的错误 a 在队列清除后重新报告

没有错误 在队列为空(已经阅读了队列中的每个错误，或已经清除队列)，队列中将出现

下述信息：0 No Error Message(s) in Queue

a. 必须解决的错误，如没有锁定。

错误信息文件

仪器所带的光盘上 errormessages.pdf 文件中提供了完整的错误信息清单。

在错误信息清单中，每个错误通常还带有说明，以进一步阐明其意义。错误信息以数字方式列出。在

同一个错误编号有多个列表时，这些信息按字母顺序排列。
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错误信息的格式

在通过前面板显示屏错误队列访问错误信息时，将以列举("1 of N")的方式显示错误编号、信息和

说明。

在发生错误时，错误信息出现在显示屏的左下角。

错误编号 错误信息

错误说明

(在显示屏上可能会显示不全)

错误信息列表中提供的说明

(在仪器上不显示)
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错误信息的类型

各种事件生成的错误类型不会超过1，例如，生成队列错误的事件不会再生成器件专用错误、执行错

误或命令错误。

Query Errors (-499 to -400) 表明仪器的输出队列控制已经检测到 IEEE 488.2第 6章中介绍的消息交

换协议发生问题。这类错误在事件状态寄存器(IEEE 488.2, 第 11.5.1 节)中设置队列错误位(第 2 位)。这

些错误与 IEEE 488.2, 6.5 中描述的消息交换协议错误相对应。在这种情况下：

在输出不存在或没有即将进行的输出时，用户试图从输出队列中读取数据，或

输出队列中的数据已经丢失

Device Specific Errors (-399 to -300, 201 to 703, and 800 to 810)表明器件操作没有正确完成，这可能

是由于异常硬件或固化软件条件引起的。这些代码还用于自检响应错误。这类错误在事件状态寄存器

(IEEE 488.2, 第 11.5.1 节)中设置器件专用错误位(第 3 位)。

SCPI没有规定明确的错误的<error_message>字符串。明确的错误是指仪器在传送码组数据或在校准

过程中，在 GPIB 系统内部、在仪器固化软件内部或硬件内部发现错误。

Execution Errors (-299 to -200)表明仪器的执行控制模块发现了错误。这类错误在事件状态寄存器

(IEEE 488.2, 第 11.5.1 节)中设置执行错误位(第 4 位)。在这种情况下：

被测器件认为包头后面的<PROGRAM DATA>单元超出了有效的输入范围，或与器件的功能不一致，

或

由于某种器件条件，可能没有正确执行有效的程序信息

在舍入和表达式评估操作完成后，将报告执行错误。例如，对数字数据单元进行舍入操作，不会报

告为执行错误。

Command Errors (-199 to -100) 表明仪器的解析器检测到 IEEE 488.2语法错误。这类错误在事件状

态寄存器(IEEE 488.2, 第 11.5.1 节)中设置执行错误位(第 5 位)。在这种情况下：

解析器检测到 IEEE 488.2 语法错误(收到违反 IEEE 488.2标准的从控制到器件的信息。可能的违反情

况包括数据单元违反器件接听格式，或器件不能接受其类型)，或

收到不能识别的包头，包括器件专用包头不正确，及 IEEE 488.2 常用命令不正确或没有实现。
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联系安捷伦销售和服务办事处

下面的网址可以协助您满足测试测量需求，并提供了与安捷伦当地办事处有关的信息：

http://www.agilent.com/find/assist

您也可以在网上购买 E8257D/67D PSG 配件或文档编制项目：

http://www.agilent.com/find/psg

如果没有上网，请与现场工程师联系。

注 在信件或电话沟通中，请提供信号源的型号和完整的序列号。有了这些信息，安捷伦代表

可以确定您的设备是否在保修期内。
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把信号源退回安捷伦

为把信号源退回安捷伦进行维修，请遵守以下步骤：

1. 尽可能多地收集与信号源问题有关的信息。

2. 拨打您所在地区专用的网上列明的电话号码(http://www.agilent.com/find/assist)。如果没有上网，请与

现场工程师联系。在介绍信号源及其情况后，您将获得相关信息，告知您把信号源送哪里进

行维修。

3. 如有，使用原厂包装材料装运信号源，或使用类似包装，以正确保护信号源。
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码
øM, 18, 157

数字
003, 选项, 4
004, 选项, 4
005, 选项, 4
007, 选项, 2, 7, 46
015, 选项, 4
10 MHz 连接器, 29, 30
128QAM I/Q 调制, 创建, 181
1410, 应用指南, 216, 226
1E1, 选项, 3
1EA, 选项, 3
1ED, 选项, 4
1EH, 选项, 4
1EM, 选项, 4
二进制补码描述, 257, 270
27 kHz 脉冲, 41
601/602, 选项
定制任意模式, 77, 163, 164
定制实时模式, 191, 192
说明, 4, 7
多音模式, 215, 216
码速率, 177
双音模式, 225, 226

802.11b, 132
8757 网络分析仪, 52
8757D 标量网络分析仪, 41, 46-55

A
AC 电源插座, 28
ACP, 78, 170, 200
活动输入区域 (显示屏), 18
增加和编辑 (仪器状态), 62
调节, 显示, 14
安捷伦 PSG 网页, 1
ALC
报警器, 18
带宽选择, 132
输入连接器, 12
输入连接器 (后面), 33

限制, 幅度, 136
off 模式, 设置, 283
配备衰减器选项, 138

ALC 反馈环路, 133
ALC Hold, 133
ALC 保持
说明, 99
保存设置, 98

alpha 调节 (滤波器), 170
交替锯齿波扫描, 52
AM, 18, 155
放大器, 微波, 272, 275
幅度
显示区域, 20
硬键, 10
LF 输出, 160
调制。参阅 AM
锯齿波扫描, 53
参考和偏置, 40

模拟调制, 7, 153-161
模拟 PSG
选装功能, 2
标配功能, 2

报警器, 18
应用指南

1410, 216, 226
获得, 1

任意
AWGN, 233
文件目录, 59
参考, 设置, 189
触发, 113
波形削波, 119-126
波形文件标题, 80-90
波形定标, 127-129
另请参阅 定制任意波形发生器
另请参阅 双任意波形发生器

任意, 78
ARMED 报警器, 18
箭头硬键, 14
ATTEN HOLD 报警器, 18
衰减器, 外部置平, 138
AUTOGEN_WAVEFORM 文件, 91
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自动置平控制。参阅 ALC
AUXILIARY I/O 连接器, 26
AUXILIARY INTERFACE 连接器, 30
AWGN
任意, 233
双任意播放器, 95
实时, 233

B
带宽

ALC, 选择, 132
参考频率振荡器, 调节, 151

基带
削波, 119-126
定标, 127-129

基带发生器, 78
AWGN, 233
定制任意模式, 7, 163
定制实时 I/Q 模式, 7, 191
双任意模式, 8, 77
多音模式, 8, 215
REF IN 连接器, 25
设置, 204, 205
双音模式, 8, 225

基本操作
数字, 77
标准, 35

BbT, 调节, 170
二进制文件, 59
位文件, 59
每个码的位数, 公式, 208
BURST GATE IN 连接器, 25
突发形状, 199-203
突发信号, 132, 133

C
载波馈通, 最小化, 221, 230
载波信号, 调制, 58
CCDF 曲线, 124-126, 223
CDMA, 132
天棚函数, 每个码的位数, 208
证书, 许可密码, 71
圆形削波, 125
削波

CCDF 曲线, 124-126
圆形, 122, 125
概念, 119-124
程序, 125, 126
矩形, 122, 126

时钟调节
相位和偏移, 249

时钟速率限制, 逻辑类型输出, 239
时钟来源
设置, 260, 267

时钟定时
并行数据, 244
并行隔行扫描数据, 247
相位和偏移, 249
串行数据, 249

时钟, 频率参考, 242
时钟, 频率参考示意图, 243
每个样点的时钟数量
并行数据, 244
并行隔行扫描数据, 247

COH 连接器, 28
注释, 增加和编辑 (仪器状态), 62
公共频率参考示意图, 243
元器件测试, 78
概念
差分数据编码, 207
FIR 滤波器, 169
波形削波, 119-124
波形标尺, 98
波形定标, 127-129

机密数据, 64
连接
公共频率参考, 243

连接器
外部触发, 116
外部触发来源, 117
前面板, 9
后面板, 22

连续
列表扫描, 46
步进扫描, 43
触发, 114

连续波
配置, 38
说明, 7
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对比度调节 (显示屏), 14
校正阵列 (用户平坦度)
配置, 141
从步进阵列加载, 141
查看, 142
另请参阅 用户平坦度校正

耦合器 / 分路器, 使用, 135
定制任意, 79
定制任意波形发生器, 7, 163-189
定制模式, 78
定制实时 I/Q 基带, 7, 191-214
CW 模式
配置, 38
说明, 7

D
DAC 超过额定范围错误, 127-129
DATA
输入连接器, 16
输入连接器 (后面), 33

数据
时钟, 205
编码, 差分, 207-214
字段, 编辑, 37
文件, 59
成帧, 114
输入方法, 64
码型
触发, 113
使用, 193

删除, 68
灵敏的, 64, 68
存储

问题, 287
安全, 64
另请参阅 仪器状态寄存器
另请参阅 内存目录

未成帧, 114
数据时钟
输入连接器, 15
输入连接器 (后面), 33

数据滤波, FIR 前或 FIR 后, 257, 270
技术数据表, 1
数据类型, 252
DC 检测器, 41

DC 偏置, 156
解除分类, 64
默认的 FIR 滤波器, 恢复, 171
时延, 外部触发信号, 115
Delete Item 软键, 37
Delete Row 软键, 37
说明, 增加和编辑 (仪器状态), 62
检测器
二极管响应, 137
使用, 135

设备时钟来源选择, 260, 267
DHCP, 73
示意图
数据类型, 252

示意图
时钟定时, 并行数据, 244
时钟定时, 并行隔行扫描数据, 247
时钟定时, 相位和偏移, 249
时钟定时, 串行数据, 249
公共频率参考, 243

差分数据编码, 207-214
DIG BUS 报警器, 18
数字总线连接器, 25
数字调制
报警器, 20
定制, 163-189, 191-214
格式, 7
多载波, 164, 167, 188
多音, 215-224
双音, 225-232

数字信号接口, 238
数字信号接口模块, 238
二极管检测器响应, 137
离散步进, 偏移范围, 249
显示
消隐, 70
对比度降低, 14
对比度提高, 14
说明, 17
概述, 17
安全, 70

DMOD 文件, 59
存储选项, 5
下载固化软件, 5
双任意波形发生器, 78
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双任意播放器, 8, 91-96
双任意波形发生器, 8, 91-96
驻留时间, 42

E
E8257D
选装功能, 2
标配功能, 2

E8267D
选装功能, 4
标配功能, 4

Edit Item 软键, 37
Erase All, 68, 69, 70
擦除内存, 64, 68, 69, 70
ERR 报警器, 18, 291
错误信息

DAC 超过额定范围, 127-129
显示, 21
消息格式, 292
概述, 291
队列, 291
类型, 293

EVENT 连接器, 24
EVM, 170, 200
EXT
报警器, 18, 19
INPUT 连接器, 12
输入连接器, 12
输入连接器 (后面), 32

扩展频率, 56
扩展频率范围, 56
外部
数据时钟, 设置, 205
检测器, 二极管响应, 137

外部时钟来源选择, 260, 267
外部 FM, 156
外部 I/Q 调制, 187
外部信号源模块, 272
外部触发
连接, 116
选通, 设置, 116
单一, 设置, 188
源连接器, 117

F
故障自动防护恢复顺序, 289
故障。参阅问题诊断
下降时延, 突发形状, 200
下降时间, 突发形状, 200
FAQ, 1
功能, 信号源, 2
馈通, 载波, 最小化, 230
文件标题 (任意波形), 80-90
文件存储
文件, 61
目录, 59
使用, 60
波形段, 92-96
滤形序列, 93-95
另请参阅 仪器状态寄存器
另请参阅 内存目录

滤波的和没有滤波的样点, 257, 270
滤波器
内插, 127-128
使用, 169-176

FIR, 59, 169
固化软件
选项, 5
升级
获得, 5
使用 GPIB, 5
使用 LAN, 5
使用 RS-232, 5

平坦度校正。参阅用户平坦度校正
FM, 19, 156
FM/(M 硬键, 11
公式, 偏移离散步进, 249
成帧数据, 114
自由运行触发响应, 114
频率
显示区域, 18
硬键, 10
调制。参阅 FM
偏置, 39
锯齿波扫描, 47
范围, 2
参考, 39
RF 输出, 设置, 38
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频率扩展, 56
频率输出极限, 时钟速率和逻辑电平, 239
频率范围, 56
频率参考
公共, 242
挂起示意图, 243

前面板
说明, 9-21
禁用键, 70

FSK
文件, 59
调制, 180, 185, 186

G
GATE/ 脉冲 / 触发
输入连接器, 14
输入连接器 (后面), 32

选通, 158
选通触发, 114, 116
高斯滤波器, 选择, 170
Goto Row 软键, 37
GPIB, 29, 144

H
硬键, 9-14
硬件, 配置, 188, 204
Help 硬键, 11
帮助模式问题诊断, 288
Hold 硬键, 14

I
I 输入连接器, 16
I 输入连接器 (后面), 33
I OUT 连接器, 27
I/O 连接器, 辅助, 26
I/Q

4QAM 状态映射图, 208
报警器, 19
文件, 59
输入连接器, 16
调制, 184, 212
定标, 调节, 205

I/Q 波形

削波, 119-126
定标, 127-129

I-bar OUT 连接器, 27
IMD。参阅互调失真
Incr Set 硬键, 13
信息
附加 PSG, 1
保护灵敏的, 64

Insert Item 软键, 37
Insert Row 软键, 37
安装固化软件, 5
仪器状态寄存器
注释, 增加和编辑, 62
问题诊断, 287
使用, 61
另请参阅 内存目录

仪器状态, 52
int 选通, 158
接口连接器

AUXILIARY INTERFACE, 30
GPIB, 29
LAN, 30
RS-232, 30

接口, 远程, 144
互调失真
怎样最小化, 121
测试非线性设备, 216, 226

内部时钟来源选择, 260, 267
内插滤波器, 127-128
IQ
时钟速率, 240
调制, 187

IQ 调制, 187

K
键, 许可, 71
键盘, 数字, 13
键
禁用, 70
前面板, 9-14

旋钮, 前面板, 10

L
L (接听方模式) 报警器, 19
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局域网配置, 73
LAN 连接器, 30
LEDs, 14, 15
置平

ALC, 12, 283
外部, 135-138
内部, 132
毫米波信号源模块, 使用, 272

LF OUT 连接器, 32
LF 输出, 12, 159-161
许可密码, 71
极限, 时钟和取样速率, 逻辑输出, 239
线路电源 LED, 14
列表
错误信息, 291
文件, 59
模式值表格编辑器, 36
扫描, 43, 286

接听方模式报警器, 19
Load/Store 软键, 37
Local 硬键, 14
逻辑类型
输出电平, 239
选择, 254

低频输出。参阅 LF 输出

M
幅度误差模拟, 184
manual freq 软键, 52
手动扫描, 52
标尺路由, 133
标尺, 133
输出, 31
锯齿波扫描, 49
波形, 97-112

主 / 从设置, 54
MDMOD 文件, 59
存储介质, 64
内存, 91
基本仪器, 64
基带发生器, 64
目录, 59, 287
另请参阅 仪器状态寄存器

擦除, 64, 68
硬盘, 64

覆盖, 68
余辉, 64
物理位置, 64
清理, 69
安全模式, 69
size, 64
类型, 64
波形, 64
写入, 64

菜单
标尺, 102
标尺极性, 112
触发, 115

MENUS 硬键, 11
微波放大器, 272, 275
毫米, 272
毫米波信号源模块, 272
混频器, 在使用信号丢失, 281
毫米波信号源, 56
毫米波信号源模块
扩展频率范围, 272
置平, 138
用户平坦度 校正阵列, 创建, 144-150

mod on/off, 12, 19
模式 ls, 信号源, 2
工作模式, 7
模式, 触发, 114
调制
幅度。参阅 AM
模拟, 7, 153-161
模拟 波形, 154
报警器, 18-20
应用, 57
数字, 7
文件目录, 59
频率。参阅 FM
多载波, 164, 167, 188
on/off 硬键, 12
相位。参阅 øM
预先定义的设置, 165, 192
脉冲, 7, 158
类型, 180
用户定义的, 166, 212
另请参阅 数字调制

模块用户接口位置, 253, 263
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MSK 调制, 180
MTONE 文件, 59
多载波 波形, 164, 167, 188
多音, 78
多音模式, 8
多音波形发生器, 215-224

N
N5102A, 238
基带数据, 253
时钟速率, 238
时钟设置, 258, 265
时钟来源
说明, 241

时钟定时, 238, 244
公共频率参考, 242
连接到时钟和器件, 250
数据参数, 设置, 255, 268
数据类型, 252
数字数据, 271
频率参考连接器, 243
生成数据, 262
输入方向, 263
输入模式, 252, 262
隔行扫描时钟定时, 247
逻辑类型,端口配置, 264
逻辑类型 s, 254
输出方向, 255
输出模式, 252, 253
相位和偏移 时钟定时, 249
串行 时钟定时, 249
用户接口, 253
用户接口模块, 263

N5102A 数字信号接口模块, 238
否定说明, 258, 271
噪声, 95, 233
非线性设备, 测试, 216, 226
非易失性内存, 91
数字格式选择, 257, 270
数字键盘, 13
NVMKR 文件, 59
nvwfm, 91
NVWFM 文件, 59
Nyquist 滤波器, 170

O
OFDM, 132
偏置, 39, 40, 156
偏置二进制用途, 257, 270
on/off 开关, 15
操作
基础知识, 35
数字基础知识, 77
模式 of, 7

优化精度, 133
选项 015, 187
选项

003, 4
004, 4
005, 4
007, 2, 7, 46
015, 4
1E1, 3
1EA, 3
1ED, 4
1EH, 4
1EM, 4
601/602
基本数字操作, 77
定制任意模式, 163, 164
定制实时模式, 191, 192
说明, 4, 7
多音模式, 215, 216
双音模式, 225, 226
使用码速率, 177

其它信息, 5
启动, 71
UNR, 3, 151
UNT, 3, 7, 153-157, 158
UNU, 3, 7, 153, 154, 158
UNW, 3, 7, 153, 154, 158

振荡器, 参考, 调节 BW, 151
输出电平, 逻辑类型 s, 239
输出功率, 问题诊断, 280
输出。参阅 LF 输出 and RF 输出
OVEN COLD 报警器, 19
超出额定范围错误, 127-129
覆盖内存, 68



304 索引

索引

P
Page Down 软键, 37
Page Up 软键, 37
并行
时钟速率, 240
数据时钟定时, 244
隔行扫描数据时钟定时, 247
取样速率, 240

PATTERN TRIG IN 连接器, 24
峰值均值功率比

CCDF 曲线, 124, 223
高比率, 121
多音特点, 223
降低, 122

性能, 优化, 131-151
外围设备, 238
数字信号接口模块, 237
毫米波信号源模块, 237

相位
误差模拟, 184
调制。参阅 øM
极性, 206

相位时钟定时, 249
播放器, 双任意, 91-96
极性
标尺设置, 保存, 80
标尺, 112
触发, 外部, 115

端口配置, 选择, 254
电源
仪表, 139, 283
输出, 问题诊断, 280
峰值, 119-124
插座, AC, 28
搜索模式, 283
电源问题诊断, 281
开关, 15

PRAM, 78
预先定义的滤波器, 169
预先定义的调制设置, 165, 192
FIR 前取样选择, 257, 270
Preset 硬键, 14
专用数据, 64
问题。参阅问题 诊断
产品信息, 1

专有数据, 64
保护数据, 64
PSG
其它信息, 1
固化软件, 5
工作模式, 7
选项, 5
网页, 1

PSK 调制, 180
脉冲, 132
报警器, 19
输入, 14
输入 (后面), 32
调制, 158

脉冲调制, 7, 41
脉冲来源, 41, 158
脉冲 SYNC OUT, 32
脉冲 VIDEO OUT, 32
脉冲, 标尺, 查看, 110
脉冲 /TRIG GATE INPUT, 32

Q
Q 输入连接器, 16
Q 输入连接器 (后面), 33
Q OUT 连接器, 27
QAM 调制, 180, 208
Q-bar OUT 连接器, 28
QPSK I/Q 调制, 创建, 183
队列, 错误, 291

R
R (远程) 报警器, 19
锯齿波扫描, 46-55
实时, 78
实时 AWGN, 233
实时 I/Q, 191-214
实时模式, 7, 79
实时触发, 113
后面板说明, 22
Recall 硬键, 10
调用状态, 52
调用状态, 61
接收机测试, 78
恢复顺序, 故障自动防护, 289
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矩形削波, 126
参考
幅度, 设置, 40
频率, 设置, 39
振荡器带宽, 调节, 151

寄存器, 61, 62
远程操作, 11, 144
远程操作报警器, 19
复位和运行触发响应, 114
响应, 触发模式, 114
受限数据, 64
Return 硬键, 14
返回信号源, 295
RF Blank, 133
RF 消隐, 280
标尺功能, 111
设置, 保存, 98

RF 输出
报警器, 19
配置, 38
连接器, 13
连接器 (后面), 32
置平, 外部, 135-138
毫米波信号源模块, 使用, 272
On/Off 硬键, 13
扫描, 41
问题诊断, 280
用户平坦度校正, 139-150

上升时延, 突发形状, 200
上升时间, 突发形状, 200
根 Nyquist 滤波器, 170
路由, 标尺

ALC 保持, 99
RF 消隐, 111
保存设置, 98
设置, 保存, 80

RS-232 连接器, 30
运行时定标, 129

S
S (服务请求) 报警器, 19
取样
速率, 238
速率, 并行 / 并行内插端口配置, 240

速率, 串行端口配置, 239
类型选择, 257, 270

样点
基带, 127-128
内插, 127-128

清理内存, 69
保存和调用, 52
保存和调用状态, 61
保存文件
Save 硬键, 10
标量网络分析仪, 41, 46-55
标量脉冲, 41
定标
概念, 127-129
程序, 129
运行时, 129
波形数据, 129

SCPI, 73
SCPI 命令, 11
安全显示, 70
安全模式, 69
安全功能, 64, 69
安全等级, 69
波形段提前触发, 114, 118
灵敏的数据, 64
Seq 文件, 59
序列
构建和存储, 93
删除, 62
编辑, 94
仪器状态寄存器, 61
标尺控制, 108
播放, 94
触发, 113

串行
时钟和取样速率, 239
时钟定时, 249

服务请求报警器, 19
服务, 安捷伦销售和服务代表处, 294
形状文件, 59
信号源
功能, 2
固化软件, 5
模式 ls, 2
模式, 7
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选项, 5
概述, 1

信号丢失, 问题诊断, 280
Signal Studio 软件, 216, 226
单一步进扫描, 42
单一触发模式, 114
单一触发, 设置, 188
偏移
时钟定时, 249
范围, 249

SMI 连接器, 28
软键, 10, 21, 37
软件
适用于 PSG, 1
选项, 5

信号源模块, 272
SOURCE SETTLED OUTPUT 连接器, 32
来源, 外部触发, 115
频谱再生, 121
频谱分析仪, 信号丢失问题诊断, 282
方形脉冲, 41
备用 LED, 15
状态文件, 59
状态寄存器, 52
步进阵列(用户平坦度), 139
另请参阅 用户平坦度校正

步进衰减器, 外部置平, 138
步进扫描, 42-43
STOP SWEEP 连接器, 31
存储, 问题诊断, 287
扫描

27 kHz 脉冲, 41
8757D 标量网络分析仪, 41
报警器, 20
DC 检测器, 41
列表, 43
模式, 7
输出, 31
锯齿波, 46-55
RF 输出, 41
标量网络分析仪, 41
标量脉冲, 41
步进, 42
触发, 45
问题诊断, 285

扫描进度条, 41
Sweep/List 硬键, 11
开关, 电源, 15
码速率, 177
SYMBOL SYNC
输入连接器, 15
输入连接器 (后面), 33

SYNC OUT 连接器, 13
SYNC OUT 连接器 (后面), 32

T
T (发话方模式) 报警器, 20
表格编辑器, 使用, 36-37
发话方模式报警器, 20
TCP/IP, 73
技术支持, 1
文本显示区域, 21
触发
硬键, 11
输入

GATE/ 脉冲 / 触发, 14
GATE/ 脉冲 / 触发 (后面), 32
PATTERN TRIG IN, 24
触发 IN, 31

输出, 31
设置, 45

触发和运行, 114
触发输入, 158
触发极性, 158
触发, 113-118, 188
问题诊断, 279-295
双音, 8, 78, 225-232

U
没有滤波的和滤波的样点, 257, 270
未成帧数据, 114
UNLEVEL 报警器, 20
UNLOCK 报警器, 20
UNR, 选项, 3, 151
UNT, 选项, 3, 7, 153-157, 159
UNU, 选项, 3, 7, 153, 154, 158
UNW, 选项,3, 7, 153, 154, 158
升级固化软件, 5
用户平坦度, 59, 139-150
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用户接口位置, 模块, 253, 263
用户定义的
突发形状曲线 s, 201
数据码型, 195
文件, 59
滤波器, 171, 173
调制类型
定制任意, 166
实时 I/Q, 181, 212

V
矢量 PSG
选装功能, 4
标配功能, 4

VIDEO OUT 连接器, 13
VIDEO OUT 连接器 (后面), 32
易失性内存, 91

W
保证逻辑输出时钟速率, 239
波形内存, 64
波形
模拟调制, 154
任意文件标题, 80-90
CCDF 曲线, 124-126
削波, 119-126
定制, 163-189
定制实时 I/Q 基带, 191-214
DAC 超过额定范围错误, 127-129
文件目录, 59
内插, 127-128
标尺, 97
多载波, 164, 167, 188
多音, 215-224
播放器, 双 任意, 91-96
样点, 127-128
定标, 127-129
段, 92-96
序列, 93-95, 108
统计, 125-126
触发, 113
双音, 225-232
辅助工具, 125-126

网络服务器, 73

网站, 1
wfm1, 91
WFM1 文件, 59
WIDEBAND I INPUT 连接器, 27
宽带 IQ, 187
WIDEBAND Q INPUT 连接器, 27

Z
Z-AXIS BLANK/MKRS 连接器, 31



308 索引

索引


	首页
	目录
	1.信号源概述
	信号源型号和主要特点
	E8257D PSG模拟信号源主要特点
	E8267D PSG矢量信号源主要特点

	选项
	固化软件升级
	为升级固化软件

	工作模式
	CW连续波模式
	扫描信号
	模拟调制
	数字调制

	前面板
	1. 显示屏
	2. 软键
	3. 旋钮
	4. Amplitude (幅度)
	5. Frequency (频率)
	6. Save (保存)
	7. Recall (调用)
	8.Trigger (触发)
	9. MENUS (菜单)
	10. Help (帮助)
	11. EXT 1 INPUT
	12. EXT 2 INPUT
	13. LF OUTPUT
	14. Mod On/Off
	15. ALC INPUT
	16. RF On/Off
	17. 数字附加键盘
	18. RF OUTPUT
	19. SYNC OUT
	20. VIDEO OUT
	21. Incr Set
	22. GATE/ PULSE/ TRIGGER INPUT
	23. 箭头键
	24. Hold (保持)
	25. Return (返回)
	26. Contrast Decrease (降低对比度)
	27. Contrast Increase (提高对比度)
	28. Local
	29. Preset (预置)
	30. 线路电源LED
	31. LINE
	32. 备用LED
	33. SYMBOL SYNC
	34. DATA CLOCK
	35. DATA
	36. Q Input
	37. I Input

	前面板显示屏
	1. 活动输入区域
	2. 频率区域
	3. 报警器
	4. 数字调制报警器
	5. 幅度区域
	6. 错误信息区域
	7. 文字区域
	8. 软键标签区域

	后面板
	1. EVENT 1
	2. EVENT 2
	3. PATTERN TRIG IN
	4. BURST GATE IN
	5. BASEBAND GEN REF IN
	6. DIGITAL BUS
	7. AUXILIARY I/O
	8. WIDEBAND I INPUT
	9. WIDEBAND Q INPUT
	10. I OUT
	11. Q OUT
	12. I-bar OUT
	13. Q-bar OUT
	14. COH CARRIER
	15. SOURCE MODULE INTERFACE
	16. AC电源插座
	17. GPIB
	18. 10 MHz EFC
	19. 10 MHz IN
	20. AUXILIARY INTERFACE
	21. 10 MHz OUT
	22. LAN
	23. STOP SWEEP IN/OUT
	24. Z-AXIS BLANK/MKRS
	25. SWEEP OUT
	26. TRIGGER OUT
	27. TRIGGER IN
	28. SOURCE SETTLED
	29. RF OUT
	30. EXT 1 Input
	31. EXT 2 Input
	32. LF OUT
	33. PULSE SYNC OUT
	34. PULSE VIDEO OUT
	35. PULSE/TRIG GATE INPUT
	36. ALC INPUT
	37. DATA
	38. DATA CLOCK题
	39. SYMBOL SYNC
	40. I Input
	41. Q Input


	2.基本操作
	使用表格编辑器
	表格编辑器软键
	在数据字段中修改表格项目

	配置RF输出
	配置连续波RF输出
	配置扫描RF输出
	扩展频率范围

	调制信号
	打开调制格式
	对RF输出使用调制格式

	使用数据存储功能
	使用内存目录
	使用仪器状态寄存器

	使用安全功能
	理解PSG内存类型
	从PSG内存中删除敏感的数据
	使用安全显示

	启动选项
	启动软件选项

	使用网络服务器
	激活网络服务器


	3.基本数字操作
	定制调制
	定制任意波形发生器
	定制实时I/Q基带

	任意(ARB)波形文件标题
	为调制格式波形创建文件标题
	修改调制格式中的标题信息
	为双ARB播放器波形序列存储标题信息
	修改和查看双ARB播放器中的标题信息
	播放包含标题的波形文件

	使用双ARB波形播放器
	访问双ARB播放器
	创建波形段
	构建和存储波形序列
	播放波形
	编辑波形序列
	在双ARB波形中增加实时噪声
	存储和加载波形段
	重新命名波形段

	使用波形标尺
	波形标尺的概念
	访问标尺辅助工具
	查看波形段标尺
	1. 从波形段中清除标尺点
	2. 在波形段中设置标尺点
	3. 控制波形序列中的标尺(仅适用于双ARB)
	查看标尺脉冲
	使用RF消隐标尺功能
	设置标尺极性

	触发波形
	信号源
	模式和响应
	使用触发辅助工具
	设置外部触发器的极性
	使用选通触发
	使用Segment Advance触发

	使用波形削波
	功率峰值怎样发展
	峰值怎样导致频谱再生
	削波怎样降低峰值均值功率比
	配置圆形削波
	配置矩形削波

	使用波形定标
	DAC超出额定范围错误是怎样发生的
	定标怎样消除DAC超出额定范围错误
	定标目前正在播放的波形(运行时定标)
	在易失性内存中定标波形文件


	4.优化性能
	使用ALC
	选择ALC带宽
	为选择ALC带宽
	优化突发的ARB信号的电平精度

	使用外部置平
	使用检测器和耦合器/分路器进行置平
	使用选项1E1信号源进行外部置平

	创建和应用用户平坦度校正
	创建用户平坦度校正阵列
	使用毫米波信号源模块创建用户平坦度校正列

	调节参考频率振荡器带宽(选项UNR)
	选择参考频率振荡器带宽
	恢复出厂默认设置


	5.模拟调制
	模拟调制波形
	配置AM (选项UNT)
	设置载频
	设置RF输出幅度
	设置AM深度和速率
	启动幅度调制

	配置FM (选项UNT)
	设置RF输出频率
	设置RF输出幅度
	设置FM偏差和速率
	激活FM

	配置ΦM (选项UNT)
	设置RF输出频率
	设置RF输出幅度
	设置Φ M偏差和速率期、宽度和触发
	为实现Φ M

	配置脉冲调制(选项 UNU/UNW)
	设置 RF输出频率
	设置 RF输出幅度
	设置脉冲周期、宽度和触发
	激活脉冲调制

	配置LF输出(选项UNT)
	使用内部调制源配置LF输出
	使用函数发生器来源配置LF输出


	6.定制任意波形发生器
	概述
	处理预先定义的设置(模式)
	选择定制ARB设置或定制数字调制状态

	处理用户定义的设置(模式)-仅定制ARB
	修改单载波NADC设置
	定制多载波设置
	调用用户定义的定制数字调制状态

	处理滤波器
	预先定义的滤波器(Filter > Select)
	使用预先定义的FIR滤波器

	处理码速率
	设置码速率
	恢复默认码速率(仅定制实时I/Q)

	处理调制类型
	选择预先定义的调制类型
	使用用户定义的调制类型(仅实时I/Q)
	宽带IQ (选项015)

	配置硬件
	设置延迟正极外部单触发
	设置ARB参考


	7.定制实时I/Q基带
	概述
	处理预先定义的设置(模式)
	选择预先定义的实时调制设置
	反选预先定义的实时调制设置

	处理数据码型
	使用预先定义的数据码型
	使用用户定义的数据码型
	使用外部提供的数据码型

	处理突发形状
	配置突发上升和下降参数
	使用用户定义的突发形状曲线

	配置硬件
	设置BBG参考频率
	设置外部DATA CLOCK作为正常输入或码输入接收输入
	把BBG DATA CLOCK设成External或Internal
	调节I/Q标度

	处理相位极性
	把相位极性设为正常或反相

	处理差分数据编码
	了解差分编码
	使用差分编码


	8.多音波形发生器
	概述
	创建、查看和优化多音波形
	创建定制多音波形
	查看多音波形
	编辑多音设置表
	使载波馈通达到最小
	确定峰值均值比特点


	9.双音波形发生器
	概述
	创建、查看和修改双音波形
	创建双音波形
	查看双音波形
	使载波馈通达到最小
	改变双音波形的对齐方式


	10.AWGN波形发生器
	配置AWGN发生器
	任意波形发生器AWGN
	实时I/Q基带AWGN


	11.外围设备
	N5102A数字信号接口模块
	时钟定时
	连接时钟源和被测器件
	数据类型
	以输出模式操作N5102A模块
	以输入模式操作N5102A模块

	毫米波信号源模块
	使用安捷伦毫米波信号源模块
	使用其它信号源模块


	12.问题诊断
	RF输出功率问题
	在播放波形文件时没有RF输出功率
	RF输出功率太低
	电源已经关闭
	在使用混频器时信号丢失
	在使用频谱分析仪时信号丢失

	RF输出上没有调制
	扫描问题
	扫描似乎停止了
	不能关闭扫描模式
	列表扫描驻留时间值不正确
	调用的寄存器中列表扫描信息丢失

	数据存储问题
	以前存储仪器状态的寄存器是空的
	已经保存了仪器状态，但寄存器是空的或包含错误状态

	不能打开帮助模式
	信号源锁住
	故障自动防护恢复顺序

	错误信息
	错误信息文件
	错误信息的格式
	错误信息的类型

	联系安捷伦销售和服务办事处
	把信号源退回安捷伦

	索引



